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Chapter 1. Introduction to Gentran:Server for Windows

About Sterling Gentran:Server
Welcome to IBM® Sterling Gentran:Server® for Microsoft Windows, the IBM EDI
software for the Windows operating system.

Sterling Gentran:Server provides the easy-to-use tools you need to electronically
exchange data with your trading partners, including the following functions:
v data translation
v process control
v communications system

Support for Sterling Gentran:Server
Sterling Gentran:Server software is supported by trained product support
personnel who are available to help with product questions or concerns.

You can access the Sterling Gentran:Server Customer Support page (Support
Portal) at:

http://www.ibm.com/support/entry/portal/Overview/Software/
Other_Software/Sterling_Gentran:Server_for_Microsoft_Windows

You can also call Customer Support at 1-800-IBM-SERV (1-800-426-7378).

To help us provide prompt service, we ask that you do the following:
v Attempt to recreate any problem that you encounter and record the exact

sequence of events.
v When you call product support, you should be prepared to provide us with the

information below.

Information Description

Identification Your company name, your name, telephone number and
extension, your company’s IBM customer number (ICN), and
the problem management record (PMR) number (if the
question refers to a previously reported issue)

System Configuration Sterling Gentran:Server version (and any patches or options
installed) and information about the primary Sterling
Gentran:Server system controller and all machines
experiencing problems, including

v Microsoft Windows operating system version

v amount of memory

v available disk space

v database type and version

v browser version

Also, please describe any recent changes in your hardware,
software, or the configuration of your system.

System Data Store Servers containing folders in the system data store
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Information Description

Error Messages If possible, get a screen capture of any error messages and the
point at which the error occurred, as well as any log files. (If
you cannot get a screen capture, record the exact wording of
the error.)

Attempted Solutions Record any steps that you took attempting to resolve the
problem and note all outcomes. Provide an estimate on how
many times the problem occurred and whether it can be
reproduced.

Sterling Gentran:Server Components
This topic defines the Sterling Gentran:Server terminology used in this manual. We
recommend that you familiarize yourself with this terminology before proceeding
further.

Communication Controller

A communication controller regulates communication between Sterling
Gentran:Server and the organizations (value-added networks (VANs) or trading
partners) with whom data is exchanged. Through the Sterling Gentran:Server file
interface, the communication controller can support leased or dialed connections,
as well as interaction with third-party communications packages.

After a communications session is complete, all communication post processing is
executed on the communication controller. Post processing includes updating the
communication status for outbound data, splitting inbound data into component
documents, control number checking, and compliance checking.

Note: The communication controller may be any machine in the Sterling
Gentran:Server system that is capable of sending and receiving EC data using a
modem or other communications device, and on which the communications
components of the Sterling Gentran:Server system are installed.

Database

The database is the relational database that Sterling Gentran:Server uses to store
system data. This database enables multiple users to access the same data. The
other components of the product interact with this database using ODBC (Open
Database Connectivity), which allows for different database management systems
on the database controller.

Note: See the IBM Sterling Gentran:Server for Microsoft Windows Quick Start Guide to
determine which database management systems have been certified for use with
Sterling Gentran:Server.

Sterling Gentran:Server Executive

The Sterling Gentran:Server Executive is the service that controls the execution of
communication and translation functions on a defined server. The Sterling
Gentran:Server Executive is installed on the primary Sterling Gentran:Server
system controller and all secondary controllers in a Sterling Gentran:Server system.
On the primary system controller, Sterling Gentran:Server Executive also centrally
regulates system-critical information.

2 IBM Sterling Gentran:Server for Windows: Administration Guide



Sterling Gentran:Server Poller

The Sterling Gentran:Server Poller is the Sterling Gentran:Server Executive
component that polls at set intervals for the existence of specified files.

Sterling Gentran:Server Scheduler

The Sterling Gentran:Server Scheduler is the Sterling Gentran:Server Executive
component that checks all timed events at set intervals for scheduled events.

Notification

The Notification subsystem enables you to be pro-actively notified when an error
occurs by setting up notification parameters. You can specify notification
parameters that prompt the system to either send an alert to user interface clients
running the Notification program or call a specified digital pager when a specified
audit message is written to the Audit Log.

Primary System Controller

The primary system controller controls the management and dispatching of
processing requests within the Sterling Gentran:Server system, manages the audit
functionality, and controls all other system components.

Process Controller

The process controller regulates the management and dispatching of processing
requests within the system to allow the system translation load to be distributed
for fast and efficient throughput.

Note: The process controller may be any machine in the Sterling Gentran:Server
system on which the process control components are installed.

You can deploy additional controllers (secondary controllers) across the Windows
network to allow the processing load to be distributed for fast and efficient
throughput. The secondary controller can be either or both of the following
v process controller
v communication controller

System Configuration Program

The System Configuration program enables you to modify system-wide
configuration parameters, including the following:
v system data store folders
v security mode
v client notification parameters
v audit parameters
v controller settings
v ODBC data source used by the system
v maximum number of audit entries allowed in the system
v splitter entries
v users profiles
v stop and start the Sterling Gentran:Server Executive Service
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System Data Store

The system data store serves as the repository of all shared Sterling Gentran:Server
data. The system data store may reside on any machine that is a file server to the
machines in the Sterling Gentran:Server system. There is only one system data
store in the Sterling Gentran:Server system, but the associated folders and files
may be distributed across multiple machines (in a distributed system
environment).

Note: The machines where the system data store resides must be accessible by all
machines in the Sterling Gentran:Server system.

User Interface

The user interface client is any machine in the Sterling Gentran:Server system other
than the primary system controller or secondary controller. The user interface
clients provide the functions that are necessary to monitor and control the system.

Inbound Translation Process
The following diagram illustrates the inbound translation process:
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Table 1. Inbound Translation Process

Stage Description

1 The Communicator receives interchanges from your trading partners through
a network.

2 The Communicator passes the interchanges to the translator.

3 The translator uses a system interchange break translation object to unwrap
the interchange envelopes and separate each group into temporary storage.

4 The translator uses a system group break translation object to unwrap the
group envelopes and separate each transaction set into temporary storage.

5 The translator uses a system transaction break translation object to do the
following:

v Unwrap the transaction envelopes.

v Separate each document into a separate file on the system data store.

v Write a record to the database with reference information about the
document.
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Table 1. Inbound Translation Process (continued)

Stage Description

6 Does the translator locate a trading relationship for each document?

v If yes (a trading relationship is located), the translator attempts to identify
the export, document turnaround, or print translation object associated
with that relationship. If the translator locates a trading relationship and
translation object, it uses that translation object to compliance check the
document.

v If no (the translator does not locate the trading relationship or translation
object), the document is marked as not compliant and is moved to ?In
Documents.

7 Is the document compliant with the EDI standard?

v If yes, the translator changes the document status to compliant and moves
the document to In Documents.

v If no, the document remains in ?In Documents. The translator writes a
detailed error report to help you determine the problem that was
encountered.

8 In the trading relationship, if you specify that the system needs to generate a
functional acknowledgement for a document, the translator uses the system
acknowledgement translation object to generate the acknowledgement.

v Compliant acknowledgements are moved to Out Documents to be sent.

v Non-compliant acknowledgements are moved to ?Out Documents. If an
error occurred with the acknowledgement translation object, the
acknowledgement is also moved to ?Out Documents.

The translator also reconciles acknowledgements if you receive an
acknowledgement-type transaction (such as 997 or CONTRL).

9 If you specified either automatic export or automatic turnaround in the
trading relationship, the translator uses the specified export or document
turnaround translation object to either export or generate the appropriate
response document.

Outbound Translation Process
The following diagram illustrates the outbound translation process:
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Table 2. Outbound Translation Process

Stage Description

1 Use one of the following three processes to initiate an outbound translation:

v Import a file through the process control system using a timed or polled
session. This writes all valid documents to the database with a compliant
status and moves the documents to Out Documents. Invalid documents are
marked with a non-compliant status and are moved to ?Out Documents.

v Import an application file. Documents that you import manually are located
in the Workspace.

v Use the Document Editor to enter documents (if there is an appropriate
data entry translation object registered with Sterling Gentran:Server). These
documents are located in the Workspace.

2 If you import a file, the translator checks the import definitions from the
system configuration to match the file name with a system import translation
object.
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Table 2. Outbound Translation Process (continued)

Stage Description

3 The translator uses the system import translation object to determine which
trading relationship (established in Partner Editor) corresponds to each
document in the application file, so the system knows which import map to
use to process the document.

4 The translator ascertains which import translation object is specified in the
trading relationship.

5 The translator uses the import translation object to compliance check the
document. If the document is compliant (valid), it is marked OK. If the
document is not compliant (invalid), it is marked NotOK.

6 If there is another document remaining in the import file, the translator
repeats steps 3 - 5 until all documents are processed.

7 If you manually import a file through the EDI Manager or use the Document
Editor, you need to post the compliant document to Out Documents.Once
documents are located in Out Documents, they can be sent using the process
control system or by using the EDI Manager transmit option.
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Chapter 2. System Administrator Functions

About Administrator Functions
Sterling Gentran:Server provides several programs you can use as administrative
tools, including System Configuration.

Sterling Gentran:Server writes certain fatal error and audit failures to the Windows
Application Event Log (accessible through the Windows Event Viewer) that you
can use to diagnose hardware and software problems.

You can access System Configuration in either of the following ways:
v Click the Configuration icon on the Sterling Gentran:Server EDI Manager Main

Toolbar.
v From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.

Note: You must log on to Sterling Gentran:Server with System Administration
privileges to be permitted to access the System Configuration program.

System Configuration Controllers Tab
The System Configuration Controllers tab enables you to change controller settings
for every controller in your system, including stopping and starting Sterling
Gentran:Server services on the controllers in your system. You can stop and start
the Sterling Gentran:Server system at any time by performing a series of tasks in
the correct sequence.

The Controllers tab also enables you to start and stop the Sterling Gentran:Server
Poller and Sterling Gentran:Server Scheduler services.

Additionally, the Controllers tab enables you to set a limit for the number of
process control events that can execute concurrently.

Stop the system before you perform network maintenance, upgrade the operating
system on any machine running Sterling Gentran:Server, or maintain or reorganize
your Sterling Gentran:Server database.
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Parts of the Controllers Tab

The following illustrates the System Configuration Controllers tab.

The following table describes the parts of the Controllers tab:

Table 3. Controllers tab parts and functions

Part Function

Controller Specify the name of the selected controller.

When you launch System Configuration from a client, the
controller defaults to the primary Sterling Gentran:Server system
controller.

Select Accesses the settings and start/stop controls for the chosen
controller.

Browse Displays the Choose Network Server dialog box so you can select
the appropriate controller.

User Specify the User ID of the Open Database Connectivity (ODBC)
log on account that you want Sterling Gentran:Server Executive
to use on the selected controller.

Password Specify the password of the ODBC log on account that you want
Sterling Gentran:Server Executive to use.
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Table 3. Controllers tab parts and functions (continued)

Part Function

Confirm Specify again the password of the ODBC log on account for
confirmation.

Stop/Start Stops or starts the appropriate service on the selected controller
(the service listed to the left).

Dependencies Enables you to select the services/load-ordering groups that
must be started prior to initiating the Sterling Gentran:Server
Executive.

The order that the services on which the Executive Service is
dependent must be sequenced as follows:

1. Audit Notification service

2. Mailbox service

3. Communications service (if installed)

Auto start Automatically starts the Executive Service, Poller, or Scheduler
service on the selected controller when the Sterling
Gentran:Server Executive starts.

Interval Specify a time (in seconds) to change the interval Sterling
Gentran:Server should wait between checking for polled or
scheduled events.

Limit concurrent
process control events

Limit concurrent process control events.

Max events Contains the number of process control events that the system is
allowed to concurrently execute.

Dependencies

If you click Dependencies on the Controllers tab, you can specify dependencies by
selecting the services/load-ordering groups that must be started prior to initiating
the Sterling Gentran:Server Executive. The Sterling Gentran:Server Executive
Service depends on the following installed services:
v RPC Service
v MSSQL Service
v SQL Executive Service

Important: Exercise caution in changing dependencies—be certain that you are
modifying the appropriate ones.

The following illustrates the Dependencies dialog box.
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Note: The Executive Service also depends on the Audit Notification, Mailbox, and
Communications services (in that order).

Starting the System
You can start the Sterling Gentran:Server system from any user interface client or
controller that has the System Configuration program installed on it.

Before you begin
v You must have Windows administration privileges and Sterling Gentran:Server

administration privileges to start the system.
v If you have installed Sterling Gentran:Server to be HIPAA-compliant and if you

do not have a password-secured screen saver activated on your desktop, you
will not be able to log on to Sterling Gentran:Server until the screen saver is
activated.

About this task

Notes:

v Depending on which security mode you use, if you are not currently executing
Sterling Gentran:Server, the Logon dialog box may display when you start a
Sterling Gentran:Server program (such as System Configuration).

v On the Controllers tab, you can set the Executive Service to automatically start
when Windows is booted.

To start the Sterling Gentran:Server system, complete the following steps.

Procedure
1. From the Start menu of any machine on which the System Configuration

program is installed, select Programs > Gentran Server > Gentran Server
Configuration.
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The system displays a dialog box stating that the system is down.
2. Click OK to acknowledge the message.

The system displays the System Configuration dialog box.
3. Make sure that the Controller box contains the name of your primary system

controller and click Select to access the settings and start and stop controls for
the chosen controller.

4. Click Start to initiate the Executive Service and start the system.
The system starts. After the Executive Service starts, the Start buttons for the
Poller Service and the Scheduler Service display.

5. If you want the Executive Service to start on the selected controller when the
Windows operating system starts, select Auto start next to the Executive
Service enabler.

6. Verify that the services on which the Executive Service is dependent are
ordered correctly. Click Dependencies and select the following services that
must be started before initiating the Executive Service:
a. Audit Notification Service
b. Mailbox Service
c. Communications Service (if installed)

7. To start the Poller Service, click Start to the right of the Poller.

Note: You can set the Poller Service to automatically start when the Executive
Service is started. You can also specify the interval at which Poller Service
polls the system.

8. To start the Scheduler Service, click Start to the right of the Scheduler.

Note: You can set the Scheduler Service to automatically start when the
Executive Service is started. You can also specify the interval at which
Scheduler Service checks for scheduled events.
If you have additional controllers in your system, continue with the next step.
Otherwise, continue with Step 11.

9. In the Controller box, type the name of the secondary controller or click
Browse and navigate to the controller.
The system displays the Choose Network Server dialog box. Select the
appropriate controller and click OK.

10. To access the settings and start and stop controls for the chosen controller,
click Select.

11. Click OK to exit the System Configuration program.

Stopping the System
You can stop the Sterling Gentran:Server system from any user interface client or
controller on which the System Configuration program is installed.

Before you begin

Ensure that there are no users logged on to the Sterling Gentran:Server system.
You can use the Windows Server domain manager to send a message to all users
prompting them to log off immediately.
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About this task

Note: You must have Windows administration privileges and Sterling
Gentran:Server administration privileges to stop the system.

Important: You must stop the Sterling Gentran:Server Executive Service on all
secondary controllers before stopping it on the primary system controller. If you
stop the primary system controller before stopping secondary controllers, the
secondary controllers will fail.

To stop the Sterling Gentran:Server system, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Do you have secondary controllers in your system?

v If yes, type the name of a secondary controller in the Controller box on the
Controllers tab or click Browse and navigate to the controller.

Note: Stop the Sterling Gentran:Server Executive Service on your primary
system controller last.

v If no, type the name of your primary controller in the Controller box or click
Browse and navigate to the controller.

The system displays the Choose Network Server dialog box.
3. Select the appropriate controller and click OK.
4. Click Select to access the settings and start/stop controls for the chosen

controller.
5. Click Stop to the right of Executive Service to disable it and stop the system.

The system prompts you with a warning. Click Yes.
Repeat steps 3 - 6 to stop the Executive Service on each controller in your
Sterling Gentran:Server system.

6. Click OK to exit the System Configuration program.

Changing Controller Settings
The Controllers tab enables you to set a limit for the number of process control
events that can execute concurrently. You can also change the ODBC log on
account, specify that the Sterling Gentran:Server services auto start, and change the
interval at which the system polls for data and checks for scheduled events.

About this task

Limiting the number of concurrent events allows the executing processes to run
more efficiently. Once the number of activated events exceeds the set limit, those
events over the limit are activated with a blocked status. These blocked events are
executed as currently executing events complete processing.

To change controller settings, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
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2. On the Controllers tab, type the name of the controller in the Controller box
and click Select to access the settings and start/stop controls for the chosen
controller.

Note: The boxes on the Controllers tab are only active if you select a machine
that is a controller in your system.

3. If you want to change the ODBC log on account that the Executive Service
uses, enter the User ID and password (twice) of the ODBC logon account

4. If you want the Sterling Gentran:Server Executive Service to start on the
selected controller when the Windows system starts, select Auto start (to the
right of the Executive Service).

5. Verify that the services on which the Executive Service is dependent are
ordered correctly. Click Dependencies and select the following
services/load-ordering groups that must be started before initiating the
Executive Service:
a. Audit Notification service
b. Mailbox service
c. Communications service (if installed)

6. Verify that the other installed services (such as the database management
system) or any load-ordering groups that must be started prior to initiating
the Executive Service are also selected on the Dependencies dialog box.

Note: If the selected controller is also the database controller, you must ensure
that your database management system is available before automatically
starting the Executive Service.

7. If you want the Poller service to start on the selected controller when the
Executive Service starts, select Auto start (to the right of the Poller).

8. If you want to change the interval that the Poller should wait between polling
the controller for data, select the interval (to the right of the Poller).

9. If you want the Scheduler service to start on the selected controller when the
Executive Service starts, select Auto start (the right of the Scheduler).

10. If you want to change the interval that Scheduler waits between checking for
scheduled events, set the interval (to the right of the Scheduler ).

11. If you want to limit concurrent process control events, select Limit concurrent
process control events and type the number of process control events that can
concurrently execute in the Max events box.

Note: The Executive Service must be stopped and restarted for the change to
take effect. See Starting the System and Starting the System for more
information.

12. Either click OK to exit the System Configuration program or click Apply to
save your changes without exiting System Configuration.

System Configuration System Tab
The System Configuration System tab enables you to do the following:
v Change your ODBC data source.
v Select the mailbox that Sterling Gentran:Server uses.
v Specify the interval for overdue acknowledgement checking.
v Specify the interval for deferred acknowledgement generation.
v Specify the interval for deferred acknowledgement reconciliation.
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v Specify a concatenation interval for when you have many small files sent to
your system at approximately the same time that you want to automatically
"batch process".

The ODBC data source is a set of parameters supplied to an ODBC driver to
identify a database. If you moved your Sterling Gentran:Server database to another
machine or if you change database products, you would need to change your
ODBC data source.

Important: You should be absolutely certain before you change your ODBC data
source, because a change means that you will not be able to connect to the Sterling
Gentran:Server database to which the ODBC data source pointed.

The System tab enables you to specify the frequency at which the system will
check for overdue acknowledgements. This allows you to disable or reduce the
frequency of overdue acknowledgement checking. Disabling or reducing overdue
checking may speed system throughput.

Additionally, the System tab enables you to set an interval to defer
acknowledgement generation and reconciliation and to specify a concatenation
interval for when you have many small files sent into your system at
approximately the same time that you want to automatically "batch process".

Note: The interval start time for these settings depends on the time the Executive
service completes its start-up routine. For example, if the Executive service starts at
8:24:32 AM, an interval of 30 seconds elapses before the deferred processing
executes (at 8:25:02). Also, when you specify an interval of 15 minutes, the deferred
process executes at 9, 24, 39, and 54 minutes past every hour.

See "Using Acknowledgements" in the IBM Sterling Gentran:Server for Microsoft
Windows User's Guide for more information about setting the deferred or immediate
acknowledgement processing flag (on the Partner Editor Inbound Relationship
dialog box, Advanced options).
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Parts of the System Tab

The following illustrates the System Configuration System tab.

Table 4. System tab parts and functions

Part Function

ODBC Data Source Select the ODBC data source to which this system points to
access the Sterling Gentran:Server database.

Select the mailbox Sterling
Gentran:Server should use

Select the mailbox that Sterling Gentran:Server uses.

Enter the interval for
overdue acknowledgement
checking

Specify the interval (in whole minutes) at which the system
should check for overdue acknowledgements.

Enter the interval for
overdue acknowledgement
generation

Specify the interval (in whole minutes) at which the system
should generate acknowledgements. This enables you to
defer acknowledgement processing.

Enter the interval for
overdue acknowledgement
reconciliation

Specify the interval (in whole minutes) at which the system
should reconcile acknowledgements. This enables you to
defer acknowledgement processing
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Table 4. System tab parts and functions (continued)

Part Function

Enter the interval for
automatic file concatenation

Specify the interval (in seconds) at which the system should
concatenate (batch) small files into one file for processing.
Note: This function is useful when you have many small
files sent into your system at approximately the same time
that you want to automatically batch process.

Files are concatenated based on their mailbox of origin. For
files that have a content type that invokes a
GDW_MBImport process, the files are concatenated to a file
in the \TransIn directory, with the filename based on the
filename of the first file received. The format is:

<ExternalDataKey>_<first file>.<first file extension>

For example, the first file received is named pet_810.txt
and has an external data key of 600. The file created in
\TransIn is named 600_pet_810.txt.

Files undergoing a GDW_MBProcessFile will be
concatenated to the .ext file in Gensrvnt\Temp. The name
will be the external data key of the first file received (for
example, 600.ext or 601.ext).

Changing the ODBC Data Source
The ODBC data source is a set of parameters supplied to an ODBC driver to
identify a database.

About this task

You may need to change the ODBC data source that your system points to for a
number of reasons. For example, you would need to change your ODBC data
source if you moved your Sterling Gentran:Server database to another machine or
changed database products.

Important:

v Be absolutely certain before you change your ODBC data source, because a
change means that you cannot connect to the Sterling Gentran:Server database to
which the ODBC data source pointed.

v Do not change the data source if any users are logged on to Sterling
Gentran:Server.

To change the ODBC data source, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Select the System tab.
3. From the ODBC Data Source list, select the ODBC data source to which this

system points to access the Sterling Gentran:Server database.
4. Either click OK to exit the System Configuration program or click Apply to

save your changes without exiting System Configuration.
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Changing the Checking Frequency of Overdue
Acknowledgements

This function enables you to specify the frequency at which the system checks for
overdue acknowledgements (in whole minutes), thus allowing you to disable or
reduce the frequency of overdue acknowledgement checking. Reducing or
disabling overdue acknowledgement checking may speed system throughput.

About this task

To change the frequency of overdue acknowledgement checking, complete the
following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Select the System tab.
3. In the Overdue acknowledgement checking box, type the interval (in whole

minutes) at which the system should check for overdue acknowledgements.
Entering zero disables overdue acknowledgement checking.

4. Either click OK to exit the System Configuration program or click Apply to
save your changes without exiting System Configuration.

System Configuration Mailbox Tab
The Mailbox tab on the System Configuration dialog box enables you to view,
change, create, and delete Mailbox subsystem parameters. You can also specify the
type of data that the Mailbox processes and the actions the system performs on
each type of data.

The following illustrates the System Configuration Mailbox tab.
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Table 5. Mailbox tab parts and functions

Part Function

(list) Displays the defined mailbox parameters.

New Enables you to define a new mailbox specification.

Delete Removes the selected mailbox specification.

Content Select the content type of the message.
Note: This value is case-sensitive.

SubContent Select the subcontent type of the message. Valid values:

v Import

v Document-EDI

v EDI

v RosettaNet (only if you have Sterling Gentran:Server for
RosettaNet installed)

Note: This value is case-sensitive.
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Table 5. Mailbox tab parts and functions (continued)

Part Function

Action Select the action for the system to perform when the specified
content and subcontent types occur. Valid values:

v GDW_Process_MBFile - process a Mailbox file from an
inbound transmission.

v GDW_Import - perform the Import function on a specified file.

v GDW_MBImport - perform the Mailbox Import function on a
specified file.

Changing Mailbox Parameters
About this task

To change mailbox parameters, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Select the Mailbox tab.
3. From the Content column, select the parameter set that you want to modify.
4. From the Content list, select or type the message content type.
5. From the SubContent list, select or type the message subcontent type.
6. From the Action list, select the action for the system to perform when the

specified content and subcontent types occur.
7. Click OK.

You are prompted to stop and restart the primary system controller before the
changes take effect.

8. Click OK.
The system displays the Controllers tab so you can stop and restart the primary
Sterling Gentran:Server system controller. See Stopping the System for more
information.

9. Click OK to exit the System Configuration program.

Creating New Mailbox Parameters
About this task

To create new mailbox parameters, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Select the Mailbox tab.
3. Click New.
4. From the Content list, select or type the message content type.
5. From the SubContent list, select or type the message subcontent type.
6. From the Action list, select the action for the system to perform when the

specified content and subcontent types occur.
7. Click OK.
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You are prompted to stop and restart the primary system controller before the
changes take effect.

8. Click OK.
The system displays the Controllers tab so you can stop and restart the primary
Sterling Gentran:Server system controller. See Stopping the System for more
information.

9. Click OK to exit the System Configuration program.

Deleting Mailbox Parameters
About this task

To delete mailbox parameters, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Select the Mailbox tab.
3. From the Content column, select the desired mailbox parameter and click

Delete. The mailbox parameter is deleted without warning.
4. Click OK to exit the System Configuration program.

System Configuration Splitter Tab
The Splitter tab on the System Configuration dialog box enables you to define and
edit splitter entries for Sterling Gentran:Server. Default splitter entries are installed
with the system. Each splitter entry contains the parameters that are necessary for
the system to identify and split interchanges for received data.

You may need to define, edit, or delete splitter entries if you are implementing a
proprietary standard or if you are changing the implementation of an EDI
standard.

Important: We strongly recommend that you do not modify or delete the default
splitter entries.

The following illustrates the System Configuration Splitter tab.

22 IBM Sterling Gentran:Server for Windows: Administration Guide



Table 6. Splitter tab parts and functions

Part Function

New Enables you to define a new splitter entry.

Delete Removes the selected splitter entry.
Important: Do not delete the default splitter entries.

Move Up Moves a splitter entry up in the list.

Move Down Moves a splitter entry down in the list.
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Table 6. Splitter tab parts and functions (continued)

Part Function

Type Select the type of splitter entry. Valid values:

v Fixed - The splitter entry expects a defined set of delimiters in
the EDI data (default).

v Fixed Position - The splitter entry expects delimiters at defined
positions in the EDI data so the system can determine what
the delimiter is.

v Variable Position - The splitter entry expects defined
interchange start and end segments, element delimiter position
(so the system can determine what the delimiter is), number of
elements in the start segment, maximum length of the start
segment, maximum length of the last element in the start
segment and the end segment.

v Positional - The splitter entry expects the maximum length of
end segment to be defined.

v CII - The splitter entry expects CII data.

v XML - The splitter entry expects XML data with the start
segment defined.

v NCPDP Batch - The splitter entry expects NCPDP Batch data.
Note: Only one NCPDP Batch splitter entry is allowed. If you
have already defined a NCPDP Batch splitter entry and
attempt to create another one, the system displays a dialog box
stating that you cannot create a second entry for the NCPDP
Batch type.

Start Specify the start segment of the interchange.

End Specify the end segment of the interchange.

Table 7. Translation Objects parts and functions

Part Function

Interchange Break Select the interchange break translation object that will be used to
break the interchange.

Functional Group Break Select the functional group break translation object that will be
used to break the functional groups in the interchange.

Transaction Set Break Select the transaction set break translation object that will be
used to break the transaction sets in the interchange.

F/A Extraction Select the functional acknowledgement break translation object
that will be used to extract interchange level functional
acknowledgements from the interchange.

Note: Only registered interchange break translation objects are displayed in these lists.

Table 8. Delimiter Positions parts and functions

Part Function

Tag The system uses this value to determine what is being used as a
tag separator and breaks the interchange depending on the
standard you are using:

v For Fixed type, the tag separator

v For Fixed Position type, the position of the tag separator in the
interchange

Note: If tag separators are not applicable to the standard that
you are using, enter 0 in the Tag box.
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Table 8. Delimiter Positions parts and functions (continued)

Part Function

Elem Depends on the standard you are using:

v For Fixed type, the element separator

v For Fixed Position type, the position of the first element
separator in the interchange

v For Variable type, the position of the first element delimiter in
the interchange

Note: For Fixed Position and Variable, the system uses this value
to determine what is being used as an element delimiter and
breaks the interchange accordingly.

If element separators are not applicable to the standard that you
are using, enter 0 in the Elem box.

Sub Elem The system uses this value to determine what is being used as a
subelement delimiter and breaks the interchange depending on
the standard you are using:

v For Fixed type, the subelement separator

v For Fixed Position type, the position of the first subelement
separator in the interchange

Note: If subelement separators are not applicable to the standard
that you are using, enter 0 in the Sub Elem box.

Seg The system uses this value to determine what is being used as a
segment terminator and breaks the interchange depending on the
standard you are using:

v For Fixed type, the segment terminator

v For Fixed Position type, the position of the first segment
terminator in the interchange

Note: If segment terminators are not applicable to the standard
that you are using, enter 0 in the Seg box.

Rep Elem If the standard you are using employs composite fields
containing repeating data elements, this contains the location of
the repeating element separator in the interchange. These fields
may be formatted to accommodate a greater number of
occurrences than might be practical for real-time transmissions.

Rel Char The system uses this value to determine what is being used as a
release indicator delimiter and breaks the interchange depending
on the standard you are using:

v For Fixed type, the release indicator

v For Fixed Position type, the position of the first release
indicator in the interchange

Note: If release indicators are not applicable to the standard you
are using, enter 0 in the Rel Char box.

Dec Point Depends on the standard you are using:

v For Fixed type, the decimal point notation

v For Fixed Position type, either a comma or period to indicate
the decimal point in a numeric field

v For Variable type, either a comma or period to indicate the
decimal point in a numeric field

Note: If decimal points are not applicable to the standard that
you are using, enter 0 in the Elem box.
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Table 9. Binary Data parts and functions

Part Function

Name of Binary
Segment that Sterling
Gentran:Server should
look for

Specify the name of the binary segment for which the system
should search in the data. Valid values:

v BIN - The name of the binary segment

v BDS - The name of the binary segment

v blank - Indicates that you do not expect the data to contain
any binary segments, so the system will not check for them.

Table 10. Limits parts and functions

Part Function

Start seg count Contains the number of elements in the interchange start
segment.
Note: This is a control that the system uses to determine the
segment terminator. The system assumes that the segment
terminator is the first non-alphabetic or non-numeric character in
the last element.

Max length of start
segment

Contains the maximum length of the interchange start segment.
Note: This is a control that the system uses to determine the
segment terminator. The system will not look for the segment
terminator beyond the maximum length of the start segment.

Max length of last
element in start
segment

Contains the maximum length of the last element in the
interchange start segment.
Note: This is a control that the system uses to determine the
segment terminator. The system will not look for the segment
terminator beyond the maximum length of the last element in the
start segment.

Max length of end
segment

Contains the maximum length of the interchange end segment.
Note: This is a control that the system uses to determine the end
of the interchange.

Defining a New Splitter Entry
You need to define a new splitter entry if you are implementing a proprietary
standard or if you are changing the implementation of an EDI standard.

About this task

To define a new splitter entry, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Select the Splitter tab.
3. Click New.
4. From the Type list, select the type of splitter entry.
5. Enter values for Start and End (if available).
6. In the Translation Objects section, select values for the break translation objects.
7. In the Delimiter Positions section, complete the delimiters that are appropriate

for the standard you are using.
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8. Either click OK to exit the System Configuration program or click Apply to
save your changes without exiting System Configuration.

Editing a Splitter Entry
You may need to modify a splitter entry if you are implementing a proprietary
standard or if you are changing the implementation of an EDI standard.

About this task

We strongly recommend that you do not modify the default splitter entries that are
shipped with Sterling Gentran:Server.

To edit a splitter entry, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Select the Splitter tab.
3. From the Type column on the Splitter tab, select the desired splitter entry.
4. If you want to change the type, select the type of splitter entry from the Type

list.
5. Enter values for Start and End (if available).
6. In the Translation Objects section, select values for the break translation objects.
7. In the Delimiter Positions section, complete the delimiters that are appropriate

for the standard you are using.
8. Either click OK to exit the System Configuration program or click Apply to

save your changes without exiting System Configuration.

Deleting a Splitter Entry
You may want to delete a splitter entry if you are implementing a proprietary
standard or if you are changing the implementation of an EDI standard.

About this task

We strongly recommend that you do not delete the default splitter entries that are
shipped with Sterling Gentran:Server.

To delete a splitter entry, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Select the Splitter tab.
3. Select the desired splitter entry from the Type column and click Delete.

The selected splitter entry is deleted without warning.
4. Click OK to exit the System Configuration program.

Changing the Order of Splitter Entries
You may need to reorder the list of splitter entries because the system breaks
interchanges based on the sequence of entries in the list on the Splitter tab. For
example, if you defined the splitter entry for a UNB segment before defining one
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for a UNA segment, you would want to move the UNA entry so it appears in the
list ahead of the UNB entry, because that is the order that the system must process
the interchange (since the UNB is imbedded in the UNA).

About this task

To change the order of splitter entries, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Select the Splitter tab.
3. On the Splitter tab, select the desired splitter entry from the Type column and

do one of the following:
v Click Move Up to move that splitter entry up in the list.
v Click Move Down to move that splitter entry down in the list.

4. Either click OK to exit the System Configuration program or click Apply to
save your changes without exiting System Configuration.

System Configuration Users Tab
The System Configuration Users tab enables you to administer Sterling
Gentran:Server users, including their access privileges. System security is an
important ongoing step in controlling who can log on to your system and which
functions they can access. Security ensures the integrity of your data by limiting
who can make changes to specific areas of the system.

Notes:

v You need to add Sterling Gentran:Server users to the system.
v If you are running Sterling Gentran:Server in Integrated security mode and the

User ID for each user matches the Windows User ID for that user, the user is not
required to log on to Sterling Gentran:Server. You may need to change the
Sterling Gentran:Server and database passwords for users when their Windows
passwords are changed.

Parts of the Users Tab

Table 11. Users tab parts and functions

Part Function

(list) Displays a list of the defined Sterling Gentran:Server users.

New Displays the Security Access dialog box, which enables you to
define a new user.

Edit Displays the Security Access dialog box, which enables you to
change user access parameters.

Delete Removes the selected user.

Parts of the Security Access dialog box

Table 12. Security Access dialog box parts and functions

Part Function

User ID Specify a unique logon identifier for the user.
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Table 12. Security Access dialog box parts and functions (continued)

Part Function

User Name Specify the name of the user.

Password

Verify Password

Specify the user password.

You must confirm the password in the Verify Password box.

Security Matrix Select access rights for the user.

You can also update a user to have System Administration
privileges or remove your own System Administration privileges.
If you do, you may not reset your privileges once your profile
has been saved.
Note: The system does not allow you to remove System
Administration privileges from the last System Administrator in
the system.

Valid values:

v System Administration gives system administrator rights.
Important: Be extremely careful about which users you assign
to be system administrators. Only system administrators can
access the System Configuration program.

v Partner Profiles gives access to the Partner Editor and Partner
Wizard.

v Send/Receive gives access to send and receive data.

v Import gives access to import data.

v Export gives access to export data.

v Screen Entry gives access to the Document Editor (data entry)
subsystem.

v Unattended gives access to the process control subsystem.

Adding a User
A new user can be set up only by a user with System Administration privileges.
Otherwise, you need to get the security administrator within your organization to
complete the setup.

About this task

To add a user, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Select the Users tab.
3. On the Users tab, click New.
4. In the User ID box, type a unique logon identifier for this user.
5. In the User Name box, type the name of this user.
6. In the Password box, type the user's password.

Note: Passwords can be up to 126 characters long.
7. In the Verify Password box, type the user's password again.
8. From the Security Matrix section, select the areas of the system that the user

needs to access.
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9. Click OK to exit the Security Access dialog box.
10. Click OK to exit the System Configuration program.

Changing a User's Security Access
A user's security access profile can only be changed by a user with System
Administration privileges. If you are a user with System Administration privileges,
you can alter your own profile and the system access rights for all other users.

About this task

Note: The system does not allow you to remove System Administration privileges
from the last System Administrator in the system.

To change a user's security access profile, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Select the Users tab.
3. Select the User ID for the user whose access you want to change and click Edit.
4. To modify the user name, type the name of this user in the User Name box.
5. To modify this user's password, type the user's password in the Password box.
6. In the Verify Password box, type the user's password again.
7. From the Security Matrix section, select the areas of the system that the user

needs to access.
8. Click OK to exit the Security Access dialog box.
9. Click OK to exit the System Configuration program.

Deleting a User
Only a security administrator (a user with System Administration privileges) can
delete a user access profile from the system.

About this task

Note: The system does not allow you to delete the last user with System
Administration privileges from the system.

To delete a user, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Select the Users tab.
3. Select the User ID for the user you want to delete and click Delete.
4. Click OK to delete the selected user.
5. Click OK to exit the System Configuration program.

System Configuration Directories Tab
The Directories tab on the System Configuration dialog box enables you to modify
the system data store folders that you established during installation.
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The Directories tab also enables you to establish a hierarchical file structure for the
document and translator report folders (Inbound and Outbound Interchanges,
Documents, and Translator Reports) that corresponds to the file creation date or
date and time.

Note: Using the hierarchical file structure improves system functionality by
eliminating the possibility of an excessive number of files in a single folder and
improves user navigation in these folders.

The following illustrates the System Configuration Directories tab.

Table 13. Directories tab parts and functions

Part Function

Translation Objects Specify the location of the registered translation objects. The
default is RegTransObj.

Unattended Sessions Specify the location of the process control event, session, and
calendar files. The default is Unattend.

Archive Files Specify the location of the archive files. The default is Archive.

Error Files Specify the location of any interchanges or network reports that
the Splitter was unable to recognize. The default is ErrorData.
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Table 13. Directories tab parts and functions (continued)

Part Function

Inbound Transmissions Specify the location of any Mailbox Import files. The default is
TransIn.
Note: The path you set for the TRANSIN directory must exactly
match the UNC file path you specify for Mailbox Imports on the
Imports tab.

External Data Files Specify the location of all external data files. The default is
ExternalData.

Inbound Interchanges Specify the location all received interchanges.The default is IntIn.

Outbound Interchanges Specify the location of all sent interchanges. The default is
IntOut.

Documents Specify the location of all document files. The default is
Documents.

Translator Reports Specify the location of all translator reports. The default is
TranRpt.

Directory Format Select a value to establish a hierarchical file structure for the
document and translator report folders, which corresponds to the
file creation date or date and time. Valid values:

v None (this is the default)

v YYYY/MM/DD (groups files by date in the format
#YYYY/MM/DD)

v YYYY/MM/DD/HH (groups files by date and time in the
format #YYYY/MM/DD/HH)

Note: The directory structure you set here results in a
hierarchical structure with the first level being the 4-digit year.
Then, depending on the format specified, the next level will be
the 2-digit month and then the 2-digit day, following by the
2-digit hour (in 24-hour format), if specified.

If you change the directory structure, the previous structure
remains intact, but the system loads new files into the
hierarchical level that is currently specified.

PIP 0A1 Interchanges For RosettaNet users only

Specify the location of all outbound PIP 0A1 Failure Notification
Action interchanges. The default is IntRNPIP0A1.

... (Browse) Enables you to select the appropriate folder from the Choose
Directory dialog box.

Modifying System Data Store Folders
You can modify the system data store folders that you establish during Sterling
Gentran:Server installation by using the System Configuration program.

About this task

To modify system data store folders, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Select the Directories tab.
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3. Modify the appropriate system data store folders by either typing the path and
folder in the appropriate box or by browsing to it.
If you are running Sterling Gentran:Server in a distributed environment, all
folders must be entered in UNC format (instead of using drive mappings). If
you browse to select a folder from the Choose Directory dialog box, the system
automatically uses UNC format to specify the folder. The system displays the
Choose Directory dialog box.

4. Select the file path and click OK.
5. If you want to establish a hierarchical file structure for the document and

translator report folders (Inbound and Outbound Interchanges, Documents, and
Translator Reports) that correspond to the file creation date or date and time,
select the file structure from the Directory Format list.

6. Click OK to exit the System Configuration program.

System Configuration Security Tab
The Security tab on the System Configuration dialog box enables you to define the
security mode for your system.

We recommend that you set the same security modes for Sterling Gentran:Server
and your database.

Depending on which security mode you use, if you are not currently executing
Sterling Gentran:Server, the Logon dialog box may be displayed when you start a
Sterling Gentran:Server program (such as System Configuration).

Important: If your ODBC data source does not support, or is not configured, for
Integrated or Mixed security, it may require you to log on separately.

The following illustrates the System Configuration Security tab.
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Security Modes
The Security tab on the System Configuration dialog box enables you to define the
security mode for your system.

Sterling Gentran:Server uses the following security modes:
v Integrated
v Mixed
v Standard

Integrated security mode

Integrated is the recommended security mode. This mode does not prompt a user
to sign on to Sterling Gentran:Server if the user's ID is the same for Sterling
Gentran:Server as it is for Windows.

In this mode, when you have configured only one system, you do not have the
opportunity to log on to Sterling Gentran:Server as another user unless the logon
fails. In this case, the system displays the Logon dialog box to ensure access to the
system.

When you have configured more than one system and are using the Integrated
security mode, the system displays the Logon dialog box so the user has the
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opportunity to select the appropriate Sterling Gentran:Server system (the User ID
and Password are disabled on the Logon dialog box).

Mixed security mode

Mixed security mode always prompts the user with the Sterling Gentran:Server
Logon dialog box. The Windows user name is the default value.

If the user's Sterling Gentran:Server user ID is the same as it is for Windows, the
user can click OK on the Logon dialog box. In this case, the password is not
validated and the user is logged on to Sterling Gentran:Server.

If the user changes their Windows user name, the system prompts the user for a
password that is validated before logging on to Sterling Gentran:Server. This
allows the capability to log on as another user.

Standard security mode

Standard security mode always requires the user to log on to Sterling
Gentran:Server. The Windows user name is defaulted on the Logon dialog box.

Defining the Security Mode
The Security tab on the System Configuration dialog box enables you to define the
security mode for your system.

About this task

To define the security mode for Sterling Gentran:Server, complete the following
steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Select the Security tab.
3. Select the option that corresponds to your system’s needs and uses.
4. Click OK to save your changes and exit the System Configuration program.

System Configuration Imports Tab
The Imports tab on the System Configuration dialog box enables you to determine
which import or system import translation object is used to translate files in the
specified location with the specified file extension.

The import or system import translation object is used by the system to build a
key to find the partner relationship to determine which translation object is used to
translate data.

For each type of import file, you need to define an import specification that
indicates which import or system import translation object is used to begin
translation during the import process. You can use wildcards (*), if necessary.
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File type vs. file name

You can either specify a type of file or a specific file name that the system imports.
We recommend that you use a file type rather than specifying a path and folder.
This ensures that users can import files of the specified type from their local drives
without using UNC file names.

The import function was unsuccessful if any of the following are true:
v A UNC file name is specified on the System Configuration Imports tab and a

local drive (such as the C drive) is specified in the import.
v A file type or name is specified on the System Configurations Imports tab and a

UNC file name is specified in the import.
v The specified import folder has two different shares established to it and the

System Configuration Imports tab uses one and the import uses the other one.

The import function was successful if any of the following are true:
v A UNC file name is specified on the System Configuration Imports tab and a

mapped drive (such as the F drive) is specified in the import.
v A UNC file name is specified in both the System Configuration Imports tab and

the import (provided that both use the same share).
v A file type or name is specified in both the System Configuration Imports tab

and the import folder.

Parts of the Import Tab

Table 14. Import tab parts and functions

Part Function

(list) Displays a list of the defined import specifications.

File Path Specify the path and type of file (or file name).
Note: You can type the name of a specific file or use wildcards
(*) to indicate all files with a specified extension (such as *.txt).

Translation Object Select the import or system import translation object that you
want the system to use to begin translation when a file of the
specified type is imported. The Translation Object list contains
the description of every import and system import translation
object that is registered with the system.

New Enables you to define a new import specification.

Delete Removes the selected import specification.

Move Up Moves an import specification up in the list.

Move Down Moves an import specification down in the list.

Browse Enables you to select the file path from the Choose Directory
dialog box.

Defining a New Import Specification
You need to define an import specification for each type of file (such as the file
location, file name, or file extension) that you are importing. If you want to import
files from a location, a specific file name, or files with a specific extension that is
not defined in an import specification, you need to create a new import
specification.
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About this task

To define a new import specification, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Select the Imports tab.
3. Click New.
4. In the File Path box, enter the file type or browse to select the folder. We

recommend that you enter a file type in this box rather than specifying a path
and folder. This ensures that users can import files of the specified type from
their local drives without using UNC file names.

Note: For a Mailbox Import, you must specify the UNC path and file name.
This must exactly match the path you set for the TRANSIN directory on the
Directories tab.
The system displays the Choose Directory dialog box.

5. Select the file path and click OK.

6. From the Translation Object list, select the import or system import translation
object that you want the system to use to begin translation when a file of the
specified type is imported.

7. Either click OK to exit the System Configuration program or click Apply to
save your changes without exiting System Configuration.

Editing an Import Specification
You can modify any existing import specification. If the location from which you
want to import files, the specific file name, or the file extension for any existing
import specification changes, you need to edit that import specification.

About this task

To edit an import specification, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Select the Imports tab.
3. Select the desired import specification from the File Path column to access that

import specification.
4. In the File Path box, enter the file type or browse to select the folder. We

recommend that you enter a file type in this box rather than specifying a path
and folder. This ensures that users can import files of the specified type from
their local drives without using UNC file names.

Note: For a Mailbox Import, you must specify the UNC path and file name.
This must exactly match the path you set for the TRANSIN directory on the
Directories tab.
The system displays the Choose Directory dialog box.

5. Select the file path and click OK.
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6. From the Translation Object list, select the import or system import translation
object that you want the system to use to begin translation when a file of the
specified type is imported.

7. Either click OK to exit the System Configuration program or click Apply to
save your changes without exiting System Configuration.

Deleting an Import Specification
About this task

To delete an import specification, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Select the Imports tab.
3. Select the desired import specification from the File Path column and click

Delete.

Note: The import specification is deleted without warning.
4. Click OK to exit the System Configuration program.

Changing the Order of Import Specifications
You may need to reorder the list of import specifications if you have more than
one translation object defined for the same file path.

About this task

If more than one import specification contains the exact same file path, the system
uses the first one in the list on the Import tab to build the key to find the partner
relationship to determine which translation object is used to translate data.

Note: If a file path with *.* (all files in specified path) is listed sequentially before
any other file specifications, the system ignores any successive file specifications.

To change the order of import specifications, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Select the Imports tab.
3. Select the desired import specification from the File Path column and do one of

the following:
v Click Move Up to move that import specification up in the list.
v Click Move Down to move that import specification down in the list.

4. Click OK to exit the System Configuration program.
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System Configuration Audit Notification Tab
The Sterling Gentran:Server System Configuration dialog box Audit/Notification
tab allows you to access the Audit Notification System components you need to
configure audit and notification activities.

The Audit Notification System components are:
v Audit Messages
v Notifications
v Operators
v Server settings

Note: This dialog box also allows you to purge the contents of the Audit Log.

To access the System Configuration dialog box, from the Start menu select
Programs > Gentran Server > Gentran Server Configuration. When the system
displays the System Configuration dialog box, select the Audit/Notification tab.

The following table describes the parts of the System Configuration dialog box
(Audit/Notification tab):

Table 15. Audit/Notification tab parts and functions

Part Function

Messages Accesses the Audit Messages browser to view the list of audit
messages. From this dialog box you can access others to:

v Modify user-related audit message information for messages
defined by Sterling Gentran:Server.

v Add, change, and delete your own (user-defined) audit
messages.

v Search for a specific audit message.

Notifications Accesses the Notify dialog box to view the list of notifications
defined in the system. From this dialog box you can access others
to add, change, and delete notifications.

Operators Accesses the Operators browser to view the list of operators
defined in the system. From this dialog box you can access others
to:

v Add and delete operators.

v Change operator properties such as e-mail address and pager
number.

Server Accesses the Audit/Notification Server Properties dialog box to
configure database and notification server options (such as
communications port and MAPI profile), as well as setting service
dependencies. You can stop and start the Audit Notification Server
from this dialog box.

Purge Deletes the contents of the Audit Log.
Note: You can also purge the Audit Log by using the
GDW_Audit_Purge command in a Process Control session.
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System Configuration External Data Tab
The External Data tab on the System Configuration dialog box enables you to
define how Sterling Gentran:Server copies external data files to the system data
store.

You can specify that the copy of external data files will occur by system action:
v process file
v import
v export

These are the only parameters you can set on the External Data tab because the
system always copies data to the External Data folder when processing inbound
data received from a Mailbox and when processing import data coming through
Mailbox (when a Message Content Type is Application/Import).

In either of these cases, the system extracts the data from the Mailbox message into
a file to process the data through Sterling Gentran:Server, so the external data is
always copied to the External Data folder.

Additionally, when outbound data is sent to the Mailbox from Sterling
Gentran:Server, the data is related to a Mailbox message and is not saved to the
External Data folder. When data is sent outbound and the data in Mailbox is
deleted or archived, that data may not be viewed in the Sterling Gentran:Server
external data view.

Note: If you do not specify that any process file, import, or export external data
should be copied, the option to view external data files is not available from the
Sterling Gentran:Server document browsers.

Setting External Data Options
The External Data tab on the System Configuration dialog box enables you to
define how Sterling Gentran:Server copies external data file to the system data
store.

About this task

To define the external data options in Sterling Gentran:Server, complete the
following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Select the External Data tab.
3. Select the check boxes that correspond to the Sterling Gentran:Server activities

for which you want the system to copy external data files.
4. Either click OK to exit the System Configuration program or click Apply to

save your changes without exiting System Configuration.
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The Event Viewer
You can use the Windows Event Viewer to view the Windows Application Event
Log. Sterling Gentran:Server writes fatal errors that cannot be written to the Audit
Log (such as database open errors) and audit failures (such as unable to write to
Audit Log) to the Windows Application Event Log.

The Windows Application Event logging service starts automatically when you
boot Windows. By default, Sterling Gentran:Server writes these types of critical
errors to the Application Event Log on the machine that is executing Sterling
Gentran:Server.

Notes:

v You can set up notification parameters so that these messages are sent to the
Notifications Component as well.

v You can specify that Sterling Gentran:Server writes user-defined audit messages
to Windows Event Log.

The information that Sterling Gentran:Server writes to the Application Event Log
may be useful in diagnosing a hardware or software problem. Additionally, if your
system administrator periodically views the Application Event Log for Sterling
Gentran:Server, he or she may be able to identify problems so that errors can be
detected and corrected before impacting future Sterling Gentran:Server processing.

The Event Log

If you are logged on to Windows with the appropriate security privileges, you can
view the Application Event Log for each machine to which you have access.

You should periodically view the Application Event Log for each machine that is
running Sterling Gentran:Server. The Application Event Log is accessed by using
the Windows Event Viewer. You can typically access the Event Viewer for a
machine by selecting Programs > Administrative Tools from the Windows Start
menu, and then double-clicking Event Viewer in the Administrative Tools group.

Note: The Windows Application Event Log for each machine contains messages
that are logged by other Windows applications executed on that machine and not
just by Sterling Gentran:Server. However, you can filter the display of events in the
Application Event Log to contain only Sterling Gentran:Server events.
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Chapter 3. Audit Notification

About the Audit Notification System
The Audit Notification System is a software component installed with Sterling
Gentran:Server that performs error identification and allows you to configure audit
message generation and notification actions within Sterling Gentran:Server and
other related systems (such as Mailbox, Archive, or a user system).

You must have Microsoft Outlook installed on the Primary Sterling Gentran:Server
System Controller. Also, due to Microsoft security changes, for Office XP and
forward (including Outlook 2002 and forward), Outlook must be configured for
Microsoft Exchange Server for messages to be sent automatically. In addition, the
Primary Sterling Gentran:Server System Controller must be in the same or a
trusted domain as the Microsoft Exchange Server.

The use of any other configuration of Outlook will result in messages not being
sent automatically unless the Outlook client is launched.

If the E-mail back-end is Microsoft Exchange, the Sterling Gentran:Server Mailbox
service must use a domain account that has been granted access to an Exchange
mailbox. This allows the service to log on directly to the mailbox without being
prompted for a password.

Audit Notification System Flow
The following diagram illustrates the data flow within the Audit Notification
System.
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Table 16. Audit Notification System flow

Stage Description

1 Events occur during processing, initiating the generation of audit messages.

2 The appropriate systems or system components send audit messages to the
Audit Notification Server.

3 The Audit Notification Server sends the messages to their configured
destinations, which might be one or all of the following: Audit Log,
Windows Event Log, Notification Log (when a notification is generated for
an audit message).

4 The Audit Notification Server sends any notifications (alerts, e-mails, or
pages) to specified operators, or initiates Process Control events, according
to the specifications within notifications that apply to the generated
messages.

Configuration Overview
You can configure the Audit Notification System in a variety of ways to suit your
needs. This topic provides an example scenario and explains your configuration
options at a high level.

Monitoring (or auditing) processing activity is crucial to pinpointing and correcting
errors. The Audit Notification System is designed to help you specify the errors
and system activity you want to monitor, allow you to monitor and respond to
errors as efficiently as possible, and allow you to notify the appropriate people
when action must be taken to correct an error. Use the Audit Notification System
for the following activities:
v Modifying and adding audit messages
v Restricting display of messages you do not want to view on the Audit Log
v Designating individuals to be notified when specific errors occur
v Configuring multiple responses (notifications) to the same error
v Sorting your Audit Log display as you prefer for easy reference

Using the Audit Notification System, you could define a new audit message to be
generated whenever the system receives an invoice with a total that is higher than
a specified dollar amount. Then you might configure a notification to be e-mailed
to the specified person who needs to respond to the invoice activity.

Audit message information

An audit message summarizes processing and user activity information, such as:
v Steps occurring in a Process Control event
v A user editing a document
v A user creating a mailbox
v Processing error information (such as translation errors or partner not found)
v Communications errors
v System errors such as database errors and network errors

Event ID

The Event ID number is the same for all Audit Log entries generated from the
same Process Control event, user session, Mailbox event, or system-generated
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event. By default, entries with the same Event ID are grouped together in the
Audit Log (sorted by date and time within the event). This makes locating related
events on the Audit Log quick and easy.

If two Process Control events executed concurrently, the different Event ID
associated with the Audit Log entries for each makes it easier for you to determine
which entry corresponds with which event.

Audit Notification Customization
The Audit Notification system allows you to configure audit messages and the
Audit Log display so you can monitor system activity according to the criteria that
is most important to you.

System-defined audit messages are generated by Sterling Gentran:Server. You can
add information to the descriptive message text so that the Audit Log display of
that message contains customized information. Depending on the severity level of
the message, you also can direct the message to be written to the Windows Event
Log and the Audit Log.

Add your own audit messages to the system. Using the Audit Notification System,
you can define your own audit messages that you want to be written to the Audit
Log, and then use Process Control or extended rules to configure them to be
written to the Audit Log. These are referred to as user-defined audit messages.

Customize the Audit Log display.
v You can sort messages in the display lists by clicking on column headings, or

specifying Date/Time view or Event view.
v You can use a criteria-filtering function so only messages matching the criteria

you enter are displayed.
v You can control the amount of data the system displays on the Audit Log at one

time, to allow for faster display.
v You can specify that the system write messages to the Audit Log for events you

need to know about. Conversely, you can specify that the system not write audit
messages to the Log that you do not need to view. In this way your Audit Log
does not fill up with unnecessary data.

Operators
You must supply the Audit Notification system with identifying information for
each user (operator) you designate to receive notifications when specified audit
messages are generated. This includes data such as name, e-mail information, and
pager number. When you set up the notifications, the system uses the operator
definition for the recipient you specify.

Use notifications to alert your defined operators of system activity. You set up
notifications by specifying any of the following:
v The audit message or type of audit message that, when generated, initiates the

notification
v The operators to receive the notification
v The type of notification action (such as e-mail, alert, or page)

The Audit Notification system allows you to set up notifications using any of the
following options:
v Different criteria - Notifications can be sent in response to:
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– A specific audit message
– All audit messages of a designated level (such as warning messages)
– All audit messages generated by a designated functional source or component

(such as Sterling Gentran:Server or the Server/CONFIG program)
v Different types - For example, you can configure a notification in the form of an

alert, a page, an e-mail, or a Process Control event.
v In multiples to be sent in response to one audit message - For example, you

could configure a page and an e-mail to be sent to multiple operators, in
response to one audit message.

Configuration Process
Configuring audit and notification activity is an ongoing process. As needed, you
can modify message, operator, and notification properties, and reorganize your
Audit Log display. If Sterling Gentran:Server installed without errors, you can use
the system immediately, although notifications cannot be sent until you make the
appropriate configurations.

If you need to configure different system components, you must perform certain
configuration steps in a logical order.

Examples

v Before the system can send notifications in the form of a page or an e-mail, you
must configure specific Server settings.

v Once you are using the system, you must set up operators before you can add
notifications designated to those operators.

The following table describes a typical process for configuring audit and
notification activities.

Stage Description

1 Configure database information and modem information for the Audit
Notification Server to be able to send e-mail and page notifications.

See Configuring Database Settings and Configuring Notifications Settings
for information about configuring Server settings.

2 Define operator information.

See The Operators Component for information about defining operators to
the system.

3 Set up notifications to defined operators.

See Notifications for information about setting up notifications.

4 Modify any system-generated audit messages, if needed.

See The Audit Log for information about modifying audit messages.

5 Define any new audit messages, if needed.

See The Audit Log for information about defining new audit messages.
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Stage Description

6 Organize the Audit Log display, if needed:

v Make your sort order and column order preferences.

v If needed, filter the display to show only selected entries.

v Specify that entries be listed in date/time order if you do not want the
default (Event ID) list order.

v Change the default page size if you want the system to display more or
less data (Audit Log entries) at one time.

See Filtering the Audit Log Display for information about customizing your
Audit Log display.
Note: These settings are not saved from session to session. The next time
you use the system, you must reset your preferences or use the default
settings.

System Components Used for Audits
The following system components provide access to the functions you use to
configure audit message and notification handling and to monitor system activity:
v Server settings
v Audit Messages
v Audit Log
v Operators
v Notifications
v Notification Log

Table 17. Audit components and functions

Component Function

Server settings Allows you to configure database and notification-related information,
including the following:

v The ODBC data source the system uses

v The ID and password the system uses to access the Sterling
Gentran:Server database system

v Dependencies used by the Audit Notification system (such as database
services or load order groups)

v The MAPI profile and communications port used to send notifications

This component also allows you to start and stop Audit Notifications
System activity.

Audit
Messages

Displays a list of all audit messages defined in the system. Allows you to:

v Modify limited audit message information for messages defined by
Sterling Gentran:Server (such as the Log to which the message is
written, which would be the Audit Log or the Windows Event Log).

v Add, change, and delete your own (user-defined) audit messages.

v Search for specific audit messages.
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Table 17. Audit components and functions (continued)

Component Function

Audit Log Performs the following actions:

v Displays a list of Audit Log entries written by system components.

v Identifies Audit Log entries that were generated from the same system
event (such as a specific Process Control event or user session) with the
same Event ID number, for easier identification.

Allows you to:

v Customize your visual display of Audit Log entries (columns, sort
order, page size).

v Use filtering criteria to specify characteristics limiting the messages to
be in the display.

v Search for specific entries.

v View detailed properties of Audit Log entries.

Operators Allows you to:

v Define or modify properties such as e-mail address and pager
information for the users who are to receive notifications.

v Add and delete notifications.

v Test the validity of e-mail or pager information entered for an operator.

Notifications Displays a list of all notifications defined in the system. Allows you to:

v Add, change, and delete notifications.

v View detailed properties for a notification.

Allows you to configure notifications:

v Based on a specific audit message or severity (such as warning
messages)

v Based on the specific functional source or component (such as the
translator) generating the message

v In the form of an alert, a page, an e-mail, or a Process Control event

v That are multiple response actions in any combination of notification
type (such as a page and an e-mail)

v That are sent to multiple operators

Notification
Log

Allows you to:

v View a list of notifications that have been generated to you.

v View a list of all notifications generated.

v View detailed properties of a Notification Log entry.

v Receive Notification Log alerts while logged on with the Notification
Log open.

v Delete all Notification Log entries that have been generated to you.

v Delete all Notification Log entries that have been generated.

System Configuration Dialog Box
The Sterling Gentran:Server System Configuration dialog box (with the
Audit/Notification tab selected) allows you to access the Audit Notification System
components you need to configure audit and notification activities.

The Audit Notification System components are:
v Audit Messages
v Notifications
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v Operators
v Server settings

Note: This dialog box also allows you to purge the contents of the Audit Log.

To access the System Configuration dialog box, from the Start menu select
Programs > Gentran Server > Gentran Server Configuration. When the system
displays the System Configuration dialog box, select the Audit/Notification tab.

The following table describes the parts of the System Configuration dialog box
(Audit/Notification tab):

Table 18. Audit/Notification tab parts and functions

Part Function

Messages Accesses the Audit Messages browser to view the list of audit
messages. From this dialog box you can access others to:

v Modify user-related audit message information for messages
defined by Sterling Gentran:Server.

v Add, change, and delete your own (user-defined) audit
messages.

v Search for a specific audit message.

Notifications Accesses the Notify dialog box to view the list of notifications
defined in the system. From this dialog box you can access others
to add, change, and delete notifications.

Operators Accesses the Operators browser to view the list of operators
defined in the system. From this dialog box you can access others
to:

v Add and delete operators.

v Change operator properties such as e-mail address and pager
number.

Server Accesses the Audit/Notification Server Properties dialog box to
configure database and notification server options (such as
communications port and MAPI profile), as well as setting service
dependencies. You can stop and start the Audit Notification Server
from this dialog box.

Purge Deletes the contents of the Audit Log.
Note: You can also purge the Audit Log by using the
GDW_Audit_Purge command in a Process Control session.

The Audit Notification Server
The Audit Notification Server performs several functions crucial to proper
operation of the Audit Notification System.

The Audit Notification Server performs the following actions:
v Generates Event IDs.
v Writes entries to the Audit Log.
v Writes entries to the Windows Event Log.
v Generates notifications.
v Writes entries to the Notification Log.
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You must specify several Audit Notification Server settings for Audit Notification
Server processing to run correctly.

Note: The Audit Notification Server runs as a separate Windows service.

Table 19. Audit Notification Server functions and descriptions

Function Description

Generate Event IDs Sterling Gentran:Server programs call on the Audit Notification
Server to provide a new Event ID when a new Process Control
session or interactive user session starts.

Write entries to the
Audit Log

Sterling Gentran:Server programs write messages to the Audit Log
and call the Audit Notification Server to write audit messages to
the Audit Log Database table.

Write entries to the
Windows Event Log

When the system writes audit messages configured to be written to
the Windows Event Log to the Audit Notification database table,
the Server writes these messages to the Windows Event Log on the
machine where the Audit Notification System is running.

Generate notifications v When the system writes an entry to the Audit Log, it determines
if the audit is configured for notification. If it is, the Server then
initiates the action that is defined for the Notification (such as
sending a page or e-mail, generating an alert, or initiating a
Process Control event.

v When a user has the Notification Log active, the Server informs
the Notification Log program that it has generated a new
notification to the active user. The Notification Log then
generates the alert message to the user.

Note: If the Server cannot execute the action defined for the
Notification, it writes an entry to the Windows Event Log and the
Audit Log.

Write entries to the
Notification Log

After executing e-mail, page, or alert notification actions, the Server
updates the Notification Log.

Audit Notification processing

The Audit Notification System starts automatically with Sterling Gentran:Server.
However, you can stop the system and restart it using Start System/Stop System
on the Sterling Gentran:Server Audit/Notification Server Properties dialog box.

Note: Other services may be dependent on the Audit Notification System. In this
case, if you select Stop System, the system displays a dialog box describing the
systems that will stop and asking if you want to continue.

Audit/Notification Server Properties Dialog Box
The Sterling Gentran:Server Audit/Notification Server Properties dialog box allows
you to configure database and notification-related information. You also can stop
and start the service on this dialog box.

Two tabs comprise the Sterling Gentran:Server Audit/Notification Server
Properties dialog box:
v Database
v Notifications
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To activate any changes to the Audit/Notification Server Properties dialog box,
you must restart the services.

Database tab

Table 20. Database tab parts and functions

Part Function

ODBC Data Source Specifies the ODBC data source the system should use to access
the Sterling Gentran:Server Audit Notification Database tables.

User ID Specifies the User ID (created by the database administrator) that
the Audit Notification system should use to log on to the database
system.

Password Specifies the password (created by the database administrator) that
the Audit Notification system should use to log on to the database
system.

Start Service/Stop
Service

Toggles (starts and stops) the Audit Notification System activity.
The Audit Notification System starts automatically with Sterling
Gentran:Server. If you stop the service, however, the System can be
restarted at that time using Start Service.

Dependencies Displays the Dependencies dialog box.

Service startup
sequence

Writes logging and tacking information to the Event Log when the
Audit Service starts. To disable this function, deselect the check
box.

Notifications tab

Table 21. Notifications tab parts and functions

Part Function

Use MAPI Indicates if you want to use MAPI to send e-mail and
alphanumeric pager notifications. Deselect this if you want to use
SMTP to send e-mail and alphanumeric pager notifications.

MAPI Profile Specifies the MAPI profile you want to use to send e-mail and
pager notifications.
Note: You must set up the MAPI profile for notifications using the
same Windows login and password as the Audit Notification
service (you must login to Windows using that ID and password
and create the MAPI profile). If you do not use the same ID and
password, the MAPI profile will not be available for use by Audit
Notification.

See the documentation that came with your MAPI messaging
software for information on setting up a MAPI profile.

Full Name Specifies your full name. Used for SMTP only.

E-mail address Specifies your e-mail address. Used for SMTP only.

SMTP Server/Port Specifies the name and port of the SMTP server that you can
access from the network including the Sterling Gentran:Server
primary server. Used for SMTP only.

My server requires
authentication

Indicates whether or not your SMTP server requires authentication
(login and password). If you select this, you must enter valid
values in the next two fields. Used for SMTP only.

Account Name Specifies your account name (login) on the SMTP server. Used for
SMTP only.

Password Specifies your password on the SMTP server. Used for SMTP only.
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Table 21. Notifications tab parts and functions (continued)

Part Function

Log File Specifies the location of the log file. Used for SMTP only.

Comm Port Identifies the communications port where your modem is installed.
This is used for sending numeric pager notifications.

Dependencies Dialog Box
The Dependencies dialog box allows you to indicate whether the Audit
Notification System depends on any other installed services (such as a database
service) or load order groups for operation.

Note: If the necessary dependencies are not selected, the system will not be able to
start unless dependent services are already started due to required access being
unavailable.

Table 22. Dependencies dialog box parts and functions

Part Function

If the
Audit/Notification
service depends on
any other installed
services

Specifies any installed services (such as a database service) on
which the Audit Notification system is dependent for operation.

Load Order Groups Specifies any load order groups that the Audit Notification system
is dependent upon for operation.

Note: The Executive Service also depends on the Audit Notification, Mailbox, and
Communications services (in that order).

Configuring Database Settings
You can configure Audit Notification Server settings on the Audit/Notification
Server Properties dialog box and the Dependencies dialog box.

About this task

You must have set up your MAPI profile before you can configure the Audit
Notification Server settings. See the documentation that came with your MAPI
messaging software for information about setting up a MAPI profile.

To configure database setting, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Select the Audit/Notification tab and click Server.
3. Select the Database tab.
4. From the ODBC Data Source list, select the appropriate data source.
5. In the User ID box, type the User ID that Audit Notification should use to log

on to the database system.
6. In the Password box, type the password that the Audit Notification system

should use to log on to the database system.
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7. Click Dependencies.
8. From the installed service list, select any services that the Audit Notification

system depends on.
The Audit Notification System uses the database so any database services
must be started before the audit service or the audit service cannot start.

9. From the Load Order Groups list, select any load order groups that the Audit
Notification system uses.

10. Click OK.
The system saves the dependencies information and redisplays the
Audit/Notification Server Properties dialog box.

Configuring Notifications Settings
About this task

To configure notifications setting, complete the following steps.

Procedure
1. From the Audit/Notification Server Properties dialog box, select the

Notifications tab.
2. If you want to send notifications via e-mail, in the MAPI Profile box, select the

name of the profile you want the Audit Notification system to use for sending
e-mail and alphanumeric pager notifications.

3. If you want to send notifications via an alphanumeric pager, in the Comm Port
box, type the name of communications port where your modem (for numeric
pager notifications) is installed.

4. Click OK.
The system saves the Notifications tab settings and prompts you to restart the
system.

5. Click Start Service/Stop Service to restart the Audit Notification system to
make the settings take effect.

About Audit Messages
Audit messages summarize processing and user activity information, such as:
v Steps occurring in a Process Control event
v A user editing a document
v A user creating a mailbox
v Processing error information (such as translation errors or recipients not found)
v Communications errors
v System errors such as database errors and network errors

The Audit Messages Component
The Audit Notification System Audit Messages component allows you to add and
modify messages and message descriptions. When system components write
messages to the Audit Log, the information displayed is tailored to your needs.
This makes it easier to monitor system activity and to set up responses such as
error notifications to specified messages.

If you are not interested in viewing certain information-level messages, you can
specify that they not be written to the Audit Log.
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The Audit Messages component allows you to:
v View a list of all audit messages defined in the system.
v Modify limited audit message properties for messages defined by Sterling

Gentran:Server.
v Add, modify, and delete your own audit messages.
v Search for a specific audit message.
v Refresh the list of audit messages to view changes made by other users.

You can refresh the audit messages list to see any changes made by other users, by
selecting View > Refresh or pressing F5.

You can delete audit messages on the Sterling Gentran:Server Audit Messages
browser by selecting the message you want to delete and pressing Delete.

Note: You cannot delete system-defined audit messages.

Table 23. Audit message components

Component Description

Source Indicates the system or functional system area (such as Sterling
Gentran:Server, Archive, user system) generating the audit
message.

Source ID The numeric identifier representing the source.

Component Indicates the part of the specified source generating the audit
message (such as the Process Control program).

Component ID The numeric identifier representing the component.

Message ID A number ranging from 1 to 65535 that indicates a specific error
for a component.
Note:

Values 1 – 49,999 are used for audit messages unique to a specific
source and component.

Values 50,000 – 65,535 are used for audit messages that can be
generated by more than one component within the same source
(common audit messages).

Audit Number The identifying number indicating the source ID, component ID
and message ID of the audit message.

Example

1-1-1010

In this example, Sterling Gentran:Server is the source (1), the
component is EDIMGR (1) and the message ID indicates the
message "Sterling Gentran:Server client started" (1010).
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Table 23. Audit message components (continued)

Component Description

Severity Level Indicates the magnitude of the error. In the Audit Log, this value is
represented by an icon. Valid values:

v Information

v Warning

v Error

v Audit success

v Audit failure

Note: Audit Success and Audit Failure are security severities,
intended to indicate if successful access was made or access to a
resource failed, like the Windows Event Log severities.

Type Specifies the type of audit message (such as processing or
data-related types such as document or interchange).

Message Text The descriptive text of the audit message, for example: Sterling
Gentran:Server client started.
Note: The % symbol used within audit message text allows you to
insert variables into messages that you define. Where the %
variable is used in system-defined audit messages, the value (or
definition) of the variable is determined at run-time, according to
system activity.

For example, ANServer startup error %1 in function %2. In this
example, %1 explains the specific error, and %2 is the function of
the program where the startup error took place (such as logging on
to the database or reading a value from the registry).

Audit Log This option is selected on the appropriate dialog box to indicate
that the message should be written to the Audit Log, Data Audit
view, or Tracking Information view, based on the Audit Message
Type.

Event Log This option is selected on the appropriate dialog box to indicate
that the message should be written to the Windows Event Log of
the machine running the Audit Notification Server.

Source and Component Numeric Values
The following table lists the numeric values for the message sources and
component values:

Table 24. Audit message sources and values

Source Values

0 - ALL 0 - ALL (the message may be generated by all components within
the source)
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Table 24. Audit message sources and values (continued)

Source Values

1 - Server 0 - ALL (common)

1- EDIMGR

2 - RPCSRV (Executive Service)

3 - Unattended

4- partner_editor

5 - Configuration

6- Commpost

7 - Process Control

2 - Mailbox 0 - ALL (common)

1 - Server

2 - Trace

3 - Exe_agent

4 - File_system_adapter

5 - MAPI_adapter

6 - Mailbox_client

3 - Translator 0 - ALL (common)

1 - Translator

5 - Audit 0 - ALL (common)

1 - Audit Notification Server

2 - Audit Context

3 - Notifications

4 - Audit Message User Interface

5 - Operators

6 - Server Settings

6 - Comm 0 - ALL (common)

1 - GenCom97

2 - GenComPC

3 - GenCom UI

4 - ComStart

7 - Archive 0 - ALL (common)

1 - Archive Engine

2 - Archive Manager
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Table 24. Audit message sources and values (continued)

Source Values

99 - User 0 - ALL (common)

99 - User

Audit Message Types
The system issues processing-related and data-related audit messages.
Process-related audit messages describe user actions and processing information
and errors, such as steps occurring in a Process Control event or communications
errors. Data audit messages are related to a specific document, interchange,
message, or attachment in the system and provide information such as messages
created, transferred, or delivered.

Note: Processing messages can be viewed in the Audit Log. Data audit messages
can be viewed via the Tracking Information and Data Audit views.

The system assigns a Type value to all audit messages, which specifies the nature
of the activity that initiated the audit message. The data audit message types are:
v document
v interchange
v external data
v session
v message
v attachment

The following table describes examples of processing and data audit messages:

Table 25. Audit message examples by type

Audit Message Type Example

Processing When a user logs on to Sterling Gentran:Server and starts the
Sterling Gentran:Server client, the program writes the following
audit message to the Audit Log:

1-1-1010 Gentran:Server client started

Processing When Process Control starts the Unattended program and it starts
processing a session file, Unattended writes the following message
to the Audit Log:

1530 Process Control - Started Session

Data When the Sterling Gentran:Server Executive Service performs
overdue checking logic and finds that an interchange sent has not
been acknowledged by the trading partner, the service writes the
following data audit message:

1-2-3000 Acknowledgement status changed to Overdue

Common Audit Messages
Common audit messages are audit messages that may be written by more than one
component within the same source (the same message cannot be issued by
different sources). For example, within Sterling Gentran:Server, the Unattended
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program may issue an audit message indicating that it encountered a database
open error. Similarly, the RPCSRV program may issue the same audit message that
it encountered the same error.

Common audit messages are defined in the system with the component value of
ALL (and the corresponding numeric component ID value of 0). However, when a
common audit message is written to the Audit Log, the component issuing the
audit message is identified as such. For example, if the Unattended program and
the RPCSRV program both write message 51000 to the Audit Log, the Audit Log
entries display the source for each as Server, the component as Unattended and
RPCSRV respectively, and the message ID for each as 51000. Yet on the audit
message table (where you can review, add, and modify message information), the
message is defined as Server-ALL-1-0-51000.

Audit Messages Browser
The Sterling Gentran:Server Audit Messages browser allows you to view audit
messages and delete user-defined audit messages from the system. This browser is
also the entry point to add and modify audit messages.

Table 26. Audit Messages browser parts and functions

Part Function

Audit Number Indicates the source ID, component ID, and message ID of the
audit message. The source and the component are numerically
represented to make identifying messages from different system
areas easier.

Source Indicates the system generating the message (such as Sterling
Gentran:Server, Mailbox, or user system).

Component Indicates the part of the specified source generating the audit
message (such as the Sterling Gentran:Server Unattended
program).

Message ID A number between 1 and 65535 that indicates a specific error for a
component.

Severity Indicates the magnitude of the error or the status of the event.
Severity levels include:

v Information

v Warning

v Error

v Audit Success

v Audit Failure

Message Text The descriptive text of the audit message.

Find Dialog Box
The Find dialog box allows you to enter search criteria, such as message text and
message ID, to locate a specific audit message.

Table 27. Find dialog box parts and functions

Part Function

Find Criteria Select the criteria to use to search for the message.
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Table 27. Find dialog box parts and functions (continued)

Part Function

Search for Specify the specific property value of the criteria to search for.

Examples

Find Criteria: Message Text

Search for: Translation error

Find Next Searches for the next audit message in the list that matches the
selected criteria.

Cancel Ends the search and exits the Find dialog box.

Direction Up

Direction Down

Search up or down the list (relative to the current location in the
list) for audit messages that match the selected criteria.

Audit Message Definition Dialog Box
The Audit Notification system allows you to create an audit message when you
need a message to record a system activity for which Sterling Gentran:Server does
not have a system-defined audit message.

Note: Audit messages you create are referred to as user-defined audit messages.

You also use the Audit Message definition dialog box to modify the properties of
an existing audit message. These options enable you to customize the messages
that the system generates.

The following table describes the parts of the Audit Message Definition dialog box.
Except as noted within the table, the values in these fields cannot be changed for
system-defined messages.

Table 28. Audit Message Definition dialog box parts and functions

Part Function

Audit Number The identifying number indicating the source ID, component ID
and message ID of the audit message.

Source Indicates the default source (User) to be applied to the new
message, or the system source of the message (such as Sterling
Gentran:Server, Mailbox).

Component Indicates the part of the system (within the specified source)
generating the audit message (such as the Sterling Gentran:Server
Unattended program).

Message ID Indicates the message ID number. For new messages, this value
defaults to the highest message ID not currently used. You may
enter another value.

User/System Message Indicates whether the message is user-defined or system-defined.

Write to Audit Log Indicates whether the message will be written to the Audit Log.

Write to Event Log Indicates whether the message will be written to the Windows
Event Log. For some system-defined audit messages, you can select
or deselect this option.
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Table 28. Audit Message Definition dialog box parts and functions (continued)

Part Function

Severity Indicates the severity level of the audit message. Severity levels
are:

v Information

v Warning

v Error

v Audit Success

v Audit Failure

Audit Msg Type Indicates the type of audit message. Valid values are:

v Processing

v Document

v Interchange

v External data

v Session

v Message

v Attachment

Message Text Contains the descriptive text of the message.

Additional (User) Text Contains any additional descriptive message text. You may add
message text to this field for system-defined messages.

Adding an Audit Message
You can add an audit message by defining the message properties on the Audit
Message Definition dialog box.

About this task

Use this procedure when you need an audit message to record a system activity
for which Sterling Gentran:Server does not have a system-defined audit message.
After you add the audit message, you must use either Process Control or extended
rules to configure the message to be written to the Audit Log.

To add an audit message, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Select the Audit/Notification tab and click Messages.
3. Select File > New Audit Message.
4. Change the message ID if you do not want the default value (the default

value is highest message ID not used).
5. Select a severity level from the Severity list.
6. Select a message type from the Type list.
7. Select Audit Log if you want the message to be written to the Audit Log.
8. Select Event Log if you want the message to be written to the Windows Event

Log.
9. Type the descriptive text of the message in the Message Text field.

10. Click OK.
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The system adds the new message to the list, exits the dialog box, and
displays the Sterling Gentran:Server Audit Messages browser.

Modifying Audit Message Properties
You can modify audit message properties using the Audit Message Definition
dialog box.

About this task

Use this procedure when you need to do any of the following:
v Direct the Audit Notification system to write system-defined audit messages to

the Audit Log or the Windows Event Log.
v Add descriptive message text to a system-defined message.
v Modify the properties of a user-defined audit message.

To edit the properties of an audit message, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Select the Audit/Notification tab and click Messages.
3. Double-click the message you want to modify.

The system displays the Audit Message Definition dialog box with the
properties of the message you selected.

4. Change the values in the dialog box fields as needed.

Notes: The Audit Notification system restricts you from changing certain
properties depending on the type of audit message you are editing.
v For system-defined, information-level messages, you can:
v Change the Audit Log and Event Log options to indicate the logs to which

the audit message should be written.
v Add or change text in the Additional Messages box.
v For system-defined, non-information-level messages, you can modify only

the Additional Messages box.
v For user-defined audit messages, you can modify all fields except the Audit

Number field and the Source and Component fields, which default to User.
5. Click OK.

The system applies the changes to the audit message, exits the dialog box, and
displays the Sterling Gentran:Server Audit Messages browser.

Searching for a Specific Audit Message
You can initiate a search for a specific audit message on the Sterling Gentran:Server
Audit Messages browser by specifying distinguishing properties on the Find dialog
box.

About this task

Use this procedure when you need to locate a message to review or change its
properties.

To search for a specific Audit Message, complete the following steps.
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Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Select the Audit/Notification tab and click Messages.
3. From the File menu, select Find.
4. In the Find Criteria list, select the type of search criteria you are using. For

example, message text or message ID.
5. In the Search for box, type the specific property on which you are basing the

search. For example, if your Find Criteria is Message Text, you might type
Acknowledgement status changed in the Search for box.

6. Indicate whether you want the system to search Up or Down the list from your
present location.

7. Click Find Next.

Note: If the system does not find a message matching the criteria you entered,
it displays an information message.

8. Double-click the highlighted message to review or change its properties.
The system displays the Audit Message Definition dialog box for the selected
message.

The Operators Component
An operator is a user defined in the system to receive notifications when specified
audit messages are generated by system components.

You must define operator information such as name, e-mail address, and pager
number, so when you configure notification recipients, the system has an operator
definition for the recipient you specify.

The Operators component of the Audit Notification system allows you to:
v View a list of all operators defined in the system.
v View and modify operator properties.
v Add new operators to the list.
v Delete operators.
v Send test notifications to defined operators.
v Refresh the list of operators to view changes made by other users.

Test Function

The Operators component allows you to test the validity of the operator
information you enter on the properties dialog boxes by using a test function to
send trial notifications to the operator. The test notifications can be in the form of
Notification Log alerts, e-mails, or pages.

The method of confirming the success or failure of a notification test depends on
the type of notification action being tested and the success or failure of the test.
v For alerts, the designated operator must have logged on with a valid Windows

User ID and have the Sterling Gentran:Server Notification Log dialog box open.
v For pages and e-mail notifications, the operator must confirm that the specified

operator received the test notification by checking the designated e-mail account
or pager.
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v When the system encounters an error generating e-mail or pager test
notifications, the system generates error messages indicating the nature of the
problem.

Refresh Function

The Operators component allows you to refresh the Sterling Gentran:Server
Operators browser to view any changes made by other users. You can select View
> Refresh or press F5.

Deleting Operators

When you no longer need to maintain an entry for an operator, you can delete the
operator from the Operators list on the Sterling Gentran:Server Operators browser
by selecting the entry you want to delete and pressing Delete.

Note: When you delete an operator, the system deletes any notifications
configured with that operator as a recipient.

Operators Browser
The Sterling Gentran:Server Operators browser displays the list of operators
defined in the system and enables you to delete operators from the list.

Table 29. Operators browser parts and functions

Part Function

User ID Displays the Windows identifier of the operator.

Operator Name Displays the operator name.

E-mail Address Displays the operator e-mail address.

Pager info Specifies either the operator numeric pager number (such as 9,
111-1111) or the e-mail address of an alphanumeric pager.

Operator Properties Dialog Box
To specify that a selected notification be sent to a specific user (operator), you must
add operator information defining the user to the system. Sterling Gentran:Server
uses the operator properties to send the notification to the specified operator.

The Operator Properties dialog box allows you to add an operator to the system to
receive notifications and to view and modify properties for existing operators. If
operator information changes (such as e-mail address), you must use this dialog
box to update the operator information that defines that user to the system.

The following table describes the parts of the Operator Properties dialog box:

Table 30. Operator Properties dialog box parts and functions

Part Function

NT User ID Specify the Microsoft Windows User ID of the operator.
Note: If your database is case sensitive, the User ID value in this
field must use the exact case as the Microsoft Windows User ID.
Otherwise, operators will not be able to view all notifications
generated to them.

Name Specify the operator name.
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Table 30. Operator Properties dialog box parts and functions (continued)

Part Function

Alert Test Sends a test Notification Log alert message to the specified
operator.
Note: The specified operator must have logged on with a valid
Windows User ID and have the Notification Log dialog box open
to receive the test alert notification.

E-mail Address Specify the operator e-mail address.

E-mail Test Sends a test e-mail notification to the specified operator. This test
will work with both SMTP and MAPI.

Numeric Pager
(Phone Number)

Specify the telephone pager number at which the operator will
receive notifications. This number must include as many commas
as necessary to handle the phone pauses between dialing out to the
pager service, pausing until the pager service is ready to receive
the numeric number, for example: 9,555-5555,,,,

The four commas after the number allow for the paging service
voice message that plays until it is ready to receive the message.

Alpha Numeric Pager
(E-mail Address)

Specifies the e-mail address at which the operator will receive
alphanumeric pager notifications.

Pager Test Sends a test pager notification to the specified operator. For
alphanumeric pagers, this test will work with both SMTP and
MAPI.

Adding an Operator
Use this procedure when you need to set up a user to receive notifications.

About this task

To add an operator, you specify identifying properties on the Operator Properties
dialog box.

To add an Operator to the system, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Select the Audit/Notification tab and click Operators.
3. Select File > New Operator.
4. Type the necessary information in the appropriate fields:

v NT User ID

Note: If your database is case sensitive, be sure to enter the User ID in the
same case as for the Windows User ID. Otherwise, operators will not be able
to view all notifications generated to them.

v Name
v E-mail Address
v Numeric Pager (Phone Number)
v Alpha Numeric Pager (E-mail Address)

5. Click the appropriate Test button for any notification you want to test.
The system sends a test notification to the new operator.
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6. Click OK.
The system adds the operator to the list and closes the dialog box.

Modifying Operator Properties
When operator information (such as the e-mail address or pager number) changes,
you must modify operator properties. The Operator Properties dialog box allows
you to modify the properties of an existing operator.

About this task

To modify Operator properties, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Select the Audit/Notification tab and click Operators.
3. Double-click the operator entry you want to modify.
4. Modify the information in the following fields as needed:

v NT User ID
v Name
v E-mail Address
v Numeric Pager (Phone Number)
v Alpha Numeric Pager (E-mail Address)

5. Click the appropriate Test button for any notification you want to test.
The system sends a test notification to the operator.

6. Click OK.
The system saves the changes and exits the dialog box.

Notifications
A notification is the user-configured action (such as a page, e-mail, or Notification
Type Process Control event) that Sterling Gentran:Server initiates when a system
component generates a specified audit message. Notifications can simply inform a
user of an audit message generation, or they can take the form of a system
response (Notification Type Process Control event) to the audit message.

The Notifications component allows you to:
v Add notifications.
v Modify existing notification properties.
v View a list of all notifications defined in the system.
v Delete notifications.
v Refresh the list of notifications to view changes made by other users.
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Notification actions

Table 31. Notification actions and descriptions

Notification Action Description

Notification Log alert
messages

A message box generated to inform operators while they are
working in the system that a notification has been issued to them.

Operators must be logged on and have the Notification Log active
to receive Notification Log alert messages.
Note: Alert messages are activated by default on the Audit
Notifications Log Preferences menu, along with an audible signal.
Operators can deselect these options.

page A notification delivered to a pager to inform an operator of a
condition that may require attention.

e-mail An e-mail sent to inform an operator of a condition that may
require attention.

Notification Type
Process Control event

An activity or series of activities previously configured to be
initiated in response to the generation of a specified audit message.
For example, based on an extended rule set up in the map to write
a processing audit whenever an invoice for more than a specified
dollar amount is received, a Notification Type Process Control
event might be configured to initiate a user program to process the
data.
Note: Notification Type Process Control event actions are not
written to the Notification Log.

Flexible configuration options

The Notifications component allows you to set up a variety of notification
configurations according to your requirements. However, you can only set up one
notification for a specific audit message. If you try to set up additional notifications
for the same message, the system displays an error message.

Using the Notifications component, you can:
v Notify multiple operators. Multiple operators can be notified for in either of the

following cases:
– In response to the same audit message
– Using multiple types of notifications (such as page, e-mail, Notification Log

alert) in response to the same audit message
v Set up notifications based on different audit message criteria. Notifications can

be sent in response to any of the following:
– A specific audit message
– All audit messages of a designated level (such as warning messages)
– All audit messages generated by a designated system component (such as the

CONFIG program)
v Set up different types of notifications. You can configure a notification in the

form of a Notification Log alert, a page, an e-mail, or a Notification Type Process
Control event.

Note: Even if an audit message is configured not to be written to the Audit Log,
you can set up notification responses to be initiated when the system issues the
message.
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Configuration example

When you are setting up notifications, you can select either a specific audit
message or a group of audit messages defined by any of the following:
v Source
v Component
v Message ID
v Severity level

For example: You can designate that a notification be sent for all messages with a
source of Server, a component of Translator, <ALL> message IDs that apply, and a
severity level of Error level audit. This generates a notification when the Translator
generates any audit message indicating an Error level audit.

Notification processing order

The Audit Notification Server executes the actions for all notifications. For each
notification, the actions are processed one action at a time. Thus, one notification
requiring a page will not process until after the previous notification sending a
page completes.

If a notification requires a page action and if another process (external to the Audit
Notification System) is using the modem, the server waits 45 seconds and tries
again. After three tries, if the modem is still busy, the Server writes an entry to the
Windows Event Log and goes on to process the next notification on the queue.

Deleting notifications

You can delete a notification from the notifications list on the Sterling
Gentran:Server Notify dialog box. To delete a notification, select the notification to
delete, and press Delete.

Refresh function

The Notifications component allows you to refresh the Sterling Gentran:Server
Notifications browser to view changes made by other users. You can select Refresh
from the View menu or press F5.

Notifications Browser
The Sterling Gentran:Server Notifications browser allows you to view and delete
notifications.

Table 32. Notify dialog box parts and functions

Part Function

Name Indicates the name of the notification.

Enabled Indicates that the notification will be sent when the specified audit
message is processed to the Audit Log.
Note: When this option is not selected, the system will not
generate the notification.

Source Indicates the system or functional system area (such as Sterling
Gentran:Server, Archive, or user system) generating the audit
message that will initiate the notification.
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Table 32. Notify dialog box parts and functions (continued)

Part Function

Component Indicates the part of the specified source generating the audit
message (such as the Sterling Gentran:Server Unattended program)
generating the audit message that will initiate the notification.

Message ID The identifying number between 1 and 65,535 of the audit message
that will initiate the notification.

Audit Number The identifying number indicating the source ID, component ID
and message ID of the audit message that will initiate the
notification.

Severity Indicates the magnitude of the error or status of the event that will
initiate the notification. Severity levels are:

v Information

v Warning

v Error

v Audit Success

v Audit Failure

Notification Properties Dialog Box
The Notification Properties dialog box allows you to add a notification and change
identifying properties for a notification. On this dialog box, you specify properties
such as the name of the notification, the type of audit message to which it
responds, and the person receiving it. The following tabs comprise the Notification
Properties - Edit dialog box:
v General
v Response
v Advanced

Notification Properties dialog box - General tab

Table 33. General tab parts and functions

Part Function

Name Indicates the name of the notification.

Enabled Activates the notification to be sent if/when the specified audit
message is processed to the Audit Log.

specific message Indicates that the notification is a response to a specific audit
message being processed to the Audit Log.

group of messages Indicates that the notification is a response to any of a group of
audit messages being processed to the Audit Log.

Source Indicates the system or functional system area (such as Sterling
Gentran:Server, Archive, or user system) generating the audit
message that will initiate the notification.

Component Indicates the part of the specified source generating the audit
message (such as the Translator) that will generate the audit
message that will initiate the notification.

Message ID The identifying number between 1 and 65,535 of the audit message
that will initiate the notification.

... Shows a list of audit messages defined in the system.
Note: If source and/or component values are entered, the list is
filtered to display messages for the source and component.
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Table 33. General tab parts and functions (continued)

Part Function

Severity Indicates the magnitude of the error or status of the event that will
initiate the notification. Severity levels are:

v Information

v Warning

v Error

v Audit Success

v Audit Failure

Notification Properties dialog box - Response tab

Table 34. Response tab parts and functions

Part Function

Task to execute Indicates the Notification Type Process Control event that the
notification will initiate. This box displays any Notification Type
Process Control events previously defined to Sterling
Gentran:Server.

User ID/Name Indicates the IDs and names of operators to notify.

Alert Indicates that the notification action generates an alert to the
operator.

E-mail Indicates that the notification action generates an e-mail to the
operator. You cannot enter a value in this field if there is no e-mail
address defined for the operator.

Pager Indicates that the notification action generates a page to the
operator. You cannot enter a value in this field if there is no pager
address defined for the operator.

Notification Properties dialog box - Advanced tab

The Advanced tab allows you to configure the pager and e-mail responses sent to
Operators. For numeric pagers, you can select to either have the error number sent
to the pager (this is the default option) or you can add numeric text to the
message.

For alpha pagers and e-mail Notification responses (note that alpha pagers may
have a limited text size), the system sends a pre-formatted message by default. For
example, Sterling Gentran:Server Notification (Notification Name). You can
optionally choose to add error message text (for example Message 01-01-01
Partner not found) and/or you can add your own text in the Additional
Notification Message to send to operator box.

For regular Alert responses, the system uses any text supplied in the "Additional
Notification Message to send to operator" box to include in the Notification
Message Text that is supplied in the Notification Log.

The following table describes the parts of the Notification Properties - Edit dialog
box (with the Advanced tab active):
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Table 35. Advanced tab parts and functions

Part Function

Include error message
text

Specifies that all of the following is to be included in the
notification information sent to the operator:

v Descriptive text of the error message initiating the notification

v Date and time of the error

v Event ID of the event

Additional
notification message
text to send to
operator

Specifies any additional text to be sent to the operator receiving the
notification.
Note: For alpha pagers and e-mail Notification responses (note
that alpha pagers may have a limited text size), the system sends a
pre-formatted message by default.

Page using message
number

Specifies that the audit message number precipitating the page is
included in the notification text sent as part of the numeric page.

Page using numeric
Message

Specifies that any numeric text entered is included as the
notification text that is sent as part of the numeric page.

Adding Notifications
Adding a notification is the process by which you direct Sterling Gentran:Server to
inform a defined operator of certain system activity, as indicated when the system
generates a specified audit message.

Before you begin

Depending on the type of notification action you are configuring, you must meet
the following requirements:
v If you are setting up notifications in the form of a page, you must have selected

the appropriate communications port in the Audit Notifications Server Settings.
v If you are setting up notifications in the form of e-mail messages, you must have

set up your MAPI profile and selected that profile in the Audit Notifications
Server Settings.
– See the documentation that came with your MAPI messaging software for

information about setting up a MAPI profile.
– See The Audit Notification Server for information about specifying the

communications port and MAPI profile.
v Before you can set up a notification, you must have defined operator properties

for the operator you want to receive the notification. See Adding an Operator for
information about defining operator properties.

About this task

When you set up notifications, you specify the following:
v The audit message or type of audit message that initiates the notification
v The operators to receive the notification
v The type of notification action (such as e-mail, page, or Notification Type Process

Control event)

You add a notification by defining the notification properties on the New
Notification Properties dialog box. When you complete the configuration of the
notification, the system adds the new notification to the Sterling Gentran:Server
Notifications list.
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To add a notification, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Select the Audit/Notification tab and click Notifications.
3. Select File > New Notification.
4. Select the General tab and complete the following fields:

v In the Name box, type the name of the notification.
v If you do not want the notification to be active for processing at this time,

clear the Enabled checkbox. (The default setting is Enabled.)
v If the notification is based on a specific message, select specific message.
v If the notification is based on a group of messages, select group of messages.
v From the Source list, select the source of the messages initiating the

notification.
v From the Component list, select the component of the messages initiating the

notification

Note: If you select Common as the component value, the notification will be
generated whenever any component within the selected source generates the
audit message.

v If the notification is based on a specific message, type the message ID in the
Message ID box.

Note: Rather than selecting the message ID, you can click Browse. The
system displays the list of defined audit messages for the source and
component entered. To select the message you want, double-click the
message.

v If the notification is based on a group of audit messages with a specific
severity level, select or enter the appropriate level.

5. Select the Response tab and complete the fields:
v If you are configuring a notification in the form of a predefined Notification

Type Process Control event, select the appropriate event from the Task to
execute list.

v From the Operators to notify table in the Alert, E-mail, and Pager fields,
select the actions you want the notification to initiate.

6. Select the Advanced tab and complete the following fields:
v If you want an e-mail or alphanumeric page notification to include the text

of the error message that initiated it, the date and time of the error, and the
Event ID, select Include error message text.

v If you want the notification to deliver any additional message to the
operator, type the text in the Additional notification message to send to
operator box.

v If you want numeric pager notifications to page the operator using the
message number, select Page using message number.

v If you want the numeric pager notification to page the operator using a
numeric message, select Page using numeric Message and type the numeric
message in the box.

7. Click OK.
The system adds the notification to the list and exits the dialog box.
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Modifying Notification Properties
You can modify the properties on the Notification Properties dialog box.

About this task

You change the properties of an existing notification when you want to alter some
aspect of the notification activity or the recipient.

To modify notification properties, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server

Configuration.
2. Select the Audit/Notification tab and click Notifications.
3. Select the notification to edit and select View > Properties.
4. Select the General tab and change the values in the following fields if needed:

v Enabled
v Specific message
v Group of messages
v Source
v Component
v Message ID

Note: You may not change the name of an existing notification.
5. Select the Response tab and change the values in the following fields if needed:

v Task to execute
v Operator Name
v Alert
v E-mail
v Pager

6. Select the Advanced tab and change the values in the following fields if
needed:
v Include error message text
v Additional notification message to send to operator
v Page using numeric Message, and the box that follows

7. Click OK.
The system saves the changes to the notification, updates the Sterling
Gentran:Server Notifications browser, and exits the dialog box.

The Audit Log
Sterling Gentran:Server system components such as the Translator and Process
Control write audit messages to the Audit Log to indicate user actions and system
processing. The Audit Log displays these Audit Log entries in list format, enabling
you to monitor system activities.

The Audit Log component allows you to:
v View a list of audit messages written to the Audit Log.
v View detailed information about specified Log entries.
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v Page to scan groups of audit messages.
v Search for specific Audit Log entries.
v Customize the Audit Log display by changing:

– column sizes
– view preferences
– sort order

v Filter the Audit Log list to display specific messages only.
v Refresh the Audit Log list to view new entries.

Page setting

The Sterling Gentran:Server Audit Log displays a fixed number of entries at one
time. The number of entries displayed at one time defines the page size of the
display (the default number of entries displayed on one page is 1000).

You can scroll within a page to view entries as needed, using the arrow keys or
Page Up and Page Down. You page up or down to view the next page (group of
entries) by pressing Ctrl + Page Up or Ctrl + Page Down. For example, if the
Audit Notification system has 10,000 Audit Log entries in it (the system allows an
unlimited number) and if the page size for the Audit Log dialog box is set to 5,000,
the system displays the most current 5,000 entries, with the most current first (in
this case, entries 10,000 to 5,000). You can scroll down to view entry 5,000. You can
page to view entries 5,000 to 1 by pressing Ctrl + Page Down.

You can change the number of entries displayed (therefore, the page size). This
allows you to break the Audit Log list into manageable chunks so you can scroll
easily through the entries you need to scan. Limiting the number of entries per
page also can decrease the time it takes the system to display the Audit Log.

Change the page size by selecting Preferences from the Audit Log Options menu.
The system displays the Audit Log Page Size Configuration dialog box. You can
change the value in the box.

Note: If you have been paging through Audit Log entries and then refresh the
dialog box, the system re-displays the most current data, starting at the first page.

Sort order

To change the order in which Audit Log entries are listed, you can click on a
column on the Sterling Gentran:Server Audit Log browser. When you click the
column, the system sorts the entries according to the criteria contained in that
column (such as Event Name and Audit Number).

Within the chosen category, entries are listed alphabetically, and secondarily in
date/time order from newest to oldest. For example, if you click on the Event
Name column to sort entries, the system lists the entries, beginning with all event
names that start with A, then those that start with B, and so on. If the first entries
starting with A are event name Administrator, all entries for Administrator are
listed in date/time format with newest first.

You can use the change sort order function in only one column at a time. For
example, if you click on the User column and then click on the Date column, the
system sorts the entries by Date, not by Date within User.
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View options

You can direct the system to list entries on the Sterling Gentran:Server Audit Log
browser in Date/time view or Event view. In Event view, Audit Log entries are
grouped together by Event ID. (Within the Event ID groups, the system lists events
in date/time order, with most current first.) In Date/time view, the system lists all
Audit Log entries in date/time order, with the most current audit entry being first
on the list.

Note: Event view is the default setting if you are viewing the Audit Log for the
first time after a new installation of Sterling Gentran:Server. Both views display the
severity of the message, the date, time, event name, Event ID, audit number, and
message text of the Audit Log entries.

Access these options from the View menu by selecting Current View.

Accessing the Audit Log

You can access the Audit Log in the following ways:
v Select Audit Log from the Main Toolbar on the Mailbox Server Manager dialog

box.
v Select Audit Log from the Main Toolbar on the Sterling Gentran:Server EDI

Manager window.
The Audit Log icon depicts a red exclamation point within a yellow circle and a
white piece of paper.

v Select Audit Log from the View menu on the Sterling Gentran:Server EDI
Manager window.

Refresh function

The Audit Log component allows you to refresh the Sterling Gentran:Server Audit
Log browser to view any new entries made since you opened it. You can select
Refresh from the View menu or press F5.

Deleting Audit Log entries

You can delete Audit Log entries on the Sterling Gentran:Server Audit Log browser
by selecting the entry you want to delete and pressing Delete.

Purging the Audit Log

You can purge the contents of the Audit Log using either of the following
methods:
v On the Sterling Gentran:Server System Configuration dialog box, select the

Audit Notification tab and click Purge. When you click Purge, the system
displays a confirmation message asking if you want to delete all entries from the
Audit Log. When the system completes the purge, it displays another
information message to say that the purge was successful.

v In a Process Control session, set up the GDW_Audit_Purge command.

Note: The purged Audit Log entries are removed from the Sterling
Gentran:Server Database and appended to the text file (the file name and path
that you specified when you set the parameters for the GDW_Audit_Purge
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command). To ensure that the text file does not grow unchecked, you may want
to use a File_Delete command prior to the GDW_Audit_Purge command in your
session script.

Audit Log Browser
The Sterling Gentran:Server Audit Log browser allows you to view and sort Audit
Log entries.

Table 36. Audit Log browser parts and functions

Part Function

Severity Icons indicate the magnitude of the error or the status of the event. The
following are the severity levels and icons:

Information

Warning

Error

Audit Success

Audit Failure

Date/Time Indicates the date (MM/DD/YY) and time (HH:MM:SS) the audit message
was processed to the Audit Log.

Event Name The descriptive name of the Notification Type Process Control event, user,
or other entity by which activity is initiating the generation of audit
messages. For example, in the message Gentran:Archive Manager started,
the Event Name is Archive.

Event ID A unique number applied by the Audit Notification System to all system
events (and Audit Log entries). Audit Log entries generated from the same
Process Control event, user session, or system-generated event are assigned
the same Event ID number. Entries with the same Event ID are grouped
together within the Audit Log display by default.

Audit
Number

The identifying number indicating the source ID, component ID, and
message ID of the audit message.

Message Displays the descriptive text of the audit message.

User Indicates the Windows User ID of the user initiating the process (or the
Windows User ID of the service running the process as a Process Control
event).

Note: You can resize the columns on this dialog box to view more text within a given
field.

Audit Log Entry Detail Dialog Box
The Audit Log Entry Detail dialog box allows you to view detailed information for
a selected Audit Log entry. You can view details for consecutive entries without
exiting this dialog box by scrolling through the entries using Previous and Next.

Table 37. Audit Log Entry Detail dialog box parts and functions

Part Function

Date/Time Indicates the date (MM/DD/YY) and time (HH:MM:SS) the audit
message was processed to the Audit Log.

Source Indicates the system or functional system area (such as Sterling
Gentran:Server, Archive, or user system) generating the audit message.
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Table 37. Audit Log Entry Detail dialog box parts and functions (continued)

Part Function

User Indicates the Windows User ID of the user initiating the process (or the
Windows User ID of the service running the process as a Process Control
event).

Component Indicates the part of the specified source generating the audit message
(such as the Sterling Gentran:Server Unattended program).

Computer Indicates the name of the machine on which the process was running.

Message ID Indicates the number of the audit message within the given source and
component.

Event Type Indicates the type of event around which system components generated
the audit message. Valid values:

v ALL

v System (processing) Event

v Automated Event (Process Control event)

v Interactive Event (user session)

v Mailbox/Information Hub

Audit Number The identifying number indicating the source ID, component ID, and
message ID of the audit message.

Event Name A textual description that corresponds with the Event ID and event type
to make them more meaningful to the user. For example, if a Process
Control event named Process Invoices runs, the system allocates a unique
Event ID that is associated with event type = Automated and event name
= Process Invoices.

Audit Key A system-generated sequence number to uniquely identify the Audit Log
entry in the Audit Log table.

Event ID A unique number applied by the Audit Notification System to all system
events (and Audit Log entries). Audit Log entries generated from the
same Process Control event, user session, or system-generated event are
assigned the same Event ID number. Entries with the same Event ID are
grouped together within the Audit Log display by default.

Severity Indicates the magnitude of the error or the status of the event. Severity
levels:

v Information

v Warning

v Error

v Audit Success

v Audit Failure

Message text Displays the descriptive text of the audit message.

Additional Text Displays additional descriptive text of the audit message.

Audit Log Filter Dialog Box
The Audit Log Filter dialog box allows you to customize the Audit Log display by
specifying audit message criteria so the Audit Log displays only entries matching
that criteria.

For example, if you want to filter the Audit Log to display only entries from a
specific Notification Type Process Control event called Outbound Communications,
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you enter Outbound Communications in the Event Name box, then click OK. The
Audit Log displays only messages generated from that Notification Type Process
Control event.

Table 38. Audit Log Filter dialog box parts and functions

Part Function

First Audit

Audits On

Specifies that the filter will begin either at the first Audit Log entry
stored by the system on the Audit Log database table or with the
first Audit Log entry that was processed at the specified date and
time.

Last Audit

Audits On

Specifies that the filter will end either at the last Audit Log entry
stored by the system on the Audit Log database table or at the last
Audit Log entry that was processed at the specified date and time.

OK Filters the Audit Log display according to the specified criteria.

Cancel Exits the dialog box without filtering the Audit Log display.

Clear Clears the fields on the dialog box.

Help Accesses Online Help.

Severity Indicates the magnitude of the errors or the status of the events
that you want to be displayed on the Audit Log. Severity levels:

v Information

v Warning

v Error

v Audit Success

v Audit Failure

Source Indicates the system or functional system area (such as Sterling
Gentran:Server, Archive, or user system) generating the audit
message for which you want the Audit Log entry to be displayed.

Component Indicates the part of the specified source generating the audit
message (such as the Sterling Gentran:Server Unattended
program).

Message ID Indicates the number of the audit message within the given source
and component.

Event Type Indicates the type of event around which system components
generated the audit message. The following are the event types:

v ALL

v System Event

v Automated Event (Process Control event)

v Interactive Event (user session)

v Mailbox/Information Hub

Event Name Indicates the name of the event initiating the generation of audit
messages. For example, in the message Gentran:Archive Manager
started, the Event Name is Archive.

Event ID A unique number applied by the Audit Notification System to all
system events (and Audit Log entries). Audit Log entries generated
from the same Process Control event, user session, or
system-generated event are assigned the same Event ID number.
Entries with the same Event ID are grouped together within the
Audit Log display by default.
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Table 38. Audit Log Filter dialog box parts and functions (continued)

Part Function

User Indicates the Windows User ID of the user who initiated the
process (or the Windows User ID of the service running the
process as a Process Control event) that is described by the audit
message for which you want the Audit Log entry to be displayed.

Computer Indicates the name of the machine on which the process was
running that initiated the audit message for which you want the
Audit Log entries to be displayed.

Audit Log Find Dialog Box
The Audit Log Find dialog box allows you to locate specific Audit Log entries by
limiting the search to specific properties entered on this dialog.

Table 39. Audit Log Find dialog box parts and functions

Part Function

Source Indicates the system or functional system area (such as Sterling
Gentran:Server, Archive, or user system) generating the audit
message that corresponds to the Audit Log entry you want to find.

Component Indicates the part of the specified source generating the audit
message (such as the Sterling Gentran:Server Unattended program)
that generated the Audit Log entry you want to find.

Message ID Specifies the number between 1 and 65535 that indicates the
specific error for the component as it applies to the Audit Log
entry you want to find.

Event Name Specifies the name of the event that initiated the audit message
corresponding to the Audit Log entry you want to find.

Event ID Specifies the unique numerical identifier assigned by Sterling
Gentran:Server to the Audit Log entry (and any related Audit Log
entries) that you want to find.

Audit Key Specifies the system-generated sequence number that uniquely
identifies the audit message entry in the Audit Log table.

User Specifies the Windows User ID of the user initiating the process (or
the Windows User ID of the service running the process as a
Process Control event) that resulted in the Audit Log entry you
want to find.

Computer Specifies the name of the machine on which the process was
running when the Audit Log entry you want to find was
generated.

Severity Specifies the severity level value that applies to the Audit Log
entry you want to find. Severity levels:

v Information

v Warning

v Error

v Audit Success

v Audit Failure

Find Next Displays the next audit message that matches the criteria selected
in the dialog box fields.

Clear Clears the Audit Log Find dialog box search criteria fields.
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Table 39. Audit Log Find dialog box parts and functions (continued)

Part Function

Direction

Up/Down

Search up or down the Audit Log list (relative to the current
location in the list) for audit messages that match the selected
criteria.

Viewing Audit Log Entry Details
You can view detailed Audit Log entry information on the Audit Log Entry Detail
dialog box.

About this task

To view Audit Log entry details, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server.
2. Select View > Audit Log.
3. Double-click the Audit Log entry for which you want to view details.
4. Click Close to exit the dialog box.

Note: You can click Previous to view the details for the entry before your
present spot on the list or Next to view details for the entry after your present
spot on the list.

Searching for Audit Log Entries
You can search for specific Audit Log entries using the Audit Log Find dialog box.
Use this dialog box to quickly and easily locate entries from large lists of data.

About this task

To search for a specific Audit Log entry, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server.
2. Select View > Audit Log.
3. Select View > Find.
4. Complete the following fields as needed:

v Source
v Component
v Message ID
v Event Name
v Event ID
v Audit KEY
v User
v Computer
v Severity

5. Select Up or Down to indicate whether you want the system to search up or
down the list from your present location.

6. Click Find Next.
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The system moves the cursor on the Audit Log to the next message on the list
that matches the find criteria you entered. If the system finds no matching
entry, it displays an informative dialog box.

Note: The system requires you to page up or down as it completes the search.
For example, if you have 10 pages of data and if you start your search on the
first page, the system finds any matches on that page, then displays a message
to ask if you want to search on the next page. If you select Yes, the system
finds any matches on the second page. When the system has found all
matching entries on the second page, you can click Find Next to continue
searching consecutive pages without the system displaying the message asking
what you want to do.

7. When you have completed the search, click Cancel to exit the dialog box.

Filtering the Audit Log Display
You can filter the Audit Log display by specifying criteria on the Audit Log Filter
dialog box by which you want the display to be limited.

About this task

To filter the Audit Log display, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran Server.
2. Select View > Audit Log.
3. Select View > Filter Audits.
4. Complete the following fields as needed:

v Select First Audit or Audits On (if you select Audits On, select the date and
time).

v Select Last Audit or Audits On (if you select Audits On, select the date and
time).

v Severity
v Source
v Component
v Event type
v Event name
v Event ID
v User
v Computer

5. Click OK.
The system filters the Audit Log according to the specified criteria and
redisplays the Audit Log, listing data that matches the filtering criteria.

The Notification Log
The Notification Log displays a list of generated notifications sorted in date/time
order with most current first.

You can use the Notification Log to:
v View a list of notifications generated specifically to you.
v View a list of all notifications generated.
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v View detailed information about a notification you have received.
v Receive alert messages when a notification is generated to you.
v Delete notifications generated to you.

Note: The system writes Notification Log entries for user-directed actions only
(such as e-mails, alerts, and pages). Notifications in the form of Notification Type
Process Control events are not included in the Log.

Each entry on the Notification Log includes information about:
v The audit message that precipitated the notification
v The type of notification action issued
v The computer on which the process was running when the audit message that

initiated the notification was generated.

If you receive a notification, you can refer to the Notification Log for more
information about the audit message and the event that precipitated the
notification.

Operator-specific Log display

The Notification Log makes it easy for you to get more information about the audit
message that precipitated a notification.

When you open the Sterling Gentran:Server Notification Log dialog box, the
system searches the related database, using your Windows User ID, to locate
notifications generated to that Windows User ID. Using this information, the list of
notifications displayed on the dialog box is customized to show only the
notifications that apply to your User ID.

If you enter an invalid Windows User ID (an ID for which no operator has been
defined in the system), the operator-specific list does not display. To access the
display without a valid ID, you must open the Sterling Gentran:Server Notification
Log dialog box and select All Notifications from the View menu. The system
displays a list of all notifications generated.

If no notifications have been generated to the Windows User ID with which you
logged on, the system displays the dialog box with no entries.

Alert settings

By default, you are activated to receive Notification Log alert messages
accompanied by an audible beep signal if you have started the Notification Log
after entering a valid Windows User ID. These alert messages warn you that a
notification has been generated to you so you can check the Log for details.

Alert messages display the audit number and audit message text for the audit
message that generated the notification.

The alert message disappears automatically, or you can click OK to close it. When
the alert closes, the system adds a corresponding entry to the Notification Log.

The alert messages and audible beep signal options are activated when the
Message Box and Audible Signal selections are enabled on the Preferences menu of
the Notification Log dialog box. You can disable the audible signal or Notification
Log alerts by deselecting these options on the menu.
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View all notifications

If you want to view all Notification Log entries rather than the operator-specific
list, you can select All Notifications from the View menu. You also can use this
option if your Windows User ID is invalid and no list displays.

When you select All Notifications, the system adds a new Operator column to the
dialog box. This column indicates the operator to whom the notification was
generated.

When you are viewing all notifications, the system generates alert messages
configured to any user.

Deleting one or all notifications

You can delete all of your Notifications from the Log by selecting the Delete All
Notifications option from the View menu on the Sterling Gentran:Server
Notification Log dialog box.

Note: If you are viewing all notifications mode and select Delete All
Notifications, the system displays a message box explaining that all Notifications,
not just to the current user, will be deleted. You can continue or cancel the delete.

Purging the Notification Log

You can purge the contents of the Notification Log using the GDW_Notify_Purge
command in a Process Control session.

Accessing the Notification Log

Access the Notification Log component from the Start menu by selecting Programs
> Gentran Server > Gentran Notification Log.

Notification Log Dialog Box
The Sterling Gentran:Server Notification Log dialog box allows you to view and
delete entries from the list of notifications generated by the Audit Notification
system.

Table 40. Notification Log dialog box parts and functions

Part Function

Operator Indicates the Windows User ID of the Operator to whom the
notification was directed. The system displays this field only when
you are viewing all notifications.

SV/Act Indicates the severity level of the associated audit message, and the
notification action taken (such as page or e-mail).

Date/Time Indicates the date (MM/DD/YY) and time (HH:MM:SS) that the
audit message that triggered the notification occurred.

Event ID The unique number assigned by Sterling Gentran:Server to the
Audit Log entry (and any related Audit Log entries) that initiated
the notification.

Audit Number The identifying number indicating the source ID, component ID,
and message ID of the audit message that initiated the notification.

Message Displays the descriptive text of the audit message that initiated the
notification.
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Table 40. Notification Log dialog box parts and functions (continued)

Part Function

User Indicates the Windows User ID of the user initiating the process
(or the Windows User ID of the service running the process as a
Process Control event) that initiated the audit message and
notification.

Computer Indicates the name of the machine on which the process was
running when the audit message that initiated the notification was
generated.

Audit Key Specifies the system-generated sequence number that uniquely
identifies the audit message entry in the Audit Log table that
initiated the notification.

Notification Details Dialog Box
The Notification Details dialog box allows you to view detailed information for a
selected Notification Log entry.

Table 41. Notification Details dialog box parts and functions

Part Function

Date/Time Indicates the date (MM/DD/YY) and time (HH:MM:SS) that the
audit message that triggered the notification occurred.

Source Indicates the system or functional system area (such as Sterling
Gentran:Server, Archive, or user system) generating the audit
message that initiated the notification.

User Indicates the Windows User ID of the user initiating the process
(or the Windows User ID of the service running the process as a
Process Control event) that initiated the audit message and
notification.

Component Indicates the part of the specified source generating the audit
message (such as the Sterling Gentran:Server Unattended program)
that initiated the notification.

Computer Indicates the name of the machine (on which the process was
running) that initiated the audit message and notification.

Message ID Indicates the number of the audit message within the given source
and component that initiated the notification.

Event Type Indicates the type of event around which system components
generated the audit message that initiated the notification. Valid
values:

v ALL

v System (processing) Event

v Automated Event (Process Control event)

v Interactive Event (user session)

v Mailbox/Information Hub

Audit Number The identifying number indicating the source ID, component ID
and message ID of the audit message that initiated the notification.

Event Name Indicates the name of the event that initiated the generation of the
audit message and notification. For example, in the message
Gentran:Archive Manager started, the Event Name is Archive.
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Table 41. Notification Details dialog box parts and functions (continued)

Part Function

Audit Key The system-generated sequence number that uniquely identifies the
related audit message entry in the Audit Log database table.
Note: Knowing the sequence in which the audit message occurred
allows you to use the audit key value to search the Audit Log for
the message that triggered the notification. In this way, you can
review any related Audit Log entries that occurred before or after,
giving you more information about an event.

Event ID Indicates the unique numerical identifier assigned by the Audit
Notification system to the Audit Log entry (and any related Audit
Log entries) that applies to the notification.

Severity Indicates the magnitude of the error or the status of the event that
initiated the audit message and notification. Severity levels:

v Information

v Warning

v Error

v Audit Success

v Audit Failure

Audit Type Indicates whether the audit message is a data audit message or a
processing audit message.

Notification Indicates the name of the notification.

Action Indicates the type of notification action (page or e-mail).

Operator Indicates the name of the operator designated to receive the
notification.

Text Displays the text of the notification.
Note: For numeric pages, the audit number format contains
leading zeroes for the component ID and message ID portions of
the number. The leading zeroes enable the recipient of the page to
determine the number, since the dashes that divide the components
do not display on a beeper. With the leading zeroes, the
component ID will always have three characters and the message
ID will always have five characters. For example, message number
1-1-1200 will display on the beeper as 100101200.

Message text Displays the descriptive text of the audit message that initiated the
notification.

Additional Text Displays additional descriptive text of the audit message that
initiated the notification.

Viewing Notification Log Entry Details
You can view detailed information about a Notification Log entry on the
Notification Detail dialog box.

About this task

To view the detailed information for a Notification Log entry, complete the
following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server > Gentran

Notification Log.
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2. Double-click the Notification Log entry for which you want to view details.

Note: You can click Previous to view the details for the entry before your
present spot on the list or Next to view details for the entry after your present
spot on the list.

3. Click Close to exit the dialog box.
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Chapter 4. Database Tables

About Database Tables
Sterling Gentran:Server enables you to access its relational database tables by using
your database management system. This gives you the capability to query the
database tables.

Important: The relationships between the tables are extremely complex, and
therefore we strongly recommend that you do not update these tables.

Database tables include the following:
v Data flow tables
v System configuration tables
v Partner profile tables
v Audit and notify tables
v Mailbox tables

Data Flow Tables
The following tables control the data flow processes in Sterling Gentran:Server:
v Document Table (Document_tb)
v External Data Table (ExtData_tb)
v External Data Cross-Reference Table (ExtDataXref_tb)
v Group Table (Group_tb)
v Interchange Table (Interchange_tb)
v Track Table (Track_tb)
v Tracking Table (Tracking_tb)

Document Table
The Document Table (Document_tb) contains a record for every document in the
Sterling Gentran:Server system.

The translator creates a record in the Document Table each time a document is
created or introduced to the system. Each time a function is performed against a
document (such as send, receive, import, or export), the translator updates the
corresponding record in the Document Table. The translator deletes a record from
the Document Table when the corresponding document is deleted.

Table 42. Document Table field information

Field Name Type Size Values and Use

DocumentKEY number
(long)

4 Unique identifier (integer) for a document that is allocated by the
system.

Direction number
(integer)

2 Direction of the document:

v 0 = Inbound

v 1 = Outbound

PartnerKEY string 25 Unique identifier for the partner to which the document belongs.
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Table 42. Document Table field information (continued)

Field Name Type Size Values and Use

DocumentName string 255 Name of the document established in the Application Integration
subsystem to help identify this document in the Sterling
Gentran:Server document browsers.

TransactionSetID string 150 Transaction set (message) identifier established in the partner
relationship or in the document.

FunctionalGroupID string 6 Functional group identifier established in the partner relationship.

ControlNumber string 255 Value from the partner relationship used to generate the next
transaction set control number or message reference.

LocationStatus number
(long)

4 Location of the document in Sterling Gentran:Server:

v 0 = In Drawer

v 1 = Out Drawer

v 2 = In Documents

v 3 = ?In Documents

v 4 = Out Documents

v 5 = ?Out Documents

v 6 = Workspace

v 7 = Queued

ComplianceStatus number
(long)

4 Compliance status of the document in Sterling Gentran:Server:

v 0 = Incomplete

v 1 = NonCompliant

v 2 = OK

v 3 = DocQueued

v 4 = Sent

v 5 = NetReceived

v 6 = NetDelivered

v 7 = Ack'd

v 8 = Waiting

v 9 = OverDue

v 10 = NetWarning

v 11 = NetError

v 12 = AckErr

v 13 = FAPartial

v 14 = FAReject

v 15 = NetPickedUp

v 16 = Duplicate

v 17 = ReadyToSend

v 18 = SendFailed

TimeCreated number
(long)

4 Time the document was created by the system.

Release number
(long)

4 Message release number of the document (TRADACOMS only).

TestMode number
(long)

4 Indicates the partner relationship mode:

v 0 = Production

v 1 = Test
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Table 42. Document Table field information (continued)

Field Name Type Size Values and Use

TestModeChar number
(integer)

2 Character representation of the partner relationship mode:

v 0 = Production

v 1 = Test

Agency number
(integer)

2 EDI standard used for the document.

InterchangeVersion string 13 Version of the interchange from the interchange control record in
the partner relationship.

GroupVersion string 13 Version of the group from the group control record in the partner
relationship.

DocumentVersion string 13 Version of the document from the document control record in the
partner relationship.

DocumentBlobKEY string 255 Name of the *.doc file in the Documents subfolder.

UserIDKEY string 20 Identifier for the user who created the document.

ReferenceData string 255 Reference data for this document established in the Application
Integration subsystem to help identify the document in the Sterling
Gentran:Server document browsers.

TranslationReport File string 255 File name for the translator report.

AppField1 string 150 First application field in this document that was updated in the
Application Integration subsystem.

AppField2 string 150 Second application field in this document that was updated in the
Application Integration subsystem.

AppField3 string 40 Third application field in this document that was updated in the
Application Integration subsystem.

AppField4 string 40 Fourth application field in this document that was updated in the
Application Integration subsystem.

AppField5 string 40 Fifth application field in this document that was updated in the
Application Integration subsystem.

AppField6 string 40 Sixth application field in this document that was updated in the
Application Integration subsystem.

Element Separator number
(integer)

2 Value from the partner relationship used to separate elements in a
data segment.

SubElement Separator number
(integer)

2 Value from the partner relationship used to separate component
elements in a composite data element.

SegmentTerminator number
(integer)

2 Value from the partner relationship used to identify the end of a
data segment.

ReleaseCharacter number
(integer)

2 Value from the partner relationship used to restore any character
used as a syntactical separator to its original meaning.

SegmentTag number
(integer)

2 Value from the partner relationship used to identify the end of
each segment tag (identifier).

DecimalIndicator number
(integer)

2 Value from the partner relationship used to indicate a decimal
point in a numeric field.

Processing number
(integer)

2 Indicates if a document is being processed:

v 0 = Not processing

v 1 = Processing

v 2 = Deferred Acknowledgement
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Table 42. Document Table field information (continued)

Field Name Type Size Values and Use

Restored number
(integer)

2 Indicates whether the data is original or restored:

v 0 = Original

v 1 = Restored

NbrBytes number
(long)

4 Provides a counter of the number of bytes in the document EDI
data.

NbrRecords number
(long)

4 Provides a counter of the number of records in the document EDI
data.

Mailbox string 125 Mailbox that corresponds to the document.

RepeatingElement
Separator

number
(integer)

2 Location of the repeating element separator in the interchange, if
the standard you are using employs composite fields containing
repeating data elements.

External Data Table
The External Data Table (ExtData_tb) contains the persistent copy of the external
data files.

A record in this table corresponds to one of two types of external data references in
the system, each containing several attributes that describe it. For flat files that are
exported, imported, or processed inbound, the type is external data and the
external data reference contains information about the flat file. For documents that
are sent to a Mailbox message, the type is message and the external data reference
contains information about the outbound message.

Table 43. External Data Table field information

Field Name Type Size Use

ExtDataType number
(long)

4 Type of external data:

ExtData if Sterling Gentran:Server data came from or is sent to a
flat file

Message if Sterling Gentran:Server data is sent to a Mailbox
message.

ExtDataKEY number
(long)

4 Unique external data file identifier.

Filename string 255 Original filename before it was copied (if copied) to the external
data folder in the system data store.

FileDateTime number
(long)

4 Timestamp of the original file.

ActionDataTime number
(long)

4 Date and time that the action took place, such as export or import.
(Date/time the database was updated.)

Action number
(long)

4 Type of action performed on the external data file:

v Export

v Import

v Mailbox Import

v Process File

v Mailbox Process File

v Send
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Table 43. External Data Table field information (continued)

Field Name Type Size Use

BlobKEY string 255 Name of the file saved in the system data store folder and its path
relative to this directory. The name of the file is the ExtDataKEY to
ensure it is unique, with .ext as the file extension. The relative
path depends on the Directory Format that the user specifies in
the System Configuration subsystem.

Restored number
(long)

4 Indicating whether the record (external data reference) was
restored from an archive.

Msg number
(long)

4 Number indicating the message in Mailbox to which the external
data was sent for the outbound process, or the message from
which the external data was received for the inbound process.

Atm number
(long)

4 Number indicating the attachment in Mailbox to which the
external data was sent for the outbound process, or the attachment
from which the external data was received for the inbound
process.

ExtDataCount number
(long)

4 Count of the Sterling Gentran:Server documents with which an
external data reference is associated. This count is decremented
when associated documents are deleted and incremented when
documents are added.

SaveFile number
(long)

4 Indicates if the external data was saved to the system data store
folder.

External Data Cross-Reference Table
The External Data Cross-Reference Table (ExtDataXref_tb) contains information on
how each external data file relates with the Sterling Gentran:Server data.

Each record is a cross-reference between external data and a related Sterling
Gentran:Server document or interchange.

Table 44. External Data Cross-reference Table field information

Field Name Type Size Use

ExtDataKEY number
(long)

4 A foreign key on the ExtData_tb, used to provide a link between
the tables.

GentranType number
(long)

4 Type of Sterling Gentran:Server data that is related to the external
data reference:

v Interchange

v Document

GentranKEY number
(long)

4 A foreign key on either the Interchange_tb or the Document_tb,
depending on the value of the GentranType parameter.

RecordCount number
(long)

4 For import and export actions, the number of records in the
external data file that were created from the document that was
imported or exported. For process file actions, the number of
segments in the interchange that were processed for the given
inbound data.

ByteCount number
(long)

4 Total number of bytes in the external data.

StartingOffset number
(long)

4 The start offset in the external data that corresponds to the Sterling
Gentran:Server data that the record created.

EndingOffset number
(long)

4 The end offset in the external data that corresponds to the Sterling
Gentran:Server data that the record created.
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Table 44. External Data Cross-reference Table field information (continued)

Field Name Type Size Use

TimeStamp number
(long)

4 Date/time when this external data reference is written.

Appfield1 string 40 Copied from the Document_tb according to the DocumentKEY. If
the external data is associated with an interchange, then Appfield
1–6 are copied from the Interchange_tb.

Appfield2 string 40 Copied from the Document_tb according to the DocumentKEY. If
the external data is associated with an interchange, then Appfield
1–6 are copied from the Interchange_tb.

Appfield3 string 40 Copied from the Document_tb according to the DocumentKEY. If
the external data is associated with an interchange, then Appfield
1–6 are copied from the Interchange_tb.

Appfield4 string 40 Copied from the Document_tb according to the DocumentKEY. If
the external data is associated with an interchange, then Appfield
1–6 are copied from the Interchange_tb.

Appfield5 string 40 Copied from the Document_tb according to the DocumentKEY. If
the external data is associated with an interchange, then Appfield
1–6 are copied from the Interchange_tb.

Appfield6 string 40 Copied from the Document_tb according to the DocumentKEY. If
the external data is associated with an interchange, then Appfield
1–6 are copied from the Interchange_tb.

DocumentName string 255 Copied from the Document_tb according to the DocumentKEY. If
the external data is associated with an interchange, then
DocumentName is ignored.

ReferenceData string 255 Copied from the Document_tb according to the DocumentKEY. If
the external data is associated with an interchange, then
ReferenceData is ignored.

TranslationReport File string 255 Name of the translator report file.

DocStatus number
(integer)

2 Indicates whether document processing succeeded:

v 0 = Failure

v 1= Success

Group Table
The Group Table (Group_tb) contains a record for every functional group in the
Sterling Gentran:Server system.

The translator creates a record in the Group Table each time a group is introduced
to the system. A record in the Group Table is updated when a functional group
acknowledgement is received or generated. The translator deletes a record from the
Group Table when the corresponding group is deleted.

Table 45. Group Table field information

Field Name Type Size Use

GroupKEY number
(long)

4 Unique identifier for a group that is allocated by the system.

PartnerKEY string 25 Unique identifier for the partner to which the group belongs.

ControlNumber string 255 Value from the partner relationship used to generate the next
group control number.

FunctionalGroupID string 6 Functional group identifier established in the partner relationship.
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Table 45. Group Table field information (continued)

Field Name Type Size Use

GroupControlKEY string 20 Group control record in Partner Editor that refers to this table.

Direction number
(integer)

2 Direction of the group:

v 0 = Inbound

v 1 = Outbound

Agency number
(integer)

2 EDI standard used for the group.

Version string 13 Version of the group from the group control record in the partner
relationship.

ExpectOrGenerate Ack number
(integer)

2 Indicates whether the system sends a functional acknowledgement
to this trading partner when you receive the group defined in this
relationship (inbound) or receives a functional acknowledgement
from this trading partner as a result of your partner receiving the
group defined in this relationship (outbound):

v 0 = Do not expect or generate acknowledgements

v 1 = Expect or generate acknowledgements

AckHoursOverdue number
(integer)

2 Number of hours that must elapse before the acknowledgement is
considered overdue.

AckStatus (inbound) number
(integer)

2 Status of the acknowledgement (inbound):

v 0 = Acknowledgement not required

v 1 = Waiting

v 2 = OK

v 3 = Acknowledged with errors

v 4 = Partially acknowledged

v 5 = Rejected

v 6 = Deferred acknowledgement generation

v 7 = Immediate acknowledgement generation

v 8 = Deferred reconciliation (for acknowledgement documents
only)

v 9 = Immediate reconciliation (for acknowledgement documents
only)

v 10 = Reconciliation complete (for acknowledgement documents
only)

AckStatus (outbound) number
(integer)

2 Status of the acknowledgement (outbound):

v 0 = Reconciliation not required

v 1 = Waiting

v 2 = OK

v 3 = Reconciled with errors

v 4 = Partially reconciled

v 5 = Rejected

v 6 = Reconciliation overdue

AckTime number
(long)

4 Time of the acknowledgement.

AckTransaction SetID string 150 System-generated transaction set identifier for the
acknowledgement.

NoTransactions
Accepted

number
(integer)

4 Number of transaction sets that were accepted (inbound).
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Table 45. Group Table field information (continued)

Field Name Type Size Use

NoTransactions Rejected number
(integer)

4 Number of transaction sets that were rejected (inbound).

AppField1 string 40 First application field in this group that was updated in the
Application Integration subsystem.

AppField2 string 40 Second application field in this group that was updated in the
Application Integration subsystem.

AppField3 string 40 Third application field in this group that was updated in the
Application Integration subsystem.

AppField4 string 40 Fourth application field in this group that was updated in the
Application Integration subsystem.

AppField5 string 40 Fifth application field in this group that was updated in the
Application Integration subsystem.

AppField6 string 40 Sixth application field in this group that was updated in the
Application Integration subsystem.

Element Separator number
(integer)

2 Value from the partner relationship used to separate elements in an
outbound data segment.

SubElement Separator number
(integer)

2 Value from the partner relationship used to separate component
elements in an outbound composite data element.

SegmentTerminator number
(integer)

2 Value from the partner relationship used to identify the end of an
outbound data segment.

ReleaseCharacter number
(integer)

2 Value from the partner relationship used to restore any character
used as a syntactical separator to its original meaning.

SegmentTag number
(integer)

2 Value from the partner relationship used to identify the end of
each segment tag (identifier).

DecimalIndicator number
(integer)

2 Value from the partner relationship used to indicate a decimal
point in a numeric field.

Restored number
(integer)

2 Indicates whether the data is original or restored:

v 0 = Original

v 1 = Restored

NbrBytes number
(long)

4 Provides a counter of the number of bytes in the Group EDI data.

NbrRecords number
(long)

4 Provides a counter of the number of records in the document EDI
data.

Interchange Table
The Interchange Table (Interchange_tb) contains a record for every interchange in
the Sterling Gentran:Server system.

The translator creates a record in the Interchange Table each time an interchange is
introduced to the system. A record in the Interchange Table is updated when an
interchange acknowledgement is received or generated. The translator deletes a
record from the Interchange Table when the corresponding interchange is deleted.

Table 46. Interchange Table field information

Field Name Type Size Use

InterchangeKEY number
(long)

4 Unique identifier for an interchange that is allocated by the
system.
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Table 46. Interchange Table field information (continued)

Field Name Type Size Use

PartnerKEY string 25 Unique identifier for the partner to which the interchange belongs.

ControlNumber string 255 Value from the partner relationship used to generate the next
interchange control number.

InterchangeControl KEY string 40 Interchange control record in Partner Editor that refers to this
table.

SessionKEY number
(long)

4 Not currently used.

TimeCreated number
(long)

4 Time the interchange was created by the system.

TimeSent number
(long)

4 Time the interchange was sent.

ProcessedStatus number
(integer)

2 Processing status of the interchange:

v 1 = Received

v 2 = Sent

v 3 = Ready to Send

v 4 = Queued

v 6 = Held

v 7 = Send Failed

v 8 = Processing

Direction number
(integer)

2 Direction of the interchange:

v 0 = Inbound

v 1 = Outbound

Agency number
(integer)

2 EDI standard used for the interchange.

Version string 13 Version of the interchange from the interchange control record in
the partner relationship.

TestMode number
(integer)

2 Indicates the partner relationship mode:

v 0 = Production

v 1 = Test

ExpectOrGenerate Ack number
(integer)

2 Indicates whether the system sends an acknowledgement to this
trading partner when you receive the interchange defined in this
relationship (inbound) or receives an acknowledgement from this
trading partner as a result of your partner receiving the
interchange defined in this relationship (outbound):

v 0 = Do not expect or generate acknowledgements

v 1 = Expect or generate acknowledgements

AckHoursOverdue number
(integer)

2 Number of hours that must elapse before the acknowledgement is
considered overdue.
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Table 46. Interchange Table field information (continued)

Field Name Type Size Use

AckStatus (inbound) number
(integer)

2 Status of the acknowledgement (inbound):

v 0 = Acknowledgement not required

v 1 = Waiting

v 2 = OK

v 3 = Acknowledged with errors

v 4 = Partially acknowledged

v 5 = Rejected

v 6 = Deferred acknowledgement generation

v 7 = Immediate acknowledgement generation

v 8 = Deferred reconciliation (for acknowledgement documents
only)

v 9 = Immediate reconciliation (for acknowledgement documents
only)

v 10 = Reconciliation complete (for acknowledgement documents
only)

AckStatus (outbound) number
(integer)

2 Status of the acknowledgement (outbound):

v 0 = Reconciliation not required

v 1 = Waiting

v 2 = OK

v 3 = Reconciled with errors

v 4 = Partially reconciled

v 5 = Rejected

v 6 = Reconciliation overdue

AckTime number
(long)

4 Time of the acknowledgement.

AckTransaction SetID string 150 System-generated transaction set identifier for the
acknowledgement.

NetworkStatus number
(integer)

2 Network processing status:

v 0 = Not sent

v 1 = Received OK

v 2 = Network Warning

v 3 = Network Error

v 4 = Picked Up

v 5 = Transmitted to third-party network

NetworkTime number
(long)

4 Time the network received the interchange.

NoGroupsAccepted number
(integer)

2 Number of groups that were accepted (inbound).

NoGroupsRejected number
(integer)

2 Number of groups that were rejected (inbound).

NoTransactions
Accepted

number
(integer)

4 Number of transaction sets that were accepted (inbound).

NoTransactions Rejected number
(integer)

4 Number of transaction sets that were rejected (inbound).

Filename string 255 Name of the file that contains the interchange data.

Translation ReportFile string 255 File name of the interchange translator report.
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Table 46. Interchange Table field information (continued)

Field Name Type Size Use

AppField1 string 40 First application field in this interchange that was updated in the
Application Integration subsystem.

AppField2 string 40 Second application field in this interchange that was updated in
the Application Integration subsystem.

AppField3 string 40 Third application field in this interchange that was updated in the
Application Integration subsystem.

AppField4 string 40 Fourth application field in this interchange that was updated in
the Application Integration subsystem.

AppField5 string 40 Fifth application field in this interchange that was updated in the
Application Integration subsystem.

AppField6 string 40 Sixth application field in this interchange that was updated in the
Application Integration subsystem.

Element Separator number
(integer)

2 Value from the partner relationship used to separate elements in
an outbound data segment.

SubElement Separator number
(integer)

2 Value from the partner relationship used to separate component
elements in an outbound composite data element.

SegmentTerminator number
(integer)

2 Value from the partner relationship used to identify the end of an
outbound data segment.

ReleaseCharacter number
(integer)

2 Value from the partner relationship used to restore any character
used as a syntactical separator to its original meaning.

SegmentTag number
(integer)

2 Value from the partner relationship used to identify the end of
each segment tag (identifier).

DecimalIndicator number
(integer)

2 Value from the partner relationship used to indicate a decimal
point in a numeric field.

MessageId number
(long)

4 Message identifier used to send the interchange data.

Restored number
(integer)

2 Indicates whether the data is original or restored:

v 0 = Original

v 1 = Restored

NbrBytes number
(long)

4 Provides a counter of the number of bytes in the Interchange EDI
data.

NbrRecords number
(long)

4 Provides a counter of the number of records in the document EDI
data.

RepeatingElement
Separator

number
(integer)

2 Location of the repeating element separator in the interchange, if
the standard you are using employs composite fields containing
repeating data elements.

Track Table
The Track Table (Track_tb) contains a record for every document in the Sterling
Gentran:Server system.

The records contain all the necessary information to allow the system to track the
document, including the link between the document, group, and interchange. The
translator creates a record for every document in an interchange in the Tracking
Table each time an interchange is built. A record in the Tracking Table is updated
when an acknowledgement is received or generated. The translator deletes a record
from the Tracking Table when the corresponding document is deleted.
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Table 47. Track Table field information

Field Name Type Size Use

DocumentKEY number
(long)

4 Unique identifier for a document (message) that is allocated by the
system.

GroupKEY number
(long)

4 Unique identifier for a functional group that is allocated by the
system.

InterchangeKEY number
(long)

4 Unique identifier for an interchange that is allocated by the system.

AckDocumentKEY number
(long)

4 Unique identifier for the document acknowledgement (the link
from the document to the acknowledgement).

TimeLastModified number
(long)

4 Time the document was last modified.

TimePosted number
(long)

4 Time the document was posted to the Out Documents.

ExpectOrGenerate Ack number
(integer)

2 Indicates whether the system sends an acknowledgement to this
trading partner when you receive the document defined in this
relationship (inbound) or receives an acknowledgement from this
trading partner as a result of your partner receiving the document
defined in this relationship (outbound).

GenerateAckDetails number
(integer)

2 Indicates whether the acknowledgement is generated with error
detail:

v 0 = No Error Detail

v 1 = With Error Detail

AckHoursOverdue number
(integer)

2 Number of hours that must elapse before the acknowledgement is
considered overdue.

AckTransactionSet ID string 150 System-generated transaction set identifier for the
acknowledgement.

Direction number
(integer)

2 Direction of the document:

v 0 = Inbound

v 1 = Outbound

AckStatus (inbound) number
(integer)

2 Status of the acknowledgement (inbound):

v 0 = Acknowledgement not required

v 1 = Waiting

v 2 = OK

v 3 = Acknowledged with errors

v 4 = Partially acknowledged

v 5 = Rejected

v 6 = Deferred acknowledgement generation

v 7 = Immediate acknowledgement generation

v 8 = Deferred reconciliation (for acknowledgement documents
only)

v 9 = Immediate reconciliation (for acknowledgement documents
only)

v 10 = Reconciliation complete (for acknowledgement documents
only)
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Table 47. Track Table field information (continued)

Field Name Type Size Use

AckStatus (outbound) number
(integer)

2 Status of the acknowledgement (outbound):

v 0 = Reconciliation not required

v 1 = Waiting

v 2 = OK

v 3 = Reconciled with errors

v 4 = Partially reconciled

v 5 = Rejected

v 6 = Reconciliation overdue

AckTime number
(long)

4 Time of the acknowledgement.

PartnerKEY string 25 Unique identifier for the partner to which the interchange belongs.

DocumentControl
Number

string 255 Value from the partner relationship used to generate the next
document control number or message reference.

GroupControl Number string 255 Value from the partner relationship used to generate the next group
control number.

InterchangeControl
Number

string 255 Value from the partner relationship used to generate the next
interchange control number.

FunctionalGroupID string 6 Functional group identifier established in the partner relationship.

TransactionSetID string 150 Transaction set (message) identifier established in the partner
relationship or in the document.

Restored number
(integer)

2 Indicates whether the data is original or restored:

v 0 = Original

v 1 = Restored

Tracking Table
The Tracking Table (Tracking_tb) contains a record for every document in the
Sterling Gentran:Server system.

The records contain all the necessary information to allow the system to track the
message.

The following table contains the field information for the Tracking Table:

Table 48. Tracking Table field information

Field Name Type Size Use

MessageId number (long) 4 Identifier for the message.

TrackingType string 125 Tracking type.

TrackingInfo string 255 Tracking information.

CheckSum number (long) 4 Reserved for future use.
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System Configuration Tables
The following tables allow system configuration in Sterling Gentran:Server:
v Application Database Information Table (AppDbInformation_tb)
v Schedule Table (Schedule_tb)
v Splitter Table (Splitter_tb)
v System Import Table (SystemImport_tb)
v Translation Object Table (Template_tb)
v User Table (User_tb)

Application Database Information Table
The Application Database Information Table (ApDbInformation_tb) contains one
record that contains all the multi-user system-wide configuration information.

This table is updated by a configuration program each time multi-user
configuration information is changed or a document, group, or interchange is
created.

Table 49. Application Database Information Table field information

Field Name Type Size Use

NextDocID number
(long)

4 System-generated key defining the identifier for the next
document. Updated each time a document is created.

NextGrpID number
(long)

4 System-generated key defining the identifier for the next group.
Updated each time a group is created.

NextIntID number
(long)

4 System-generated key defining the identifier for the next
interchange. Updated each time an interchange is created.

NextExtDataID number
(long)

4 System-generated key defining the identifier for the next external
data file. Updated each time an external data file is added to the
system.

NextPIPInstanceID number
(long)

4 System-generated key defining the identifier for the next PIP
instance. Updated each time a PIP instance is added to the system.

DbRevision string 10 Reserved for future use.

DirInterchangeIn string 255 UNC path name for the shared storage area containing all received
interchanges.

DirInterchangeOut string 255 UNC path name for the shared storage area containing all sent
interchanges.

DirTxReports string 255 UNC path name for the shared storage area containing all
translator reports. These reports are stored in binary format and
should only be printed using Sterling Gentran:Server.

DirTemplate string 255 UNC path name for the shared storage area containing all
registered translation objects.

DirUnattended string 255 UNC path name for the shared storage area containing all process
control events, sessions, and calendar files.

DirArchive string 255 UNC path name for the shared storage area containing all archived
definition files (*.ard) and archived data files (*.arv).

DirDocuments string 255 UNC path name for the shared storage area containing the
documents.

DirTransmitIn string 255 Folder containing the initial communication files received from
Mailbox, before the files are split into interchanges.

DirTransmitOut string 255 Temporary folder used for sending data.
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Table 49. Application Database Information Table field information (continued)

Field Name Type Size Use

DirErrData string 255 Folder containing the error data that is not recognized by the
Splitter.

DirExtData string 255 Folder containing the copies that the system has made of external
data files.

DirFormat number
(long)

4 Format Sterling Gentran:Server will use for its folders.

NextTplID number
(long)

4 Next translation object ID.

Exporter Table
The Exporter Table (Exporter_tb) contains a record for every document currently in
the build process within the Sterling Gentran:Server system.

The system creates a record when a document is being processed. The system
deletes the record when the build process is complete. This table is used internally
by the system during the build process to ensure that multiple build processes are
synchronized.

Table 50. Exporter Table field information

Field Name Type Size Use

DocumentKEY number (long) 4 Reserved.

PartnerKEY string 25 Reserved.

InterchangeControlKEY string 40 Reserved.

TestMode string 2 Reserved.

GroupControlKEY string 20 Reserved.

FunctionalGroup string 7 Reserved.

DocumentType string 7 Reserved.

Schedule Table
The Schedule Table (Schedule_tb) contains a record for every event in the Sterling
Gentran:Server system.

The translator creates a record when you create an event in process control. The
translator updates a record when you modify an event. The translator deletes a
record when you delete an event from the system.

Table 51. Schedule Table field information

Field Name Type Size Use

Time string 50 Time the event is run (for timed events only).

SessionFile string 50 Name of the session that is run.

Calendar string 50 Name of the calendar used to determine when the event should
be run (timed events only).

Parm1 string 128 User-defined parameter.

Parm2 string 128 User-defined parameter.

Parm3 string 128 User-defined parameter.
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Table 51. Schedule Table field information (continued)

Field Name Type Size Use

Owner string 50 Reserved for future use.

OwnerDomain string 50 Reserved for future use.

EventType number
(integer)

2 Indicates whether the event is polled:

v 0 = Scheduled

v 1 = Polled

v 2 = Notify

v 3 = System

ProcessID number
(long)

4 Identifier of the process that is running the session specified in
the event:

v 0 = process is not running

v non-zero = process is running

TimeStarted number
(long)

4 Time the event started.

TimeEnded number
(long)

4 Time the event ended.

ServerName string 50 Name of the controller on which the event is run.

CurrentSessionCmd Nbr number
(long)

4 Name of the event that is currently processing.

Event string 50 Description of the event.

Status number
(integer)

2 Indicates whether the event is suspended or active:

v 0 = suspended

v 1 = activated

v 2 = blocked

v 3 = execute

EventID string 10 Unique event identifier.

Splitter Table
The Splitter Table (Splitter_tb) contains a record for every splitter entry defined in
Sterling Gentran:Server.

Each splitter entry contains the parameters that are necessary for the system to
identify and split interchanges for received data.

Table 52. Splitter Table field information

Field Name Type Size Use

Type number
(integer)

2 Type of splitter entry.

v Fixed - The splitter entry expects a defined set of delimiters in
the EDI data. (default)

v Fixed Position - The splitter entry expects delimiters at defined
positions in the EDI data so the system can determine what the
delimiter is.

v Variable - The splitter entry expects defined interchange start
and end segments, element delimiter position (so the system can
determine what the delimiter is), number of elements in the start
segment, maximum length of the start segment, maximum
length of the last element in the start segment, and maximum
length of the end segment.
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Table 52. Splitter Table field information (continued)

Field Name Type Size Use

StartTag string 50 Start segment of the interchange.

EndTag string 50 End segment of the interchange.

EleDelim string 1 Value depends on the standard:

v For the Fixed type, contains the element separator.

v For the Fixed Position type, contains the position of the first
element separator in the interchange.

v For the Variable type, contains the position of the first element
delimiter in the interchange.

TagDelim string 1 Value depends on the standard:

v For the Fixed type, contains the tag separator.

v For the Fixed Position type, contains the position of the tag
separator in the interchange.

EndDelim string 1 Value depends on the standard:

v For the Fixed type, contains the element separator.

v For the Fixed Position type, contains the position of the first
element separator in the interchange.

v For the Variable type, contains the position of the first element
delimiter in the interchange.

RelDelim string 1 Value depends on the standard:

v For the Fixed type, contains the release indicator.

v For the Fixed Position type, contains the position of the first
release indicator in the interchange.

SubDelim string 1 Value depends on the standard:

v For the Fixed type, contains the subelement separator.

v For the Fixed Position type, contains the position of the first
subelement separator in the interchange.

DecChar string 1 Value depends on the standard:

v For the Fixed type, contains the decimal point notation.

v For the Fixed Position type, contains either a comma (,) or
period (.) to indicate the decimal point in a numeric field.

v For the Variable type, contains either a comma (,) or period (.) to
indicate the decimal point in a numeric field.

EleDelimPosn number
(integer)

2 Position of the element delimiter.

TagDelimPosn number
(integer)

2 Position of the tag delimiter.

EndDelimPosn number
(integer)

2 Position of the end delimiter.

RelDelimPosn number
(integer)

2 Position of the release delimiter.

SubDelimPosn number
(integer)

2 Position of the subelement delimiter.

DecCharPosn number
(integer)

2 Position of the decimal character delimiter.

NumHdrSeg number
(integer)

2 Number of elements in the interchange start segment.
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Table 52. Splitter Table field information (continued)

Field Name Type Size Use

HdrMaxLen number
(integer)

2 Maximum length of the interchange start segment.

HdrLastEleLen number
(integer)

2 Maximum length of the last element in the interchange start
segment.

EndMaxLen number
(integer)

2 Maximum length of the interchange end segment.

InterchangeBreak string 40 Interchange break translation object used to break the interchange.

GroupBreak string 40 Functional group break translation object used to break the
functional groups in the interchange.

TransactionBreak string 40 Transaction set break translation object used to break the
transaction sets in the interchange.

FAExtract string 40 Functional acknowledgement break translation object used to
extract interchange level functional acknowledgements from the
interchange.

RepeatingElement Delim string 1 Delimiter for repeating elements.

RepeatingElement
DelimPosn

number
(integer)

2 Location of the repeating element delimiter in the data.

BinarySegment string 50 Name of the binary segment for which the system should search in
the data.

System Import Table
The System Import Table (SystemImport_tb) contains a record for each set of
import parameters.

The import parameters enable you to determine which import or system import
translation object is used to translate files in the specified location with the
specified file extension.

Table 53. System Import Table field information

Field Name Type Size Use

Sequence number
(integer)

2 Sequential position of the import parameters in the hierarchical
list of parameters.

Filemask string 255 Path and type of file (or specific file name).

Template string 40 Import or system import translation object that you want the
system to use to begin translation when a file of the specified
type is imported.

Translation Object Table
The Translation Object Table (Template_tb) contains a record for every registered
translation object in the Sterling Gentran:Server system.

The translator creates a record when you register a translation object with the
system for the first time. The translator updates a record when you re-register a
translation object. The translator deletes a record when you delete a translation
object from the system.

104 IBM Sterling Gentran:Server for Windows: Administration Guide



Table 54. Translation Object Table field information

Field Name Type Size Use

Type number
(integer)

2 Type of translation object:

v 0 = Import

v 1 = Export

v 2 = Print

v 3 = Screen entry

v 4 = Turnaround

v 5 = Transaction build

v 6 = Transaction break

v 7 = Functional group build

v 8 = Functional group break

v 9 = Interchange build

v 10 = Interchange break

v 11 = F/A outbound

v 12 = F/A inbound

v 13 = System import

nTemplateKEY number
(long)

4 System-generated unique number that identifies the translation
object.

TemplateKEY string 40 Unique description of the translation object used by the system to
identify the translation object.

InputAgency number
(integer)

2 EDI standards agency used for the input side of the translation
object.

InputVersion string 13 Standard version used for the input side of the translation object.

InputTransactionID string 150 Transaction set (message) used for the input side of the translation
object.

InputRelease number
(integer)

2 Message release number used for the input side of the translation
object.

InputFunctional Group string 6 Functional group used for the input side of the translation object.

OutputAgency number
(integer)

2 EDI standards agency used for the output side of the translation
object.

OutputVersion string 13 Standard version used for the output side of the translation object.

OutputTransaction ID string 150 Transaction set (message) used for the output side of the
translation object.

OutputRelease number
(integer)

2 Message release number used for the output side of the translation
object.

OutputFunctional Group string 6 Functional group used for the output side of the translation object.

IsSystem number
(integer)

2 Indicates whether the translation object is a system translation
object (one used internally by the system).

Filename string 255 Name of the translation object file in the TransObj folder.

UsageCount number
(long)

4 Number of partner relationships that refer to this translation
object.

User Table
The User Table (User_tb) contains a record for every user in the Sterling
Gentran:Server system.
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The translator creates a record when you create a user. The translator updates a
record when you change user information. The translator deletes a record when
you delete a user from the system.

Table 55. User Table field information

Field Name Type Size Use

UserIDKEY string 20 System-generated unique key that identifies the user.

UserName string 42 Name of the user.

Password string 126 User password.

AccessCtlMatrix number
(long)

4 Type of access the user has to the Sterling Gentran:Server system.
The system "logically ors" these values when you select more than
one:

v 1 = System administration

v 2 = Partner administration

v 4 = Send/receive

v 8 = Import

v 16 = Export

v 32 = Screen entry

v 64 = Unattended

Partner Profile Tables
Partner Profile tables control the processing and structure of inbound and
outbound data in Sterling Gentran:Server and provide the translator access to
external information.

The partner profile tables are divided into two types, based on their functionality:
v Partner Control Tables
v Partner Reference Tables

Partner Control Tables
The partner control tables contain all the information necessary for the system to
process inbound and outbound EDI data, including acknowledgement, control
number, and enveloping information.

The following are the partner control tables:
v Functional Group Control Table (FunctionalGroupControl_tb)
v Generic Envelope Segment Table (GenericEnvelopeSegment_tb)
v Interchange Control Table (InterchangeControl_tb)
v Partner Table (Partner_tb)
v Relationship Table (Relationship_tb)

Functional Group Control Table
The Functional Group Control Table (FunctionalGroupControl_tb) contains a record
for every functional group in the Sterling Gentran:Server system.

Partner Editor creates a record in the Functional Group Control Table each time a
functional group definition is created. Each time a control number is received or
generated for a functional group, the translator updates the corresponding record
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in the Functional Group Control Table. Partner Editor deletes a record from the
Functional Group Control Table when the corresponding functional group
definition is deleted.

Table 56. Functional Group Control Table field information

Field Name Type Size Use

PartnerKEY string 25 Unique identifier for the partner to which the functional group
belongs.

Direction number
(integer)

2 Direction of the functional group:

v 0 = Inbound

v 1 = Outbound

FunctionalGroup
ControlKEY

string 20 Name of the functional group.

GroupSequence
CheckType

number
(integer)

2 Type of group sequence checking used for this group.

v 0 = None

v 1 = Incremental

v 2= Chronological

v 3= Duplicate

Agency number
(integer)

2 EDI standard used for this functional group.

Version string 13 Standard version used for this functional group.

FunctionalGroupID string 6 EDI standard identification for this functional group (such as PO
or IN).

SegmentID string 10 Segment identification of the controlling segment of the group
(such as GS, UNG, or BAT).

TemplateKEY string 40 Partner-specific group build or break translation object used for
this functional group.

AckExpected number
(integer)

2 Indicates that the system expects a functional acknowledgement to
be received from this trading partner as a result of your partner
receiving the group defined in this relationship (outbound).

HoursOverdue number
(integer)

2 Number of hours that must elapse before the acknowledgement is
considered overdue.

AckTemplateKEY string 40 Acknowledgement build or break translation object used for this
functional group.

AckTransactionSet ID string 150 Acknowledgement generated for the functional group (inbound).

ControlNumber string 255 Value from the partner relationship used to generate the next
group control number.

NumberTransFrom
Group

number
(integer)

2 Number of transaction sets in the group.

TransControl
NumberFormat

number
(integer)

2 Format of the transaction control number.

TransSequence
CheckType

number
(integer)

2 Type of sequence checking used for transaction control numbering
in this group:

v 0 = None

v 1= Incremental

v 2 = Chronological

TransControl Number string 255 Transaction control number.
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Generic Envelope Segment Table
The Generic Envelope Segment Table (GenericEnvelopeSegment_tb) contains a
record for every envelope in the Sterling Gentran:Server system.

This table is used for custom enveloping to enable you to insert envelope
information into an interchange, group, or document. This table also provides the
translator with consistent access to envelope information. The translator creates a
record in the Generic Envelope Segment Table when an envelope is created. The
translator updates a record in the Generic Envelope Segment Table when the
corresponding record is updated. A record in the Generic Envelope Segment Table
is deleted by the translator when the envelope is deleted from the system.

Table 57. Generic Envelope Segment Table field information

Field Name Type Size Use

EnvelopeLevel number
(integer)

2 Reserved.

PartnerKEY string 25 Reserved.

Description string 40 Reserved.

Direction number
(integer)

2 Reserved.

ControlNumber string 255 Reserved.

Field1 through Field30 string 40 Reserved.

SubCountField string 18 Reserved.

ControlNumberLength number
(integer)

2 Reserved

Field31 through Field40 string 255 Reserved.

Interchange Control Table
The Interchange Control Table (InterchangeControl_tb) contains a record for every
interchange in the Sterling Gentran:Server system.

Partner Editor creates a record in the Interchange Control Table each time an
interchange definition is created. Each time a control number is received or
generated for an interchange, the translator updates the corresponding record in
the Interchange Control Table. Partner Editor deletes a record from the Interchange
Control Table when the corresponding interchange definition is deleted.

Table 58. Interchange Control Table field information

Field Name Type Size Use

PartnerKEY string 25 Unique identifier for the partner to which the interchange belongs.

Direction number
(integer)

2 Direction of the interchange:

v 0 = Inbound

v 1 = Outbound

InterchangeControl KEY string 40 Name of the interchange.

Agency number
(integer)

2 EDI standard used for this interchange.

Version string 13 Standard version used for this interchange.

TemplateKEY string 40 Partner-specific group build or break translation object used for
this interchange.
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Table 58. Interchange Control Table field information (continued)

Field Name Type Size Use

SegmentID string 10 Segment identification of the controlling segment of the
interchange (such as ISA, UNB, or STX).

AckExpected number
(integer)

2 Indicates that the system expects an acknowledgement to be
received from this trading partner as a result of your partner
receiving the interchange defined in the relationship (outbound).

HoursOverdue number
(integer)

2 Number of hours that must elapse before the acknowledgement is
considered overdue.

AckTemplateKEY string 40 Acknowledgement build or break translation object used for this
interchange.

AckTransactionSet ID string 150 Acknowledgement generated for the interchange (inbound).

ControlNumber string 255 Value from the partner relationship used to generate the next
interchange control number.

SequenceCheck Type number
(integer)

2 Type of sequence checking used for this interchange:

v 0 = None

v 1 = Incremental

v 2 = Chronological

v 3 = Duplicate

MsgContentType string 125 Used to format the Content Type field when creating a message
containing interchange data. Initialized to Application.

MsgContentSub Type string 125 Used to format the Content Sub Type field when creating a
message containing interchange data. Initialized to EDI.

MaxDocsperint number
(long)

4 Used by the translator to determine how many documents should
be included in an interchange. Initialized to 0 (unlimited
documents per interchange).

Mailbox string 125 Predefined communications setup used for inbound and outbound
processing.

EMailAddress string 125 Used to identify the message address if the selected Mailbox is an
exchange gateway.

Partner Table
The Partner Table (Partner_tb) contains a record for every partner profile in the
Sterling Gentran:Server system.

Partner Editor creates a record in the Partner Table each time a partner profile
definition is created. Each time a partner profile is changed, Partner Editor updates
the corresponding record in the Partner Table. Partner Editor deletes a record from
the Partner Table when the corresponding partner profile definition is deleted.

Table 59. Partner Table field information

Field Name Type Size Use

PartnerKEY string 25 Unique identifier for this partner.

EDICode string 255 EDI identifier used during inbound processing to select the correct
partner.

ApplicationPartner KEY string 255 Application identifier for this partner used during outbound
import processing to select the correct partner.
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Table 59. Partner Table field information (continued)

Field Name Type Size Use

IsSystem number
(integer)

2 Indicates whether this partner is the <Internal System User>
partner:

v 0 = Not the <Internal System User> partner

v 1 = <Internal System User> partner

PartnerName string 40 Unique name identifying this partner.

Mailbox string 125 Predefined communications setup used for inbound and outbound
processing.

EMailAddress string 125 Used to identify the message address if the selected Mailbox is an
exchange gateway.

Editing number
(integer)

2 A specific partner relationship is in the process of being edited:

v 0= Not edited

v 1= Currently being edited

Relationship Table
The Relationship Table (Relationship_tb) contains a record for every inbound or
outbound relationship in the Sterling Gentran:Server system.

Partner Editor creates a record in the Relationship Table each time an inbound or
outbound relationship definition is created. Each time an inbound or outbound
relationship definition is changed, Partner Editor updates the corresponding record
in the Relationship Table. Partner Editor deletes a record from the Relationship
Table when the corresponding inbound or outbound relationship definition is
deleted.

Table 60. Relationship Table field information

Field Name Type Size Use

PartnerKEY string 25 Unique identifier for the partner to which the relationship
belongs.

Direction number
(integer)

2 Direction of the relationship:

v 0 = Inbound

v 1 = Outbound

Agency number
(integer)

2 EDI standard used for this relationship.

Version string 13 Standard version for this relationship.

TransactionSetID string 150 Transaction set (message) used for this relationship.

Release number
(integer)

2 Message version release number used for this relationship.

TestMode number
(integer)

2 Indicates the partner relationship mode:

v 0 = Production

v 1 = Test

Description string 40 Name of the relationship.

ImportTemplate KEY string 40 Import translation object used with this relationship.

DataEntryTemplate KEY string 40 Screen entry translation object used with this relationship.

TurnAround
TemplateKEY

string 40 Turnaround translation object used with this relationship.

PrintTemplateKEY string 40 Print translation object used with this relationship.
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Table 60. Relationship Table field information (continued)

Field Name Type Size Use

Relationship
TemplateKEY

string 40 Relation translation object used in this relationship. This allows
you to alter the system behavior at the transaction and document
level. You can use partner-specific translation objects and/or
perform as many functions as required.

ExportTemplate KEY string 40 Export translation object used with this relationship.

ComplianceCheck
TemplateKEY

string 40 Translation object that is performing compliance checking.

ExportFileName string 130 File name to be created or appended to as result of the export
operation.

ExportToFlatFile Now number
(integer)

2 Indicates whether you want the export file created automatically
upon receipt of the document defined in this relationship:

v 0 = Do not export automatically

v 1 = Export automatically

TurnAroundNow number
(integer)

2 Indicates whether you want the defined turnaround process to be
executed automatically upon receipt of the document defined in
this relationship:

v 0 = Do not export automatically

v 1 = Turnaround automatically

SequenceCheck Type number
(integer)

2 Type of sequence checking used for the transaction set (message)
defined in this relationship:

v 0 = None

v 1 = Sequence Checking - Incremental

v 2 = Sequence Checking - Chronological

v 3 = Sequence Checking - Duplicate

v 256 = Duplicate Documents Checking Only

v 257 = Sequence Checking - Incremental + Duplicate Documents

v 258 = Sequence Checking - Chronological + Duplicate
Documents

v 259 = Sequence Checking - Duplicate + Duplicate Documents

SkipCompliance Check number
(integer)

2 Indicates whether compliance checking is performed:

v 0 = Do not compliance check

v 1 = Compliance check

AckErrors number
(integer)

2 Indicates whether the acknowledgement is generated with error
detail:

v 0 = No Error Detail

v 1 = With Error Detail

AckExpected number
(integer)

2 Indicates that the system expects an acknowledgement to be
received from this trading partner as a result of your partner
receiving the transaction set (message) defined in this relationship
(outbound).

HoursOverdue number
(integer)

2 Number of hours that must elapse before the acknowledgement is
considered overdue.

AckTemplateKEY string 40 Acknowledgement build or break translation object used for this
relationship.

AckTransactionSet ID string 150 Acknowledgement generated for the transaction set (inbound).

ApplicationKEY string 150 Application identifier that indicates the destination of the
document defined in this relationship.
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Table 60. Relationship Table field information (continued)

Field Name Type Size Use

Alias string 150 Criteria that aids the system in distinguishing this relationship
from other relationships.

FunctionalGroup
ControlKEY

string 20 Group control record in Partner Editor referring to this
relationship.

InterchangeControl KEY string 40 Interchange control record in Partner Editor referring to this
relationship.

ControlNumber string 255 Value from the partner relationship used to generate the next
transaction set control number.

ImmediateAck
Processing

number
(integer)

2 Indicates whether acknowledgement reconciliation will occur
during the inbound break session or during its scheduled
interval.

IsAcknowledgement number
(integer)

2 Indicates whether the transaction defined in this partner
relationship is an acknowledgement.

ExportToMailbox number
(integer)

2 Indicates whether the Export to Mailbox function is invoked,
allowing the output of an inbound translation to be delivered
back to the Mailbox Server Manager.

RecipientMailbox string 125 Mailbox to which the output of an inbound translation will be
delivered.

RecipientEMail Address string 125 E-mail address to which the output of an inbound translation will
be delivered.

ContentType string 255 Content type of the message containing the output of the
inbound translation.

ContentSubType string 255 Content sub type of the message containing the output of the
inbound translation.

Partner Reference Tables
The partner reference tables contain all the information in the reference tables that
were set up or imported in Partner Editor, regardless of whether a table is used for
a specific partner or the internal system user partner (used globally). The use of
partner-specific or internal system user tables is defined in the translation object
when the translation object is designed. The partner reference tables are the
following:
v Cross-Reference Table (CrossReference_tb)
v Location Table (Location_tb)
v Lookup Table (Lookup_tb)

Cross-Reference Table
The Cross-Reference Table (CrossReference_tb) contains a record for every
cross-reference table in the Sterling Gentran:Server system.

Cross-reference tables in Sterling Gentran:Server enable you to convert data you
enter before it is sent to your partner. Partner Editor creates a record in the
Cross-Reference Table each time a cross-reference table is created in Partner Editor.
Each time a cross-reference table is changed, Partner Editor updates the
corresponding record in the Cross-Reference Table. Partner Editor deletes a record
from the Cross-Reference Table when the corresponding cross-reference table is
deleted in Partner Editor.
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Table 61. Cross-Reference Table field information

Field Name Type Size Use

PartnerKEY string 25 Unique identifier for the partner to which the cross-reference table
belongs.

TableName string 8 Name of the table.

MyItem string 255 Your data value that corresponds to your partner's data value.

PartnerItem string 255 Your partner's data value that corresponds to your data value.

Description string 255 Description of the MyItem and PartnerItem codes.

Text1 through Text4 string 255 Field that can be mapped when it is associated with a specific
code value.

Lookup Table
The Lookup Table (Lookup_tb) contains a record for every lookup table in the
Sterling Gentran:Server system.

Lookup tables in Sterling Gentran:Server enable you to supplement data you enter
before it is sent to your partner. Partner Editor creates a record in the Lookup
Table each time a lookup table is created in Partner Editor. Each time a lookup
table is changed, Partner Editor updates the corresponding record in the Lookup
Table. Partner Editor deletes a record from the Lookup Table when the
corresponding lookup table is deleted in Partner Editor.

Table 62. Lookup Table field information

Field Name Type Size Use

PartnerKEY string 25 Unique identifier for the partner to which the lookup table
belongs.

TableName string 8 Name of the table.

Item string 255 Value that the system looks up in the data during inbound or
outbound processing.

Description string 255 Description of the MyItem and PartnerItem codes.

Text1 through Text 4 string 255 This field can be mapped when it is associated with a specific
code value.

Location Table
The Location Table (Location_tb) contains a record for every location table in the
Sterling Gentran:Server system.

Location tables in Sterling Gentran:Server enable you to insert names and
addresses into outbound data. Partner Editor creates a record in the Location Table
each time a location table is created in Partner Editor. Each time a location table is
changed, Partner Editor updates the corresponding record in the Location Table.
Partner Editor deletes a record from the Location Table when the corresponding
location table is deleted in Partner Editor.

Table 63. Location Table field information

Field Name Type Size Use

PartnerKEY string 25 Unique identifier for the partner to which the location table
belongs.

Name string 255 Name of the partner location.
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Table 63. Location Table field information (continued)

Field Name Type Size Use

PrimaryReference Code string 255 Primary reference code that the system uses to identify this
location.

SecondaryReference
Code

string 255 Secondary reference code that the system uses to identify this
location.

Address1 string 35 First line of the address.

Address2 string 35 Second line of the address.

Address3 string 35 Third line of the address.

City string 20 City for this location.

State string 10 State for this location.

Zip string 10 Country code for this location.

Country string 10 Zip or postal code for this location.

ContactName string 35 Name of a personal contact at this partner's office.

Telephone string 20 Telephone number.

Fax string 20 Fax number.

Audit and Notify Tables
The audit tables contain all the information in the Sterling Gentran:Server Audit
Log. The notify tables contain all the information in Notification.

The Audit Log contains a record for every significant event that occurs in the
system. The Audit Log is typically used to get information to help resolve a system
problem or to track a user's activities. The Notification subsystem enables you to
be proactively notified when an error is written to the Audit Log, by setting up
notification parameters.

The following are the audit and notify tables:
v Audit Component ID Table (AuditComponentID_tb)
v Audit Message Table (AuditMsg_tb)
v Audit Source ID Table (AuditSourceID_tb)
v Data Audit Log Table (DataAuditLog_tb)
v Data Audit Type Table (DataAuditType_tb)
v Notify Table (Notify_tb)
v Notify Action Table (NotifyAction_tb)
v Notify Log Table (NotifyLog_tb)
v Operators Table (Operators_tb)
v Proc Audit Log Table (ProcAuditLog_tb)

Audit Component ID Table
The Audit Component ID Table (AuditComponentID_tb) cross-references the
component IDs and their descriptions.
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Table 64. Audit Component ID Table field information

Field Name Type Size Use

SourceID number
(long)

4 Source ID of which the component is a part.

ComponentID number
(integer)

2 Functional area within the source that is generating the message.

ComponentID Name string 30 Textual description of the component ID (for example, Translator).

Audit Message Table
The Audit Message Table (AuditMsg_tb) contains a record for every Audit Log
error message.

Each message consists of the audit message number and the actual text of the
audit message.

Table 65. Audit Message Table field information

Field Name Type Size Use

SourceID number
(long)

4 Source ID of which the component is a part.

ComponentID number
(integer)

2 Functional area within the source that is generating the message.

MsgID number
(long)

4 Specific error generated by the Source/Component. In the range 1
– 65535.

Severity number
(integer)

2 Indicates the magnitude of the error:

v 1 = Error

v 2 = Warning

v 4 = Informational

AuditMsgType number
(integer)

2 Type of audit message (system or user defined).

MsgText string 255 Audit message text.

UserMsgText string 255 Text of the user-defined audit message.

SystemMsg number
(integer)

2 Indicates if the message is a system message.

WriteToAuditLog number
(integer)

2 Indicates if the message is written to the Audit Log.

WriteToEventLog number
(integer)

2 Indicates if the message is written to the Event Log.

Audit Source ID Table
The Audit Source ID Table (AuditSourceID_tb) cross-references the source IDs and
their descriptions.

Table 66. Audit Source ID Table field information

Field Name Type Size Use

SourceID number (long) 4 Source ID of the message.

SourceIDName string 30 Text description of the source ID.

Chapter 4. Database Tables 115



Data Audit Log Table
The Data Audit Log Table (DataAuditLog_tb) contains audit messages that indicate
system activity relating to specific data in the system.

Table 67. Data Audit Log Table field information

Field Name Type Size Use

AuditEntryKEY number
(long)

4 Uniquely identifies each audit entry, sequentially incremented.

DataAuditType number
(integer)

2 Numeric value that represents a data audit type.

DataAuditKEY string 50 Relates to the key of the table for which the audit is indicating
activity. For examle, DocumentKEY for document audits.

SourceID number
(long)

4 Source of the message.

ComponentID number
(integer)

2 Functional area within the source that is generating the message
(such as the ID representing the translator).

MsgID number
(long)

4 Specific error generated by the Source/Component. In the range 1
– 65535.

Severity number
(integer)

2 Indicates the magnitude of the error.

EventID number
(long)

4 Event ID to which the audit message belongs. Used to group audit
messages generated by related processing and

EventType number
(integer)

2 Type of event:

v 0 = undefined

v 1 = system event

v 2 = automated event (scheduler event)

v 3 = interactive event (user session)

v 4 = channel event

EventName string 50 Textual description of the event.

AuditDateTime datetime (for
SQL)

DATE (for
Oracle)

varies
by
DBMS

Date and time the audit log entry was created.

UserID string 255 Windows user ID associated with the application requesting the
audit log entry.

MachineName string 31 Name of the machine requesting the audit log entry.

Parm1 through Parm10 string 255 Parameter value that the program formatting the audit message
selects at run-time.

Restored number
(integer)

2 Indicates whether the entry was restored from archived data:

v 0 = non-restored

v 1 = restored

Data Audit Type Table
The Data Audit Type Table (DataAuditType_tb) cross-references the data audit
types with their description.
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Table 68. Data Audit Type Table field information

Field Name Type Size Use

DataAuditType number
(integer)

2 Numeric value that represents a data audit type. Initial values are:

v 0 = Processing

v 4 = Session

v 5 = Message

v 6 = Attachment

v 7 = PIP

DataAuditType Name string 30 Textual description of the data audit type.

Notify Table
The Notify Table (Notify_tb) contains a record for every set of notification
parameters defined in the Notification subsystem.

The parameters that you can specify to invoke client notification include an audit
message number and an action that the system performs.

Table 69. Notify Table field information

Field Name Type Size Use

NotifyName string 35 Unique name that identifies the notification definition.

NotifyEnabled number
(integer)

2 Indicates whether the Notification function is enabled.

SourceID number
(long)

4 Source ID of which the component is a part.

ComponentID number
(integer)

2 Functional area within the source that is generating the message.

MsgID number
(long)

4 Specific error generated by the Source/Component. In the range 1
– 65535.

Severity number
(integer)

2 Indicates the magnitude of the error.

IncludeErrorMsg number
(integer)

2 Indicates whether this error message is included in the notification.

AlphaNotifyText string 255 Additional notification message to be sent to the operator.

NumPagerRespType number
(integer)

2 Indicates whether the notification is a numeric page or a text
message.

NumNotifyText string 255 Text of a message-based page.

Notify Action Table
The Notify Action Table (NotifyAction_tb) contains information about notification
actions.

Table 70. Notify Action Table field information

Field Name Type Size Use

NotifyName string 35 Unique name which identifies the notification definition.
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Table 70. Notify Action Table field information (continued)

Field Name Type Size Use

NotifyAction number
(integer)

2 Type of action the notification takes:

v 0 = operator alert

v 1 = operator e-mail

v 2 = operator page

v 5 = scheduler event

v 6 = task

v 7 = stored procedure

NotifyOperatorID string 255 Windows user ID of the operator defined in the operator table,
who receives the notification.

TaskName string 255 Name of the scheduler event to be initiated as a result of the
notification.

Notify Log Table
The Notify Log Table (NotifyLog_tb) contains information about the notification
log.

Table 71. Notify Log Table field information

Field Name Type Size Use

NotifyEntryKEY number (long) 4 Unique value that identifies each notification log entry.

NotifyName string 35 Unique name identifying the notification definition.

NotifyAction number
(integer)

2 Type of action the notification takes.

0 = operator alert

1 = operator E-mail

2 = operator page

5 = scheduler event

6 = task

7 = stored procedure

NotifyOperator string 255 Windows user ID of the operator who receives the notification.

NotifyMsgText string 255 Text of the notification message.

AuditEntryKEY number (long) 4 Relates to the key of the table for which the audit is indicating
activity.

AuditMsgType number
(integer)

2 Type of audit message:

3 = external data

DataAuditKEY string 50 Source of the audit message.
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Table 71. Notify Log Table field information (continued)

Field Name Type Size Use

SourceID number (long) 4 Type of action the notification takes:

0 = operator alert

1 = operator E-mail

2 = operator page

5 = scheduler event

6 = task

7 = stored procedure

ComponentID number
(integer)

2 Windows user ID of the operator defined in the operator table
who receives the notification.

MsgID number (long) 4 Type of action the notification takes:

0 = operator alert

1 = operator E-mail

2 = operator page

5 = scheduler event

6 = task

7 = stored procedure

EventID number (long) 4 Event ID to which the audit message belongs. Used to group
audit messages generated by related processing.

EventType number
(integer)

2 Type of event.

v 0 = undefined

v 1 = system event

v 2 = automated event (scheduler event)

v 3 = interactive event (user session)

v 4 = mailbox event

EventName string 50 Textual description of the event.

AuditDateTime datetime (for
SQL)

DATE (for
Oracle)

varies
by
DBMS

Date and time the audit log entry was created.

NotifyDateTime datetime 8 Date and time the notification log was written.

UserID string 255 Windows user ID associated with the application requesting the
audit log entry.

MachineName string 31 Name of the machine requesting the audit log entry.

Parm1 through Parm10 string 255 Parameter value that the program formatting the audit message
selects at run-time.

Operators Table
The Operators Table (Operators_tb) contains information about Windows users
configured to receive notifications.
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Table 72. Operators Table field information

Field Name Type Size Use

NotifyOperatorID string 255 Windows user ID of the operator who is to receive the e-mail,
page, or alert notification.

OperatorName string 255 Expanded operator name or descriptive text.

EmailAddress string 255 E-mail address where the notification is sent.

PagerType number
(integer)

2 Type of pager:

v 0 = numeric pager

v 1 = alpha pager

PagerAddress string 255 Numeric pager number or alpha pager e-mail address.

Proc Audit Log Table
The Proc Audit Log Table (ProcAuditLog_tb) contains audit messages that indicate
system-processing activity.

Table 73. Proc Audit Log Table field information

Field Name Type Size Use

AuditEntryKEY number
(long)

4 Number that increments sequentially and uniquely identifies each
audit entry.

SourceID number
(long)

4 Source of the message.

ComponentID number
(integer)

2 Functional area within the source that is generating the message
(such as the ID representing the translator).

0 = the message may be generated by all components within the
source

MsgID number
(long)

4 Specific error generated by the Source/Component, in the range 1
– 65535.

Severity number
(integer)

2 Indicates the magnitude of the error.

EventID number
(long)

4 Event ID to which the audit message belongs. Used to group
audit messages generated by related processing.

EventType number
(integer)

2 Type of Event:

v 0 = Unspecified

v 1 = System Event

v 2 = Automated Event (Process Control Event)

v 3 = Interactive Event (User Session)

v 4 = Mailbox Event

EventName string 50 Textual description of the event.

For Process Control Events, this would be the Event Name. For
User Sessions, this would be the User Name. For System Session,
the calling function supplies the name, such as "Overdue Check."

AuditDateTime datetime (for
SQL)

DATE (for
Oracle)

varies
by
DBMS

Date and time the audit log entry was created.

UserID string 255 Windows user ID associated with the application requesting the
audit log entry.
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Table 73. Proc Audit Log Table field information (continued)

Field Name Type Size Use

MachineName string 31 Name of the machine requesting the audit log entry.

Parm1 through Parm10 string 255 Parameter value that the program formatting the audit message
selects at run-time.

Restored number
(integer)

2 Indicates whether the entry was restored from archived data.

v 0 = non-restored

v 1 = restored

Mailbox Tables
The Mailbox tables contain all the information in the Sterling Gentran:Server
Mailbox subsystem.

The following are the mailbox tables:
v AddressBook Table (AddressBook_tb)
v Attachment Table (Attachment_tb)
v DeliveryRule Table (DeliveryRule_tb)
v DistributionList Table (DistributionList_tb)
v File Table (File_tb)
v Mailbox Table (Mailbox_tb)
v Mailbox Configuration Table (MailboxConfig_tb)
v Message Table (Message_tb)
v Recipient Table (Recipient_tb)
v SpoolQueue Table (SpoolQueue_tb)

AddressBook Table
The AddressBook Table (AddressBook_tb) contains a record for the name of every
distribution list.

Table 74. AddressBook Table field information

Field Name Type Size Use

ListId number (long) 4 List identifier.

Name string 125 Name of the distribution list.

Attachment Table
The Attachment Table (Attachment_tb) contains a record for the Mailbox
attachment information, including file name, content type, size, identifier, and the
identifier of the message to which the attachment belongs.

Table 75. Attachment Table field information

Field Name Type Size Use

MessageId number
(long)

4 Identifier of the message to which the attachment belongs.

AttachmentId number
(long)

4 Identifier of the attachment.

ContentType string 125 Content type of the attachment.
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Table 75. Attachment Table field information (continued)

Field Name Type Size Use

ContentSubType string 125 Content subtype of the attachment.

ContentSize number
(long)

4 Size of the attachment.

File string 255 File name of the attachment.

StoreFile string 255 Name of the attachment file in the message store.

Flags number
(long)

4 User-defined flags.

DeliveryRule Table
The DeliveryRule Table (DeliveryRule_tb) contains a record for all the delivery
rules that are currently set up in the system.

Each rule is associated with a sender and/or receiver, optional content type, and a
delivery agent. The rules are sequences so that you can specify the order in which
they are executed.

Table 76. DeliveryRule Table field information

Field Name Type Size Use

Extension string 125 Name of the delivery agent to use.

SenderId number
(long)

4 Identifier of the sender with which the rule is associated.

SenderEMailAddr string 125 The Sterling Gentran:Server e-mail address of the sender.

RecipientId number
(long)

4 Identifier of the recipient with which the rule is associated.

RecipientGateway
EmailAddr

string 125 Gateway e-mail address of the recipient.

ContentType string 125 Content type of the delivery rule.

ContentSubType string 125 Content subtype of the delivery rule.

TransferPoint number
(long)

4 Indicates whether the rule is run when sending or receiving.

Sequence number
(long)

4 The sequence in which the delivery rules are executed.

CommandLine string 255 Parameter for the delivery agent.

Comment string 255 Name of the delivery rule.

DistributionList Table
The DistributionList Table (DistributionList_tb) stores the mailbox entries that
belong to the distribution lists.

Table 77. DistributionList Table field information

Field Name Type Size Use

ListId number (long) 4 Identifier of the distribution list.

RecipientId number (long) 4 Identifier of the recipient.

RecipientGateway EMailAddr string 125 Gateway e-mail address of the recipient.
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File Table
The File Table (File_tb) contains a record for every file currently in the system.

Each file in this table corresponds to one or more attachments, and is reference
counted. If an attachment which is sharing the file with a second attachment is
modified, the system automatically creates a new copy of the file for the modified
attachment.

Table 78. File Table field information

Field Name Type Size Use

StoreFile string 255 Name of the attachment file in the message store.

ReferenceCount number
(long)

4 The count of how many attachments use this file.

Mailbox Table
The Mailbox Table (Mailbox_tb) contains a record for every mailbox in the Sterling
Gentran:Server system.

Table 79. Mailbox Table field information

Field Name Type Size Use

MailboxId number
(long)

4 Identifier for the mailbox.

EMailAddr string 125 E-mail address of the mailbox.

Name string 125 Name of the mailbox.

Gateway string 125 Name of the gateway associated with this mailbox (if any).

Flags number
(long)

4 Attributes of the mailbox.

Mailbox Configuration Table
The Mailbox Configuration Table (MailboxConfig_tb) contains the Sterling
Gentran:Server mailbox configuration parameters.

Table 80. Mailbox Configuration Table field information

Field Name Type Size Use

Content string 255 The Internet media type for the information being transmitted.
The content type determines the mechanism to use to display the
data.

SubContent string 255 Subcontent type of the message (EDI, Document-EDI, or Import).

Action number
(long)

4 The action that the system performs on messages of the
previously defined content and subcontent types
(GDW_Process_MBFile, GDW_Import, or GDW_MBImport).
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Message Table
The Message Table (Message_tb) contains a record for every message in the system.

Table 81. Message Table field information

Field Name Type Size Use

MessageId number
(long)

4 Identifier of the message.

MailboxId number
(long)

4 Identifier of the mailbox.

FolderId number
(long)

4 Identifier of the folder where the message resides. Possible folder:

v 1 = InBox

v 2 = OutBox

v 3 = Trash

v 4 = Spooler

SenderId number
(long)

4 Identifier of the message sender.

SenderEMailAddr string 125 E-mail address of the message sender.

SentRepresenting string 125 Name of the person (if any) for which the message is sent.

ReceiverType number
(long)

4 Type of receiver (such as TO, CC, or BCC).

ReceiverId number
(long)

4 Identifier of the message receiver.

ReceiverGateway
EMailAddr

string 125 Gateway e-mail address of the receiver.

Subject string 125 Subject of the message.

ContentType string 125 Content type of the message.

ContentSubType string 125 Content subtype of the message.

CreationTime datetime (for
SQL)

DATE (for
Oracle)

varies
by
DBMS

Time the message was created.

SubmissionTime datetime (for
SQL)

DATE (for
Oracle)

varies
by
DBMS

Time the message was submitted.

SentTime datetime (for
SQL)

DATE (for
Oracle)

varies
by
DBMS

Time the message was sent.

OriginalId number
(long)

4 Identifier of the message for which this message was copied.

OriginalFolderId number
(long)

4 The folder this message was in before it was moved to the trash.
Possible folder:

v 1 = InBox

v 2 = OutBox

v 3 = Trash

v 4 = Spooler
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Table 81. Message Table field information (continued)

Field Name Type Size Use

Flags number
(long)

4 Attributes of the message.

Status number
(long)

4 Status of the message. Possible status:

v 1 = Ready to Send

v 2 = Incomplete

v 3 = Queued

v 4 = Sending

v 5 = InGateway

v 6 = Sent

v 7 = Read

v 8 = Unread

v 9 = Deleted

v 10= SEND_FAILED

v 11= DELIVERED

v 12= PICKED_UP

v 13= SENT_THIRD_PARTY

v 14= DELIVERY_FAILED

SessionId string 125 Session identifier.

SeriesId string 125 Series identifier.

Recipient Table
The Recipient Table (Recipient_tb) associates messages with one or more recipients
(mailboxes or distribution lists).

Table 82. Recipient Table field information

Field Name Type Size Use

MessageId number
(long)

4 Identifier of the message.

RecipientType number
(long)

4 Type of recipient (such as TO, CC, or BCC).

RecipientId number
(long)

4 Identifier of the recipient.

RecipientGateway
EMailAddr

string 125 The gateway e-mail address of the recipient.

AddressBookType number
(long)

4 Address book type (such as mailbox or distribution list).

RecipientStatus number
(long)

4 Message status for each message recipient.

SentTime datetime (for
SQL)

DATE (for
Oracle)

varies
by
DBMS

The time when the message reached the recipient.
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SpoolQueue Table
The SpoolQueue Table (SpoolQueue_tb) contains a record for every message that is
waiting to be delivered by the system.

It is a persistent queue of messages that only contains valid information when the
system is not running. The function of this table is to allow the spooler to suspend
and restart correctly if the system is stopped while there are still messages waiting
to be delivered.

Table 83. SpoolQueue Table field information

Field Name Type Size Use

MessageId number
(long)

4 Identifier for the message.

Sequence number
(long)

4 Sequence of the messages waiting to be delivered.

AuditEventId number
(long)

4 Audit event identifier.
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Chapter 5. Operational Troubleshooting

About the Service Control Manager
You can use the Windows Service Control Manager to start and stop the Sterling
Gentran:Server Executive or any other Windows system service. You can also use
the Service Control Manager to change service parameters that are not accessible
on the Controllers tab of the System Configuration program.

For example, you can change the Sterling Gentran:Server Executive startup type
from manual to automatic (service starts every time Windows starts). Additionally,
you can control which user account the Sterling Gentran:Server Executive Service
uses to log on. The Sterling Gentran:Server Executive does not allow you to
configure startup parameters.

Note: Use the System Configuration program to start and stop the Sterling
Gentran:Server Executive and to set up the Sterling Gentran:Server Executive to
start manually. However, you can use the Service Control Manager if the System
Configuration program is not accessible.

You can typically access the Service Control Manager by selecting Settings >
Control Panel from the Windows Start menu and then double-clicking the Services
program icon in the Control Panel program group (in the Main program group).

About Troubleshooting Sterling Gentran:Server
If you review the Windows Application Event Log for Sterling Gentran:Server
periodically, you may be able to identify problems so that errors can be detected
and corrected before impacting future processing.

The information that Sterling Gentran:Server writes to the Application Event Log
may be useful in diagnosing a hardware or software problem.

The Sterling Gentran:Server Audit Log contains an audit record for every
significant event that occurs in the system. You should view the Audit Log on a
periodic basis to get information to help resolve a system problem or to track a
user's activities.

Common Problems
The following table contains some common Sterling Gentran:Server problems and
the steps you should take to resolve them:

Table 84. Common Sterling Gentran:Server Problems

Problem Resolution

Some users can view documents,
partners, process control events in the
Sterling Gentran:Server browsers but
some do not see them.

This may be because the ODBC DSN for the
system is not pointing to the correct database.
Verify that the ODBC DSN points to the correct
database.
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Table 84. Common Sterling Gentran:Server Problems (continued)

Problem Resolution

A user can log on to Sterling
Gentran:Server from some user interface
clients in the system but not from others.

This may be because there are two Sterling
Gentran:Server systems set up that have the
same DSN. Verify if this is the case in ODBC. If
so, change the name of one of the DSNs.

A user tries to log on to Sterling
Gentran:Server but receives a message
stating Gentran:Server system [system
name] is not currently running.

Check that your primary system controller is
turned on. Start the Sterling Gentran:Server
Executive Service.

See Starting the System for more information on
starting Sterling Gentran:Server.

A user tries to log on to Sterling
Gentran:Server but receive a message
that the User Name cannot be found.

If you are running Sterling Gentran:Server in
integrated security mode, the user's Sterling
Gentran:Server User Name does not match their
Windows User ID.

Either change the Windows User ID to match
the Sterling Gentran:Server User Name (see
Windows documentation for more information)
or change the Sterling Gentran:Server User
Name to match the Windows User ID.

See Changing a User's Security Access for more
information.

An event fails to run. v If the event that failed to run is a polled
event, check that the Sterling Gentran:Server
Poller is running on the controller specified in
the event. If the Sterling Gentran:Server Poller
is stopped, start it. See Starting the System for
more information.

v If the event that failed to run is a scheduled
event, check that the Sterling Gentran:Server
Scheduler is running on the controller
specified in the event. If the Sterling
Gentran:Server Scheduler is stopped, start it.
See Starting the System for more information.

v Verify that the controller that is specified in
the event is correct (the Sterling
Gentran:Server Poller/Sterling Gentran:Server
Scheduler is installed on that machine).
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Table 84. Common Sterling Gentran:Server Problems (continued)

Problem Resolution

When a user logs on to Sterling
Gentran:Server, they are prompted to log
on to the database.

Verify that the security mode in which you are
running Sterling Gentran:Server is the same as
the security mode of your database. If the
security modes are different, either change your
Sterling Gentran:Server security mode or change
your database security mode.

See System Configuration Security Tab or your
RDBMS documentation for more information.

Verify that the user's Sterling Gentran:Server
User ID and Password match the user's
database User ID and Password. If they do not
match, either change the database User ID and
Password or change the Sterling Gentran:Server
User ID and Password.

See your RDBMS documentation or Changing a
User's Security Access for more information.

A user is prompted to log on to the
database when they attempt to execute a
Sterling Gentran:Server subordinate
process (such as send or receive).

Verify that the security mode in which you are
running Sterling Gentran:Server is the same as
the security mode of your database. If the
security modes are different, either change your
Sterling Gentran:Server security mode or change
your database security mode.

See System Configuration Security Tab or your
RDBMS documentation for more information.

Verify that the user's Sterling Gentran:Server
User ID and Password match the user's
database User ID and Password. If they do not
match, either change the database User ID and
Password or change the Sterling Gentran:Server
User ID and Password.

See your RDBMS documentation or Changing a
User's Security Access for more information.

You are unable to start the Sterling
Gentran:Server Executive Service on
other machines.

Verify that you have Windows administrative
rights on those machines.

See your Windows documentation for more
information.
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Chapter 6. Process Control Session Setup

Process Control
Process Control is a system feature that enables you to initiate process functionality
of Sterling Gentran:Server.

These functions include:
v importing data from your application files (including TDF)
v exporting data to your application files (including TDF)
v sending
v receiving

In addition, file and process management functions can be executed that provide
additional flexibility in integrating your application with Sterling Gentran:Server.

Process Control can be executed in two ways: automatically and manually.

You can execute the processor automatically by using Process Control to create a
Session File comprised of commands with appropriate parameters, and then create
an event to process the session. Alternately, you can create a Session File by using
a text editor (such as Notepad) or copying and modifying an existing Session File.
Process Control then executes the Session File by running the UNATTEND.EXE
program at the appropriate time.

You can also execute the processor manually by creating a Session File in one of
the following ways:
v Using Process Control to create a Session File
v Using a text editor (such as Notepad)
v Copying and modifying an existing Session File

You can then execute the UNATTEND.EXE program (with a parameter that
contains the name of a Session File) from a command line or user program.
unattend.exe <session_name> -e <event_ID>

Session Files
Whether you execute Process Control automatically or manually, the Session File
contains commands that execute different Sterling Gentran:Server functions (such
as sending, receiving, or importing).

When you execute Process Control manually, you can specify a full path for the
Session File. If you do not specify a path, the processor searches for the specified
filename in the Unattend subfolder (defined in the System Configuration program).

If a filename with an extension is specified (regardless of whether the extension is
.SES or not), the processor searches for that filename. If the Process Control
program is initiated with a filename that does not include an extension, the
processor searches for that filename with an .SES extension.
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If Process Control is initiated without a Session File name, the program terminates
execution and writes an audit message to the Sterling Gentran:Server Audit Log.

Session File Layout
When you create a Session File automatically or manually with a text editor, you
must include all necessary records, commands, command parameters, conditions,
condition parameters, and condition results.

A Session File is an ASCII delimited file (each record except the last one must end
with a carriage return or line feed) that contains the following types of records:
v Record 1: Signature Version Record
v Record 2: Number of Script Commands Record
v Records 3 through n: Script Command Records

The first record in the Session File is the Signature Version Record. This record is
used to determine if the file is a valid Session File. This record is created
automatically if you use Process Control to create the Session File. If you create the
Session File manually, you need to add this record.

This record is used to determine which version of the Sterling Gentran:Server
software created the file (if the Session File was created automatically) or the
version of Sterling Gentran:Server for which the Session File is used (if the Session
File was created manually). The version information is used if conversions are
needed with subsequent releases of Sterling Gentran:Server.

The format of the Signature Version Record is "GDW-Session","Version 2.0"

Process Control validates the signature (GDW-Session), and then loads the
specified version into a variable for future use.

The second record in the Session File contains the number of script commands. If
you used the Process Control to create the Session File automatically, the system
automatically counts the number of command records and creates this record. If
you create the Session File manually, you need to count the total number of
command records and add that number to this record.

Script Command Records
The third though n records in the Session File are the Script Command Records.
Each command has associated parameters. Each command may also have an
optional associated condition, with a condition parameter and a condition result.

The format of the Script Command Record is:
"Command Name","Command Parameter 1","Command Parameter 2", "Command Parameter 3",
"Command Parameter 4","Command Parameter 5","Command Parameter 6","Condition",
"Condition Parameter","Condition Result"

When you use Process Control to create the Session File automatically, you can
select commands from the Select Script Command list on the Command Setup
dialog. This list allows you to select which script command you want to add to the
script.

Important: If you create the Session File manually, you should verify that all
commands, command parameters, conditions, condition parameters, and condition
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results are enclosed in quotes. If a command parameter, condition, condition
parameter, or condition result is not used, you must specify that option as "" (two
double quotes) in the Session File.

Command Name

When you create the Session File manually, you need to add each command record
to the file. The values for Command Name that can be used when creating the
Session File automatically or manually are listed in the following table.

Table 85. Commands and Corresponding Actions

Command Action

Exec_Program Indicates a program for the system to run.

Exec_Program_Ex Indicates a program for the system to run and for which the system will pass
the Event ID and controller name.
Note: This function is used by the Sterling Gentran:Server for RosettaNet
install program.

File_Copy Copies a file.

File_Rename Changes the name of a file.

File_Delete Removes a file from the system.

GDW_Archive Performs the archive command according to the specifications of a selected
archive definition file.

GDW_Audit_Rpt Copies the audit records to a specified file.

GDW_Audit_Purge Deletes all audit records in the system.

GDW_Audit_Write Writes a processing user audit message to the Audit Log, based on the
specified parameters.

GDW_Document_ Purge Removes document records from the Sterling Gentran:Server database
according to the specified age/date, location, partner name, transaction,
and/or status.

GDW_Document_Rpt Creates a specified file that contains document data (as well as group and
interchange data, if applicable) for documents in the Sterling Gentran:Server
database according to the specified status, location, and/or age/date.

GDW_Export Performs the Export function.
Note: You must have an export translation object registered with the system.

GDW_ExtData_Delete Deletes external data references based on the action taken on the external data
and/or age.

GDW_Import Performs the Import function from a specified file.
Note: You must have an import translation object registered with the system.

GDW_Notify_Purge Deletes all notifications records in the system or deletes them by age, if
specified.

GDW_OutboundRecovery Defines the time for the outbound recovery process to run each day.

GDW_Partner_Delete Executes the partner delete command.

GDW_Partner_Import Executes the partner import command.

GDW_Partner_Export Executes the partner export command.

GDW_Print Performs the Print function.
Note: You must have a print translation object registered with the system.

GDW_Process_File Invokes the post-communications process with any EDI file, as if the file was
received via a communication session.
Note: You must have an export translation object registered with the system.

GDW_Receive Performs the Receive Only function of the Comm Gateway.
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Table 85. Commands and Corresponding Actions (continued)

Command Action

GDW_Send_Receive Performs the Send/Receive function of the Comm Gateway. This function
does not wait for previously executed Send/Receive sessions to finish; it
executes the Send/Receive when you specify.

Terminate_Script Terminates the script.

Command Parameters

The values for Command Parameters 1 through 6 vary depending on the
Command Name. Command Parameters are defined in detail for each command
name in the Process Control Commands. If a command parameter is not used, you
must specify that option as "" (two double quotes) in the Session File.

Conditions

Each script command can have an optional associated Condition. These conditions
are evaluated just prior to the execution of the command and can be used to
control the process flow of your session.

Two types of conditions can be specified. First, the system can query for the
presence or absence of a specific file. Second, the system can determine whether or
not documents exist in a specific location (such as Out Documents).

If a condition is not used, you must specify the condition, the condition parameter,
and the condition result as "" (two double quotes) in the Session File.

Table 86. Conditions to choose from

IF the condition is... THEN it indicates that...

If File Below Exists the system must look for the file you specify and then execute the command
based on whether the file is found or not found.

If Docs Are In the Location Below the system must look for the documents in the location you specify and then
execute the command based on whether or not the documents are found in
that location.

Condition Parameters

If you use a condition, you must specify a Condition Parameter. The Condition
Parameter for the If File Below Exists condition is the name of the file that the
system must try to find. If a filename is specified without a path, the processor
searches for that filename in the folder in which Sterling Gentran:Server is installed
on the machine. The Condition Parameter for the If Docs Are In Location Below
condition is a Sterling Gentran:Server location (such as In Documents, ?In
Documents, Out Documents, or ?Out Documents).

Tip: Use a wildcard (*) to specify the name of the file for which you want the
system to check.

Condition Result

If you use a condition, you must specify a Condition Result. The Condition Result
values are as follows:
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v If the evaluated condition is True, the command should only be executed if the
specific document or file is present.

v If the condition is False, the command should be executed only if the specific
document or file does not exist. In this instance, the command is skipped and
processing continues with the next defined command.
For example, you might not want to initiate a GDW_Send_Receive command if
there are no documents in the Out Documents, or you might want to execute a
notification program if received documents are routed to the ?In Documents.

Sample Session File

The following is an example of a sample Session File:

In this example, the indented lines indicate a continuation of the previous record.
"GDW_Session","Version 2.0"
4
"GDW_Import","remit.txt","","","","","","If File Below
Exists","c:\GENSRVNT\imports\remit.txt","True"
"GDW_Send_Receive","","SendToPtr","820","","","","If Docs Are In
Location Below","Out Documents","True"
"GDW_Export","invoice.dat","","","","","","If Docs Are In Location
Below","In Documents","True"
"GDW_Document_Rpt","c:\GENSRVNT\docrpt.txt","","","2","","","","",
""

Process Control Commands
The following topics describe the process control commands alphabetically by
command name, including a table that defines the parameters for each command,
whether or not they are required, and what to type for each parameter.

Notes:

v An asterisk (*) before a command parameter number denotes that the parameter
is mandatory (must be included).

v A double asterisk (**) before a command parameter number denotes that the
marked parameter is one of two parameters that are mutually exclusive.

v A triple asterisk (***) before a command parameter number denotes that the
marked parameter is one of two parameters of which one is required but both
can be used.

Process Control writes to the Session File any parameters you do not use as "" (two
double quotes).

Important: If you create the Session File manually, you should verify that all
commands, command parameters, conditions, condition parameters, and condition
results are enclosed in quotes. If a command parameter, condition, condition
parameter, or condition result is not used, you must specify that option as "" (two
double quotes) in the Session File.

Exec_Program
The Exec_Program command allows you to run a specified program during the
process control session. You can also specify any command line arguments that are
necessary for the execution of the program.
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Session execution does not continue until the program completes. This command
can be used to integrate Sterling Gentran:Server with your application. For
example, this command could be used to invoke your own program at the start of
an outbound session to create an import file from your database. Or, at the end of
an inbound session, you might want to invoke your own program to update your
databases with exported data.

When this command is executed, the system writes an informational message to
the Audit Log indicating which program (command line in working directory) was
run.

Table 87. Command parameters for EXEC_Program

Number
Command
Parameter What to Type

*1 Execute Program "Type the name of the program that you want the system to run and any
command line arguments that are required for the program execution."

2 Working Directory "Specify the name of the working folder the system should use when executing
the program. The working folder is not mandatory. However, if you do not
specify a working folder, the system defaults to the current folder at the time of
execution. This can cause unpredictable results in programs that assume
information is available in specific folder paths."

3 ""

4 ""

5 ""

6 ""

Exec_Program_Ex
The Exec_Program_Ex command is used by the Sterling Gentran:Server for
RosettaNet install program. When used from the command line, it indicates a
program for the system to run and for which the system will pass the Event ID
and controller name.

This function is used by the Sterling Gentran:Server for RosettaNet install program.

Table 88. Command parameters for EXEC_Program_Ex

Number Command Parameter What to Type

*1 Execute Program "Type the name of the program you want the system to run and any command
line arguments that are required for the program execution."

2 Working Directory "Specify the name of the working folder the system should use when executing
the program. The working folder is not mandatory. However, if you do not
specify a working folder, the system defaults to the current folder at the time of
execution. This can cause unpredictable results in programs that assume
information is available in specific folder paths."

3 ""

4 ""

5 ""

6 ""
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File_Copy
The File_Copy command allows you to copy a file. If the target filename exists, a
concatenation operation is performed.

The folder where Sterling Gentran:Server is installed on the machine is used if you
do not specify a file path.

When this command is executed, the system writes an informational message to
the Audit Log that indicates that the file copy was successful.

Table 89. Command parameters for File_Copy

Number Command Parameter What to Type

*1 Source File "Type the name of the file you want to copy."

*2 Target File "Type the name of a file to which you want the system to copy the specified file."

3 ""

4 ""

5 ""

6 ""

File_Delete
The File_Delete command allows you to remove a file from the system.

The folder where Sterling Gentran:Server is installed on the machine is used if you
do not specify a file path.

When this command is executed, the system writes an informational message to
the Audit Log indicating that the deletion of the file was successful.

Table 90. Command parameters for File_Delete

Number Command Parameter What to Type

*1 File Name "Type the name of the file you want to remove from the system."

2 ""

3 ""

4 ""

5 ""

6 ""

File_Rename
The File_Rename command allows you to change the name of a file. If the name
you are changing to already exists, the rename operation fails.

The folder where Sterling Gentran:Server is installed on the machine is used if you
do not specify a file path.
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Table 91. Command parameters for File_Rename

Number Command Parameter What to Type

*1 Source File "Type the name of the file you want to rename."

*2 Target File "Type the new name of the file."

3 ""

4 ""

5 ""

6 ""

GDW_Archive
The GDW_Archive command performs the Sterling Gentran:Server archive
command according to the specifications of a selected archive definition file.

Table 92. Command parameters for GDW_Archive

Number Command Parameter What to Type

1 Archive Type "Select the type of archive file (such as EDI, External Data, or Mailbox)."

2 Archive Definition "Type the name of the archive definition (*.ARD) file."

3 ""

4 ""

5 ""

6 ""

GDW_Audit_Purge
The GDW_Audit_Purge command deletes all audit records in the system and
resets the SystemAuditNextEntry value in the database tables program to zero.

There are no applicable parameters for this command.

Table 93. Command parameters for GDW_Audit_Purge

Number
Command
Parameter What to Type

1 Date/Age of Audits "Type either the date (in mm/dd/yyyy format) for which you want the system to
purge audit records or the age (in number of days) for which you want the
system to purge audit records. For example, an age of "0" indicates that only the
current day's information will be retained and all older information will be
deleted. An age of "1" indicates that the current and previous days' information
will be retained and all older information will be deleted."

2 File Name "Type the name of the audit report file to which the system will print the audit
records before purging them."

3 ""

4 ""

5 ""

6 ""
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GDW_Audit_Rpt
The GDW_Audit_Rpt command copies the designated number of audit records to
a specified file.

The records in the Audit Log are listed in the order of the most recent to the
oldest. The folder where Sterling Gentran:Server is installed on the machine is used
for the Audit Report File Name if you do not specify a path. If the specified file
already exists, the program appends the new audit report data to the end of the
existing file.

Command Parameter 2 (Number of Audit Records to Report) is used as follows:
v If you do not specify Command Parameter 2, or this parameter is set to zero, all

records in the audit file are copied to the file specified in Command Parameter 1
(Audit Report File Name).

v If you do specify a number of audit records in Command Parameter 2, the
number of records that the system copies to the file specified in Command
Parameter 1 varies depending on the number of audit file records.
– If the number of records in the audit file is less that the number specified in

Command Parameter 2, the system copies all audit file records to the
specified file.

– If there are more records in the audit file than the number specified in
Command Parameter 2, the system copies only the specified number of
records to the file.

The database tables contain an AuditMaxEntries value that specifies the number of
audit records. If you specify more audit records for Command Parameter 2 than
the AuditMaxEntries allows, all audit file records are copied.

Table 94. Command parameters for GDW_Audit_Rpt

Number Command Parameter What to Type

*1 File Name "Type the name of the Audit Report File that is created."

2 Number of Records "Type the number of audit file records you want to copy to the specified file."

3 Date/Age of Audits "Type either the date (in mm/dd/yyyy format) for which you want the system
to print audit records to a file or the age (in number of days) for which you
want the system to print audit records. For example, an age of "0" indicates that
only the current day's information will be printed to file. An age of "1" indicates
that the current and previous days' information will be printed."

4 ""

5 ""

6 ""

GDW_Audit_Write
The GDW_Audit_Write command writes a processing user audit message to the
Audit Log, based on the specified parameters.

Table 95. Command paramters for GDW_Audit_Write

Number Command Parameter What to Type

1 Message ID "Type the message identifier for the audit number. For example, if the audit
number is "99-99-1000," type "1000" in this box."
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Table 95. Command paramters for GDW_Audit_Write (continued)

Number Command Parameter What to Type

2 Parameters "Type the message parameters (up to six), delimited with commas. "

3 ""

4 ""

5 ""

6 ""

GDW_Document_Purge
The GDW_Document_Purge command enables the user to remove document
records from the Sterling Gentran:Server database according to the specified
age/date, location, and/or status. If the system determines that it has purged the
last document in a group or interchange, it also deletes the group database record
and/or interchange database record.

None of the three parameters are required. If Command Parameter 1 (Document
Location) is not used, the documents in all locations are purged. If Command
Parameter 2 (Document Status) is not used, the documents are purged regardless
of status. If Command Parameter 3 (Document Age or Date) is not used, the
documents are purged regardless of age or date.

If Command Parameter 3 is used, you can specify either an age (number of days)
or a date. If an age is specified, all documents greater than or equal to the
specified number of days are purged. Zero indicates that all documents are
purged, including today's documents. One indicates that all documents except
today's documents are purged. If a date is specified, all documents created on that
day are purged. Dates are specified in YYYY/MM/DD format (four-digit year,
separator, two-digit month, separator, and two-digit day).

Important: If you do not specify any of the three parameters, all documents are
deleted.

Table 96. Command parameters for GDW_Document_Purge

Number
Command
Parameter What to Type

1 Partner "Type a partner profile ID to restrict the purge to only documents for that partner."

2 Transaction "Type a document type (transaction set or message) to restrict the purge to only
documents of that type."

3 Document Location "Select the location of the document you want to remove from the system." Valid
values are:

v "In Documents"

v "?In Documents"

v "Out Documents"

v "?Out Documents"

v "In Drawer"

v "Out Drawer"

v "Workspace"

v "Queued" (Send Queue)
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Table 96. Command parameters for GDW_Document_Purge (continued)

Number
Command
Parameter What to Type

4 Document Status "Select the status of the document you want to remove from the system." Valid
values are:

v "DocQueued"

v "Duplicate"

v "FAPartial" (This status indicates that there were no acknowledgements expected
for this document and either the group or the interchange was partially
acknowledged.)

v "FAReceived" (This status indicates that the document was acknowledged by
your partner and there were no errors.)

v "FAReject" (This status indicates that the document was acknowledged and
rejected by your partner because there were errors.)

v "FAwErrors" (This status indicates that the document was acknowledged by
your partner and accepted, although there were errors.)

v "Incomplete"

v "NetDelivered"

v "NetError"

v "NetPickedUp"

v "NetReceived"

v "NetWarning"

v "NotOK"

v "OK"

v "OverDue"

v "Sent"

v "Waiting"

5 Date/Age of Docs "Type the age (in number of days) or date (in YYYY/MM/DD format) of the
document you want to remove from the system. Zero ("0") indicates that all
documents are purged, including today's documents. One ("1") indicates that all
documents except today's documents are purged."

6 ""

7 ""

8 ""

GDW_Document_Rpt
The GDW_Document_Rpt command creates a specified file that contains formatted
document data (as well as group and interchange data, if applicable) for
documents in the Sterling Gentran:Server database according to the specified
status, location, and/or age/date.

The folder where Sterling Gentran:Server is installed on the machine is used for
the Document Report File Name if you do not specify a path. If the specified file
already exists, the program appends the new document report data to the end of
the existing file.

If Command Parameter 2 (Document Location) is not used, the documents in all
locations are used. If Command Parameter 3 (Document Status) is not used, all
documents are used regardless of status. If Command Parameter 4 (Document Age
or Date) is not used, all documents are used regardless of age or date.
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If Command Parameter 4 is used, you can specify either an age (number of days)
or a date. If an age is specified, all documents less than or equal to the specified
number of days are used. For example, zero indicates that documents from the
current day are used. One indicates that documents from the current day and the
day before are used. Two indicates that documents from the current day, the day
before, and two days before are used. If a date is specified, all documents created
on that day are used. Dates are specified in YYYY/MM/DD format (four-digit
year, separator, two-digit month, separator, and two-digit day).

If no documents match the specified parameters, the system does not create the
document report file, and a message to that effect is written to the Audit Log.

Table 97. Command parameters for GDW_Document_Rpt

Number Command Parameter What to Type

*1 File Name "Type the document report filename."

2 Document Location "Select the location of the document you want to use from the system." Valid
values are:

v "In Documents"

v "?In Documents"

v "Out Documents"

v "?Out Documents"

v "In Drawer"

v "Out Drawer"

v "Workspace"

v "Queued" (Send Queue)

3 Document Status "Select the status of the document you want to use from the system." Valid values
are:

v "DocQueued"

v "Duplicate"

v "FAPartial"

v "FAReceived"

v "FAReject"

v "FAwErrors"

v "Incomplete"

v "NetDelivered"

v "NetError"

v "NetPickedUp"

v "NetReceived"

v "NetWarning"

v "NotOK"

v "OK"

v "OverDue"

v "Sent"

v "Waiting"

4 Date/Age of Docs "Type the age (in number of days) or date (in YYYY/MM/DD format) of the
document you want to use from the system. For example, zero indicates that
documents from the current day are used. One indicates that documents from the
current day and the day before are used. Two indicates that documents from the
current day, the day before, and two days before are used."

5 ""
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Table 97. Command parameters for GDW_Document_Rpt (continued)

Number Command Parameter What to Type

6 ""

Document Report Layouts
The GDW_Document_Rpt command formats a comma-delimited positional text file
that contains the data from the requested EDI documents processed by Sterling
Gentran:Server.

The following formatting standards are used:
v Character fields are enclosed in double quotes ("character_field").
v Data fields that are not applicable for a designated processing stage are

indicated on the report as two double quotes ("").
v Numeric fields that are not applicable for a designated processing stage are

indicated on the report as two commas (,,).

The values in the 'Max Len' column, in the case of numeric data types, are the
number of bytes the field can hold. This value is not equal to the number of
decimal digits that the field can store. Examples:
v Numeric fields with a maximum length of 2 (bytes) can hold values in the range

of -32,768 to 32767 (5 decimal digits).
v Numeric fields with a maximum length of 4 can hold values in the range of

-2,147,483,648 to 2,147,483,647

While these are minimum and maximum values that can be stored in a particular
field, in many instances the actual values used by Sterling Gentran:Server will be
much less.

The Document Report record contains data that is organized into four categories:
document, group, interchange, and tracking. The following tables contain the
document report file layout.

See the following topics for more information:
v “Document Report Layouts”
v “Track Table” on page 97
v “Group Table” on page 92
v “Interchange Table” on page 94

GDW_Export
The GDW_Export command performs the Sterling Gentran:Server Export function.
This function processes documents from In Documents. You can restrict the export
to only documents for a specified trading partner profile ID and/or documents of
a specified type.

The export function writes documents to the defined export file. If the export file
exists prior to the export, the new export data is concatenated with the existing
file. If you do not specify a filename, the documents are written to the default
export file (defined for the inbound relationship for this partner). If a filename is
specified without a file path, the default Export folder (specified in the System
Configuration program) is used.
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Note: This filename can contain a mix of regular characters and formatting
characters (listed on the following page) that are replaced by the translator with
the runtime value they represent. The following caveats apply:
v If you use the GDW_Export command to export to a single file with a defined

export filename, all documents from the same interchange are exported to a
single file. If you use formatting characters in the filename, that filename
contains the Document Key of the first document exported, the Process ID from
that instance of the translator, and a Unique ID.

v If you use the GDW_Export command to export to a default file where the
export filename is defined in the inbound partner relationship, all documents
from the same interchange are exported to a single file. If you use formatting
characters in the filename, that filename contains the Document Key of the first
document exported, the Process ID from that instance of the translator, and a
Unique ID.

v You can use a special character, such as an underscore, to separate values within
the filename. For example, you could specify %Y_%M_%D to indicate
year_month_day as the filename. However, do not use a period in a filename to
separate values. A period can only be used to indicate the filename extension,
such as .txt.

You can use Command Parameter 2 (Select Partner Profile ID) and Command
Parameter 3 (Select Document Type) to restrict the exported documents.

Note: You must have an export translation object registered with the system.

You can also use the GDW_Export command to allow the output of an inbound
translation to be delivered back to the Mailbox Server. This allows the Mailbox
Server to act as a message broker to be responsible for delivering the data to its
final destination.

144 IBM Sterling Gentran:Server for Windows: Administration Guide



Table 98. Command parameters for GDW_Export

Number Command Parameter What to Type

1 filename "Type the name of the file to which you want to export. If this filename is not
specified, the default export file specified in the trading partner relationship is
used."
Notes:

v The filename can contain a mix of regular characters and formatting
characters that are replaced by the translator with the runtime values they
represent.

v You can use a special character, such as an underscore, to separate values
within the filename. For example, you could specify %Y_%M_%D to
indicate year_month_day as the filename. However, do not use a period in
a filename to separate values. A period can only be used to indicate the
filename extension, such as .txt.

Formatting characters supported

v %y (two-digit year)

v %Y (four-digit year)

v %m (abbreviated month name)

v %M (month as a decimal number)

v %d (abbreviated weekday name)

v %D (day of the month as a decimal number)

v %H (hour in 24-hour format)

v %N (minutes)

v %S (seconds)

v %K (document key)

v %P (process identifier)

v %U (unique number derived using the current time, export filename,
process identifier, and the rand() function)

2 Partner "Type a partner profile ID to restrict the action to only documents for that
partner."

3 Transaction "Type a document type (transaction set or message) to restrict the export to
only documents of that type."

4 Document "Type ‘Do not move to InDrawer' to specify the document should not be
moved or type ‘Move to InDrawer' to move the documents after the export
operation is performed."

5 ""

6 Recipient Mailbox Name "Type the recipient mailbox name if you want to use the Send Mailbox
function."

7 Recipient E-mail Address "Type the recipient E-mail address if you want to use the Send Mailbox
function."

8 Content Type/Content
Subtype

"Type the content type/content subtype if you want to use the Send Mailbox
function."

9 ""

10 ""

11 ""

12 ""

13 True or False "Type ‘true' if you want to export the file or files to a mailbox or type ‘false' if
you do not want to export to a mailbox."
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GDW_ExtData_Delete
The GDW_ExtData_Delete command enables you to delete the specified external
data files from the External Data folder in the system data store.

Table 99. Command parameters for GDW_ExtData_Delete

Number
Command
Parameter What to Type

*1 Action "Type the action by which you want the system to filter the external data files
(such as Process File, Mailbox Process File, Import, Mailbox Import, Send, or
Export)."

2 Age (no. of days) "Type the age (in number of days) of the external data files you want to remove
from the system. Zero ("0") indicates that all external data files are purged,
including today's files. One ("1") indicates that all external data files except today's
are purged."

3 ""

4 ""

5 ""

6 ""

GDW_Import
The GDW_Import command performs the Sterling Gentran:Server Import function.
In process control mode, this function translates data from a specific application
file into EDI Data.

Compliant documents are placed in the Out Documents and non-compliant
documents are placed in the ?Out Documents. If you do not specify a full file path,
the default Imports folder (defined in the System Configuration program) is used.

Note: You must have an import translation object registered with the system.

Table 100. Command parameters for GDW_Import

Number Command Parameter What to Type

*1 File Name "Type the name of the file you want the system to import."

2 ""

3 ""

4 ""

5 ""

6 ""
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GDW_Notify_Purge
The GDW_Notify_Purge command deletes all notifications records in the system or
deletes them by age, if specified.

Table 101. Command parameters for GDW_Notify_Purge

Number Command Parameter What to Type

*1 File Name "Type the age (in number of days) for which you want the system to purge
notification records."

For example, an age of "0" indicates that information only for the current day
will be retained and all older information will be deleted. An age of "1"
indicates that information for the current and previous days will be retained and
all older information will be deleted.

2 ""

3 ""

4 ""

5 ""

6 ""

GDW_Partner_Delete
The GDW_Partner_Delete command performs the Partner Editor delete command.
You can select a specific partner or choose to delete all partners.

Table 102. Command parameters for GDW_Partner_Delete

Number Command Parameter What to Type

*1 Partner "Type the name of the partner profile you want to delete from the system."

2 ""

3 ""

4 ""

5 ""

6 ""

GDW_Partner_Export
The GDW_Partner_Export command performs the Partner Editor export command.

Table 103. Command parameters for GDW_Partner_Export

Number Command Parameter What to Type

*1 Partner "Type the name of the partner profile you want to export."

2 File Name "Type the name of the file to which you want the selected partner relationship
exported."
Note: The Partner Name field is used to generate the file name. If the Partner
Name contains any Windows reserved characters (such as /, \, :, *, ?, ", <, >, |),
the file drops those characters and pads the file name with spaces (one space for
each reserved character in the name).

For example, if the Partner Name is "AB/CD-TEST" then the file name will be
AB CD TEST.par.
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Table 103. Command parameters for GDW_Partner_Export (continued)

Number Command Parameter What to Type

3 ""

4 ""

5 ""

6 ""

GDW_Partner_Import
The GDW_Partner_Import command performs the Partner Editor import
command.

Table 104. Command parameters for GDW_Partner_Import

Number Command Parameter What to Type

*1 File Name "Type the name of the partner file you want to import."

2 ""

3 ""

4 ""

5 ""

6 ""

GDW_Print
The GDW_Print command performs the Sterling Gentran:Server Print function.
This function processes documents from In Documents. You can restrict the print
to only documents for a specified trading partner and/or documents of a specified
type.

Command Parameter 1 (Select Partner) and Command Parameter 2 (Select
Document Type) can be used to restrict the printed documents by partner and
document type. If you do not specify either Command Parameter 1 or Command
Parameter 2, all documents in In Documents are printed.

Note: You must have a print translation object registered with the system.

Table 105. Command parameters for GDW_Print

Number Command Parameter What to Type

1 Partner "Type a the name of a partner profile to restrict the print to only documents for
that partner."

2 Transaction "Type a document type (transaction set or message) to restrict the print to only
documents of that type."

3 Document "Type ‘Do not move to InDrawer' to specify that the document should not be
moved or type ‘Move to InDrawer' to move the documents after the print
operation is performed."

4 ""

5 ""

6 ""
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GDW_Process_File
The GDW_Process_File command enables the user to invoke the
post-communications process with any EDI file, just as if the file was received
during a communication session.

If you do not specify a complete file path for the file in Command Parameter 1, the
default IntIn folder (specified in the System Configuration program) is used. If the
file specified in Command Parameter 1 (File to Process) does not exist, the system
terminates processing and writes a message to that effect to the Audit Log.

Note: You must have an export translation object registered with the system.

Table 106. Command parameters for GDW_Process_File

Number Command Parameter What to Type

*1 File Name "Type the name of the file you want to process."

2 ""

3 ""

4 ""

5 ""

6 ""

GDW_Receive
The GDW_Receive command performs the Sterling Gentran:Server Receive Only
function. This function allows you to establish a receive-only communications
session with one or all of your defined connections.

If you specify <all> in Command Parameter 1 (Mailbox), Sterling Gentran:Server
initiates receive sessions for each mailbox.

Table 107. Command parameters for GDW_Receive

Number Command Parameter What to Type

*1 Mailbox "Type the name of the mailbox for which you want to establish a receive-only
communications session or type <all> to initiate receive-only communications
sessions with all mailboxes."

2 ""

3 ""

4 ""

5 ""

6 ""

GDW_Send
The GDW_Send command performs the Sterling Gentran:Server Send function.
This function allows you to send posted documents for one or all of your defined
connections (that have documents ready to be sent).
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If you specify <all> in Command Parameter 1 (Mailbox), Sterling Gentran:Server
initiates send sessions for each mailbox with posted documents that are ready to
be sent.

Table 108. Command parameters for GDW_Send

Number Command Parameter What to Type

**1 Mailbox "Type the name of the Mailbox for which you want to establish a send
communications session or type <all> to initiate send communications sessions
with all mailboxes."

**2 Partner "Type a partner profile to restrict the send to only documents for that partner."

3 Transaction "Type a document type (transaction set or message) to restrict the send to only
documents of that type."

4 ""

5 ""

6 ""

GDW_Send_Receive
The GDW_Send_Receive command performs the Sterling Gentran:Server
Send/Receive function. It allows you to establish a send-receive communications
session with one or all of your defined communication connections. Alternately,
you can restrict the transmission by partner and/or document type.

If you set up an Unattended GDW_Send_Receive command to work with a
Mailbox that has Auto-send enabled, you cannot guarantee that inbound
processing for the comm session has completed before the next command in the
Unattended session starts processing. If you set up an Unattended
GDW_Send_Receive command to work with a Mailbox that does not have
Auto-send enabled, the Communications Manager ensures that all messages
received from the communications process are processed before returning to the
calling process. Thus, in this case, you can set up a session with a
GDW_Send_Receive followed by an export.

If you specify <all> in Command Parameter 1 (Mailbox), Sterling Gentran:Server
initiates send/receive sessions for all mailboxes.

If you specify a mailbox in Command Parameter 1 that is a CopyFile type profile,
or if you specify <all> in Command Parameter 1 and EDI data exists (in Out
Documents and/or Send Queue) for a partner that has a CopyFile-type of profile,
Sterling Gentran:Server only initiates the send process for that file. When the send
process is executed for a CopyFile type profile, the EDI data (in the Out
Documents and/or Send Queue) for that partner is copied to the specified file. For
all other types of mailboxes, Sterling Gentran:Server sends the data for those
partners (that is in the Out Documents and/or Send Queue) to the specified
connection and then receives any data available from that connection.

Important: Command Parameter 1 (Mailbox) and Command Parameter 2 (Select
Partner) are mutually exclusive. However, you must use one of these two
parameters.
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Table 109. Command parameters for GDW_Send_Receive

Number Command Parameter What to Type

**1 Mailbox "Type the name of the Mailbox for which you want to establish a send/receive
communications session or type <all> to initiate send/receive communications
sessions with all mailboxes."

**2 Partner "Type a partner profile to restrict the send/receive to only documents for that
partner."

3 Transaction "Type a document type (transaction set or message) to restrict the send/receive
to only documents of that type."

4 ""

5 ""

6 ""

Terminate_Script
The Terminate_Script command allows you to instruct the system to stop
processing the session. This command can be used to stop execution if unexpected
or undesired events occur during processing. Usually this command would be
used in conjunction with a condition, which would determine whether or not the
script should terminate.

In addition, you can optionally execute one of your programs just prior to
termination. You can also specify any parameters that are necessary for the
execution of the program. This program could perform any desired housekeeping,
error handling, or notification procedures.

Table 110. Command parameters for Terminate_Script

Number Command Parameter What to Type

1 Before Termination Run “Type the name of the program you want the system to run. If you need to
specify any parameters necessary for program execution, type a space after
the program name and then type the parameter(s)."

2 Working Directory "Specify the name of the working directory the system should use when
executing the program. The working directory is not mandatory. However, if
you do not specify a working directory, the system will default to the current
directory at the time of execution. This can cause unpredictable results in
programs that assume information is available in specific directory paths."

3 ""

4 ""

5 ""

6 ""
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Chapter 7. System Information

Program Descriptions Table
The programs are listed in alphabetic order in the table below, along with the
program description and location (such as controller or user interface client) of
each.

Program Description Location

AckServer.EXE Out-of-process COM
component used by
RPCSRV.EXE to perform
deferred acknowledgement
processing

primary Sterling
Gentran:Server system
controller

ANConfig.EXE Audit Server Setup user interface client

ANServer.EXE Audit Service user interface client

ArchiveEngine.EXE Archive Engine user interface client

ArchiveManager.EXE Archive Manager user interface client

AuditLog.EXE Audit Log user interface client

AuditMsgUI.EXE Audit Message Definitions user interface client

Axdist.EXE ActiveX Distribution comm controller

COMMPOST.EXE Communications Post Processor comm controller/user
interface client

CONFIG.EXE System Configuration user interface client

EDIMGR.EXE Sterling Gentran:Server EDI
Manager

user interface client

FORMS.EXE Forms Integration subsystem user interface client

GNTXEng.EXE COM component responsible
for the translation of inbound
data

controller/user interface
client

MAPPER.EXE Application Integration
subsystem

user interface client

MCLIENT.EXE Mailbox User Interface comm controller

MERCURY.EXE Mailbox Service comm controller

Notify.EXE Notification Setup user interface client

NotifyLogUI.EXE Notification Log user interface client

Operators.EXE Operators Setup user interface client

PARTNRED.EXE Partner Editor user interface client

PROCCNTL.EXE Process Control Setup user interface client

RPCSRV.EXE Sterling Gentran:Server
Executive Service

controller

TX32.EXE Translator/Document Editor user interface client

TXDE.EXE Screen entry and print legacy
application

user interface client

UNATTEND.EXE Process Control Execution controller
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Program Description Location

Vatprint.EXE Value-added tax report user interface
client/controller

XPROCESS.EXE Extra Processing Program for
pre- and post-processing

comm controller

User Interface Client/Controller Folders
Sterling Gentran:Server installs a default set of folders on each user interface client
and controller. Additionally, the installation program allows you to select default
folders on the system data store for different file types.

Sterling Gentran:Server installs the following default folders on each user interface
client and controller:
v Bin folder contains the Sterling Gentran:Server program executables (binaries)

for that user interface client or controller.
v Ipcmsg folder contains the Sterling Gentran:Server interprocess communication

files for that user interface client or controller.
v Temp folder contains the Sterling Gentran:Server temporary files for that user

interface client or controller.
v CharsetMaps folder contains character set files used for character set conversion.

Machines with client access components

Sterling Gentran:Server installs the following default folders on each machine on
which client access components were installed:
v Imports folder contains the import files.
v Export folder contains the export files.
v Partners folder contains the .PAR partner profiles.
v CommScr folder contains the Sterling Gentran:Server communication script files.
v CommScr\Samples folder contains sample Sterling Gentran:Server

communication script files.

Machines with integration components

Sterling Gentran:Server installs the following default folders on each machine on
which integration components were installed:
v Maps folder contains the Application Integration .MAP files.
v Forms folder contains the Forms Integration .STP files.
v TransObj folder contains the compiled map and form translation objects.
v Tutorial folder contains the Sterling Gentran:Server tutorial data for the Forms

and Application Integration tutorials.

Note: When the XML option is installed from the Options Pack, the Tutorial folder
includes an XML subfolder which contains the XML tutorial files.

Primary system controller folders

Sterling Gentran:Server installs the following default folder on the primary Sterling
Gentran:Server system controller:
v Store folder is the repository for all mailbox-related information and data.
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Note: The Store folder uses the directory structure set on the System
Configuration Directories Tab. The Store folder uses a hierarchical structure with
the first level being the 4-digit year. Then, depending on what was specified on
the System Configuration Directories Tab, the next level will be the 2-digit
month and then the 2-digit day, following by the 2-digit hour (in 24-hour
format), if specified.

Important: Do not modify or delete the Store folder or its contents.
v Archive folder contains the archive definition (.ARD) and archive (.ARV) files.
v Documents folder contains all of the document files (.DOC).
v ExternalData folder contains the copies the system has made of external data

files (.EXT).
v ErrorData folder contains error files (.IER), written by the Splitter when it is

unable to recognize an interchange or network report.
v IntIn folder contains all received interchanges (.INT).
v IntOut folder contains all sent interchanges (.INT).
v IntRNPIP0A1 folder contains all the outbound PIP 0A1 Failure Notification

Action interchanges.

Note: This folder is only present if you have installed Sterling Gentran:Server
for RosettaNet.

v RegTransObj folder contains the registered translation objects (.TPL).
v TranRpt folder contains all the translator reports (.RPT).
v Unattend folder contains all of the process control event, session, and calendar

files.
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Chapter 8. Partner File Layouts

Partner Functions
The Sterling Gentran:Server partner import feature enables you to import partner
details from a file. The file of partner details can originate from a partner profile
that was exported from another copy of the Sterling Gentran:Server system.

You can also use the import facility to update information for existing partners. If
you import to an existing partner profile, you can add new trading relationships.
Existing relationships are not modified.

Note: Any tables (cross-reference, lookup, or location) attached to the partner
profile are also imported.

The Sterling Gentran:Server partner export feature enables you to export existing
partner details to a file. You can also export your partners to diskette to use as a
backup of your partner system.

Note: Any tables (cross-reference, lookup, or location) attached to the partner
profile are also exported.

The partner table import function allows you to import partner cross-reference and
lookup tables from a sequential file. This allows you to import tables created for
another partner profile and build tables outside of Sterling Gentran:Server by
formatting your data in the export file layout.

The partner table export function allows you to export partner cross-reference and
lookup tables to a sequential file. This allows you to define a table for one trading
partner and copy that table to another partner profile.

Note: The default file extension for cross-reference tables is .XRF. The default file
extension for lookup tables is .LKP.

Partner Import and Export Files
The partner import and export files (*.PAR) enable you to create a new partner
based on information you previously defined. These files are free-format ASCII text
with a .PAR extension, consisting of a dump of the partner database tables in a
sequential format in which each field is delimited (separated) with Hex01. The
delimiters are necessary because the field lengths are variable.

The .PAR file begins with the partner version number, which is 1.0 followed by the
Hex01 delimiter. Next is the information from the partner database tables. Each
table is identified by a three-character code and the Hex01 delimiter.

Note: If the partner does not have specific information defined (such as location,
lookup, or cross-reference tables), then the .PAR file created does not contain any
related data for those tables. In the following sections, the tables are listed
sequentially, in the order they will appear in the .PAR file.
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Database table codes

Table 111. Three-character code corresponding to each partner database table

Partner Database Table Table Name Ident. Code

Partner main table Partner_tb PAR

Location table Location_tb LOC

Lookup table Lookup_tb LKP

Cross-reference table CrossReference_tb CRR

Relationship table Relationship_tb REL

Interchange control table InterchangeControl_tb INT

Functional group control table FunctionalGroupControl_tb GRP

Generic envelope segment table GenericEnvelopeSegment_tb ENV

The .PAR file begins with a PAR segment, followed by a REL segment.

Table Layouts

See the following topics for more information:
v “Partner Table” on page 109 - The field names, preceded by the identifier code

PAR, are used in the .PAR file.
v “Location Table” on page 113 - The field names, preceded by the identifier code

LOC, are used in the .PAR file.
v “Location Table” on page 113 - The field names, preceded by the identifier code

LKP, are used in the .PAR file.
v “Cross-Reference Table” on page 112 - The field names, preceded by the

identifier code CRR, are used in the .PAR file.
v “Relationship Table” on page 110 - The field names, preceded by the identifier

code REL, are used in the .PAR file.
v “Interchange Control Table” on page 108 - The field names, preceded by the

identifier code INT, are used in the .PAR file.
v “Functional Group Control Table” on page 106 - The field names, preceded by

the identifier code GRP, are used in the .PAR file.
v “Generic Envelope Segment Table” on page 108 - The field names, preceded by

the identifier code ENV, are used in the .PAR file.

Partner Table Import and Table Export Files
Like the partner import and export file, the table export and import file layout is a
free-format ASCII text file. Each field must be delimited (separated) with Hex01
because the field lengths are variable. The default file extension for a lookup
export file is .LKP. The default file extension for a cross-reference file is .XRF.

The .LKP and .XRF files contain information from the partner table database tables.
Each table is identified by a three-character code and the Hex01 delimiter.

The following sections illustrate the layout of the specific fields in the partner
database tables that comprise the partner table files.

Note: You can create these files with a text editor (such as Notepad).
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Table Layouts

See the following topics for more information:
v “Lookup Table” on page 113 - The field names are used in the .LKP file.
v “Cross-Reference Table” on page 112 - The field names are used in the .XRF file.
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Chapter 9. Utilities and Modules

About DCOM and the DCOM Utility
Distributed Component Object Model (DCOM) is a proprietary Microsoft Windows
technology that enables software components to communicate directly over a
network. Components on a server and a client need to be configured and must
correspond with each other to enable the DCOM network communication.

During the installation of Sterling Gentran:Server, the system saves specific
components (in the Console Root folder in Windows) that require DCOM
communication. Before these components can communicate and run on the Sterling
Gentran:Server server, you must configure them with the appropriate
authentication and activation client user permissions.

Windows lists components requiring DCOM communication in the Management
Console, accessed using the Component Services dialog box. However, the DCOM
Utility can be used to locate Sterling Gentran:Server components so you can
configure them for DCOM communication.

Affected Components

The following Sterling Gentran:Server components require configuration for
DCOM communication:
v Audit Notification Application
v Audit Notification Service
v GENTRANAudit.NotifyLogUI
v GNTXEngine
v AckServer

Important: You must have local administrator access for your client machines to
run the DCOM utility. You can set up and verify access using the Management
Console in Windows. For more information, see the Microsoft Windows
documentation.

Using the DCOM Utility, you need only to add client users and groups and update
permissions to complete the configuration process for all components that require
DCOM configuration.
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The DCOM Object Permissions Utility Dialog Box

The following diagram shows the DCOM Object Permissions Utility dialog box.

The following table describes the parts of the DCOM Object Permissions Utility
dialog box

Part Function

User Displays users and groups specified to access Sterling
Gentran:Server components.

Status Indicates whether the DCOM Utility successfully authenticated
permission to access a component using DCOM communication.
Status messages are:

v Passed - successful authentication

v Failed - authentication failure

If you received a Failed status message, consider the following
potential issues:

v Incorrect user name or user group name entered.

v Password change on the client server.

v Local administrator rights modified on the client server.

Consult the log file for further information.

Add Accesses the Add Users and Groups dialog box.
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Part Function

Remove Removes a user or user group from the list. To remove, select,
select the name from the list, and then click Remove.

Audit Notification v User ID - domain and user name of the local administrator

v Password - password of the local administrator

Using Oracle for ODBC
Mapping

Select this option if you use an Oracle database and want to
specify a different Run As User. The following fields are active
only if you select this option:

v User ID

v Password

View Log Opens the DCOMFixUtil.log file in the log viewer.

Update Permissions Authenticates permissions for all installed DCOM components,
starting with:

v Audit Notification Application - if running on the server

v GENTRANAudit.NotifyLogUI - if running on a client

Log Viewer

A log file named DCOMFixUtil.log is written in the directory where the executable
is. The file is appended to each time you run DCOMFixUtil.exe.

If there are errors when you run the utility, you can click View Log to check the
log file for the reason for failure.

The following shows an example of the log file.

Configuring the DCOM Utility
Use the DCOM Utility to locate Sterling Gentran:Server components so you can
configure them for DCOM communication.
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About this task

The DCOM Utility can run on any machine that has either a Sterling
Gentran:Server server or client installed.

Use the following procedure to configure the DCOM Utility.

Procedure
1. From the Sterling Gentran:Server DVD, navigate to Support\Utils.
2. Copy the DCOMFixUtil.exe file and then save it to a directory on your machine.

Note: You can choose any directory in which to save the file.
3. Double-click DCOMFixUtil.exe to launch the DCOM Utility.

Note: You must be in the admin group, but you do not have to be logged into
Sterling Gentran:Server to use the DCOM Utility.

4. Click Add to display the Add Users and Groups dialog box.
5. From the List Names From drop-down field, select the network from which

you want to display users and groups of users.
6. From the Names list, locate the user or group and double-click all the names of

users or groups you want to add.

Note: You must specify at least one user account.
This populates the Add Names field.

7. After you have finished your selections, click Add to return to the DCOM
Object Permissions Utility dialog box.

8. If you use an Oracle database and want to specify a different Run As User,
select Using Oracle for ODBC Mapping.

9. Click Update Permissions to complete the configuration process for all DCOM
components.
The DCOM Utility authenticates permissions for all components, starting with
Audit Notification Application. After authentication, the utility displays the
status message Passed. A rolling log file (DCOMFixUtil.log) is written to the
directory where you saved DCOMFixUtil.exe. If any credentials are invalid, an
error is displayed. Click View Log to determine the reason for the failure.

Note: If you are not logged into Sterling Gentran:Server, permissions do not
authenticate until the next time you log in.
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The Sterling Gentran Administrator Utility
If a system problem occurs that requires Customer Support intervention, you can
use the Sterling Gentran® Administrator Utility to analyze and collect system data.

The following diagram shows the Sterling Gentran Administrator Utility.

This window includes the following tabs:
v System Information
v Database Information
v Gentran File System
v Gentran File Versions
v Services

The fields on all of these tabs are only populated when you have run the analysis
and collected the system data. (See “Collecting System Data.”) You cannot enter
data in any of the fields.

Note: On the Database Information tab, you can enter the Gentran database
username and password, although it is not required.

As part of the analysis procedure, you can add a support case number as well as
other files to the collected data. The result of the analysis is a .zip file called
pdcollect_gsw.zip, which is stored in the C:\GENSRVNT folder. You can send this .zip
file to Customer Support.

Collecting System Data
If a system problem occurs that requires Customer Support intervention, you can
use the Sterling Gentran Administrator Utility to analyze and collect system data.
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About this task

Use the following procedure to collect system data to send to Customer Support.

Procedure
1. Start the Sterling Gentran Administrator Utility from the \GENSRVNT\bin folder

on the primary system controller
The system displays the Additional Information dialog box.

2. Click Analyze.
The system displays the Sterling Gentran Administrator dialog box.

3. Click OK.

Note: You can clear any of the check boxes, but we recommend that you
leave all items checked.
The system displays a confirmation dialog box and the screen is populated.

4. Click OK.
5. Click Save All.

Note: If you exit before saving, the data will not be saved to a file.
The system displays the Existing Case dialog box.

6. Click Yes or No.
If you clicked Yes, the Case Number dialog box is displayed. Enter case
number and click OK.

7. Click OK in the confirmation dialog box.
The system displays the Add File dialog box.

8. Click Yes or No.

Note: You can add as many files as you want and click No when you are
done. You can select multiple files at a time, but you cannot select folders.
If you clicked Yes, the Add File dialog box is displayed. Navigate to the file
and click Open.

9. Click Exit to close the utility.
10. Navigate to C:\GENSRVNT and send the pdcollect_gsw.zip file to Customer

Support.

GICHECK.EXE Utility
The GICHECK.EXE (Gentran Integrity Check) utility is a dialog-based application
that verifies certain aspects of integrity between the Sterling Gentran:Server
database tables and your file system.

About GICHECK.EXE

This utility supports integrity checks for Interchange objects, Document objects,
and Attachment objects. An object is defined as a database table entry (and any
associated database table entries) or a file in the Sterling Gentran:Server data store
directory structure.

Note: This utility must be run on the primary Sterling Gentran:Server system
controller.
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Each object to be checked has a tabbed dialog box that provides you with three
basic options. The first option is to execute the integrity check by clicking Find
Orphans. The second option is to delete all orphan objects found by the Find
Orphans check. The third option is to delete selected rows found by the Find
Orphans check.

GICHECK.EXE can also be run from a command line. You can also generate a
report on the orphan objects found by this utility.

GICHECK.EXE is included on the installation DVD in the \i386\utils folder.
Copy the GICHECK.EXE program to your \GENSRVNT\bin folder on the primary
Sterling Gentran:Server system controller to make this utility available for use.

You should only execute GICHECK.EXE on the primary Sterling Gentran:Server
system controller while the Sterling Gentran:Server system is not running. To
correctly verify the integrity of files and database entries, the utility depends on
the assumption that there are no files or database entries being created or updated
during the check process.

Note: GICHECK.EXE will not run on user interface client machines because the
location of the Store directory is typically a local path. If you attempt to run this
utility on any machine other than a primary Sterling Gentran:Server system
controller, the GENSRVNT\Store directory would not exist on the local machine
and all entries in the Attachment_tb database would be considered orphans. The
system will display an error and the program will be terminated.

If your Store directory is located on a machine other than the primary Sterling
Gentran:Server system controller, you should run the GICHECK.EXE utility from
that machine. However, you should be aware that this utility achieves optimal
performance when run on the primary Sterling Gentran:Server system controller.

Integrity Check Options

The following are detailed descriptions of the GICHECK.EXE options.

Find Orphans Option 1 (Delete Rows)

This option checks any table in the Sterling Gentran:Server database that contains a
reference to a file. If the file referenced is missing (it cannot be found in its
designated location), the entry in the table is marked as an orphan.

Any entry that the GICHECK.EXE utility marks as an orphan can be removed by
the utility if you choose the Delete Rows option.

Note: Table entries that reference a translation report file are purposefully not
marked as orphans if the file is missing because a missing report file is not a
significant enough reason to allow the removal of a database table entry.

The following are the Sterling Gentran:Server database tables that are checked by
the GICHECK.EXE utility:
v Interchange_tb
v Document_tb
v Attachment_tb
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Note: The Delete Rows option deletes all orphan database table entries that were
found as a result of running the Find Orphans check. These rows reference a file
(or files) that no longer exists. When the entry is removed from the database, any
associated entries are also removed to maintain the referential integrity within the
Sterling Gentran:Server database. For example, if an entry in the Interchange_tb is
removed, all entries in the Document_tb, Track_tb, Group_tb,
InterchangeAuditEntry_tb, and DocumentAuditEntry_tb that are associated with
that interchange are also removed, including any files that those entries reference.

If an entry in the Document_tb is removed and this entry represents the last
document in an interchange, then the system removes the interchange and all its
associated entries along with the document. If an entry in the Attachment_tb is
removed, the system removes any entry in the File_tb that is associated with that
attachment.

If you want to generate a report on all orphan objects found, do so before executing
the delete option. After the delete option is run, the internal list used to track these
orphan rows is emptied, which makes it impossible to generate an accurate report.

Find Orphans Option 2 (Delete Files)

All files found within the directory structure that are referenced by the tables in
Option 1 (above) are validated. If the file that is validated cannot be found in the
corresponding database table, the file is marked as an orphan. Any file that
GICHECK.EXE marks as an orphan can be removed using the Delete Files option.

The following are the directories that are checked by the GICHECK.EXE utility:
v Documents
v IntIn
v IntOut
v TranRpt
v Store

Note: The Delete Files option deletes all orphan files that were found by the Find
Orphans check. These are files that are in the Sterling Gentran:Server directory
structure (such as IntIn, IntOut, Documents, TranRpt, or Store directory, depending
on which check is being performed) but that do not have an associated database
entry that references them.

This utility also gives you the ability to verify the External Data tables and
ExternalData directory for orphan files.

If you wish to generate a report on all orphan objects found, do so before executing
the delete option. After the delete option is run, the internal list used to track these
orphan files is emptied, which makes it impossible to generate an accurate report.

The Delete Files option deletes empty folders once the last file is removed from the
folder.

Generate Report Option

After running the Find Orphans check, you can generate a report file of all orphan
files and rows by clicking the Report button on the dialog box.
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Note: The report must be generated prior to executing any of the delete options.
Once a delete has been performed, the internal list of orphan objects found is
emptied, which makes it impossible to generate an accurate report.

GICHECK.EXE from the command line

GICHECK.EXE also supports a command line interface. The following shows the
syntax:
GICheck.exe Command:SubCommand[[:SubCommand]:SubCommand]

Table 112. GICHECK.EXE commands and functions

Command Function

/DOC Checks the document file and database integrity.

/INT Checks the interchange file and database integrity.

/ATT Checks the attachment file and database integrity.

/EXT Checks the external data file and db integrity.

/DEL Deletes empty folders.

/OVR Overrides the default behavior of GICHECK.EXE that prevents it from executing while the Sterling
Gentran:Server services run. Without this command, GICheck displays or writes a message to
Gensrvnt\bin\GICHECK.LOG indicating the services are still running, and then exits without
performing any commands.

Table 113. GICHECK.EXE subcommands and functions

Subcommand Function

FR Generates a full report in the directory from which the GICHECK.EXE utility was invoked.
This report contains a list of all orphaned files and orphaned database entries that were found
during the integrity check process. The file name that is used for the report depends on the
command that is run. For example:

v /DOC = DocumentReport.txt

v /INT = InterchangeReport.txt

v /ATT = AttachmentReport.txt

v /EXT = ExternalDataReport.txt

DD Deletes all orphaned database entries.

DF Deletes all orphaned files.

Example
GICheck.exe /DOC:DF:DD:FR /INT:DD:DF:FR /ATT:FR

This example causes the GICHECK.EXE utility to run the document check, the
interchange check, and the attachment check. The document and interchange
checks delete all orphaned files and database entries and generate a report for the
integrity check process. The attachment check generates a report.

GNTSTART.EXE Utility
The GNTSTART.EXE utility allows you to invoke a Sterling Gentran:Server process
(such as import, export, send/receive, unattended process control session, or audit
message) on any primary Sterling Gentran:Server system controller or secondary
controller. The specified process is run within the security context of the Executive
Service, as if from an unattended process control session.
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GNTSTART.EXE is included on the installation DVD in the \i386\utils folder.
Copy the GNTSTART.EXE program to your \GENSRVNT\bin folder to make this utility
available for use.

To see a list of all the options available from the GNTSTART utility, open the
command prompt and type cd \GENSRVNT\bin. Then type gntstart /?.

GNTSTART.EXE can be executed using any of the following methods:
v Run from a command prompt.
v Invoke from within a map by using the WINEXEC command, which enables

you to execute another program while running the translator. Through extended
rule logic, you can design a map that issues audit messages based on whether
data exists.
See Using Extended Rules in the Application Integration User Guide for more
information.

v Invoke through a process control session using the Exec_Program command.
See Using Process Control in the IBM Sterling Gentran:Server for Microsoft
Windows User Guide for more information about creating events and using the
Exec_Program session command.

GNTSTART Syntax

The syntax for executing the GNTSTART utility from the command line is the
following:
c:\GENSRVNT\bin\gntstart.exe -M "machine name" -S "system" [action parameter]
[optional parameter]

All parameters listed in this section need to be typed without quotation marks.

The following table lists the available parameters (bold typeface indicates the
parameters are mandatory).

Table 114. GNSTART parameters

Parameter Type Explanation

-M "MachineName" action Mandatory. Provides the machine name to GNTSTART.EXE. The
machine name is the target computer where the process is run.
Note: This machine must be a primary system controller or secondary
controller.

-S "SystemName" action Mandatory. Provides the system name to GNTSTART.EXE.
Note: The system name is defined during the installation process. It can
be found on the System Configuration program System tab.
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Table 114. GNSTART parameters (continued)

Parameter Type Explanation

-A "AuditMsgID" "Parm1"
"Parm2" "Parm3" "Parm4"
"Parm5" "Parm6" "Parm7"
"Parm8" "Parm9" "Parm10"
"LocalMachine" "User"

action Issues a user defined audit message to the Audit Log:

v The "AuditMsgID" argument must be a numeric value and should
represent a specific user-defined message ID that was created using
the Audit Messages subsystem.

v The "Parm" arguments (Parm1, through Parm10) represent data that is
inserted into the audit message (for example, if the message text of
the audit message contains variables in the form of %1, %2, %3,
through %10, the values supplied by the Parm1 through Parm10
arguments will be expanded into these variables when the audit
message is written.)
Note: The "Parm" arguments are optional. However, if values are not
going to be supplied for them, empty double quotes must be supplied
in their place.

v The "LocalMachine" argument is optional and represents extra
information written to the audit log accompanying the audit message.

v The "User" argument is optional and represents extra information
written to the audit log.

Note: The -M parameter must define the machine name of the primary
system controller where the Audit Notification server resides.

-C "StartPoller" "StopPoller"
"StartScheduler"
"StopScheduler

action Start or stop the poller or scheduler.

-G "Mailbox" action Invokes a receive session for the specified mailbox.

-I "ImportFile" action Invokes an import session against the specified file name.

The "ImportFile" argument must contain the full path and filename for
the target file.
Note: The documents resulting from the import session will be
imported into the Out Documents browser not the Work Space.

-L "FileSystemMailboxName
Collection On"
"FileSystemMailboxName
Collection Off"
"FileSystemMailboxName
Extraction On"
"FileSystemMailboxName
Extraction Off"

action Turn on or off file collection or extraction.

-P "InboundFile" action Starts processing the specified inbound file.

The "InboundFile" argument must contain the full path and filename for
the target file.

-R "RemoteSessionName" action Starts an unattended process control session (UNATTEND.EXE) on a
remote machine using the specified session file.

The "RemoteSessionName" argument represents the unattended process
control session script and must be located in the GENSRVNT\Unattend
folder.
Note:

v This argument should not contain any directory or path information
and should not include the .SES file extension.

v UNATTEND.EXE will be invoked on the computer specified by the
-M parameter.
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Table 114. GNSTART parameters (continued)

Parameter Type Explanation

-V "Mailbox" "PartnerName"
"DocType"

action Starts a send/receive session for the specified mailbox, partner name, or
transaction set (doctype).
Note:

v All three arguments are optional. However, if "Mailbox" and
"PartnerName" are not supplied, you must include the value "None."
If you do not use "DocType," you must supply empty double quotes.

v You can only use one of the "Mailbox" and "PartnerName"
parameters. You must then specify "None" for the parameter you are
not using.

v For "Mailbox" and PartnerName," you can also specify "None" and
"All" as values.

v For "DocType," you must either specify the type or use "All".

-X "ExportFile" "Partner"
"DocType"

action Starts an export session for the specified partner or transaction set
(doctype) and exports it to the specified file.

v The "ExportFile" argument is mandatory and should contain the full
path and filename for the target file.

v The "Partner" and "DocType" (TransactionSetID) arguments are
optional and provide the ability to specify exactly what is to be
exported.

-W optional Wait for completion.

-D optional Delete session.

Verify that all command parameters are enclosed in quotes. If you do not use a
command parameter, you must specify that option as "" (two double quotes).

GNTSTART Batch File Example

The following example represents the contents of a batch file named
GNTTEST.BAT. This batch file can be executed on a user interface client or
controller but, when executed, GNTSTART.EXE causes all processing to occur on
the primary Sterling Gentran:Server system controller.

In the following scenario, the name of the Sterling Gentran:Server system is
"GentranSystem" and the name of the machine where the primary system
controller is installed is "RADIX". Both GNTSTART.EXE and the batch file
(GNTTEST.BAT) are located in the GENSRVNT\bin folder on a user interface client
machine.
REM Issue audit message 1000 (message text = "User batch file processing %1 is
starting")gntstart.exe -M "RADIX" -S "GentranSystem" -A "1000" "Inbound Data" ""
"" "" "" "" "" "" "" ""

REM Process the inbound EDI file
gntstart.exe -M "RADIX" -S "GentranSystem" -P "\RADIX\GENSRVNT utorial\pettest.int"

REM Export all data in the InDocs
gntstart.exe -M "RADIX" -S "GentranSystem" -X "\RADIX\GENSRVNT\exports\purchaseorder.txt"

REM Issue audit message 1001 (message text = "User batch file processing %1 is
ending")gntstart.exe -M "RADIX" -S "GentranSystem" -A "1001" "Inbound Data" "" ""
"" "" "" "" "" "" ""

When this batch file is executed, it does the following:
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v Issues an audit log message indicating that it started (a user-defined audit
message created using the Sterling Gentran:Server Audit Messages subsystem).

v Performs inbound processing of an EDI file.
v Exports all data that was compliant and located in the In Documents browser.
v Issues an audit log message indicating that the batch completed (a user-defined

audit log message created using the Sterling Gentran:Server Audit Messages
subsystem).

WINEXEC Example

The following is an example of how to use a WINEXEC extended rule to execute
GNTSTART.EXE from within a map. When the following extended rule is invoked,
it executes GNTSTART.EXE and issues an audit message.
winexec("d:\GENSRVNT\bin\gntstart.exe -M RADIX -S GentranSystem -A 1000
InboundData ’’ ’’ ’’ ’’ ’’ ’’ ’’ ’’ ’’",1);

TOMULTI.EXE Utility
TOMULTI.EXE is a utility program used to split a single text file into multiple text
files. The output files to which TOMULTI will write are configured in the
definition file. This file associates record identifiers (called tags) with a particular
output file. The definition file is read by TOMULTI prior to processing the input
file. TOMULTI then scans the input file looking for the record IDs defined in the
definition file and, if found, writes that record to the associated output file.

The following shows the command line syntax:
tomulti [<InputFile>] [<DefinitionFile>] [-D]

For example:
tomulti purchaseorder.txt purchaseorder.def

Table 115. TOMULTI parameters

Parameter Definition

InputFile The name of the file to be split into multiple files.

DefinitionFile A file containing the names of the output files and the list of record IDs associated with those
output files. It may also contain the start position of the record IDs within a record. The start
position of a record ID defaults to 1 (the beginning) if this information is not supplied.

-D This option instructs TOMULTI to delete the record IDs from the record before writing it to the
output file. This is an optional command line argument.

The definition file contains a list of output files and a comma-separated list of
record IDs associated with those output files. It can, optionally, contain the start
position of each record ID. This allows record IDs to be embedded within a record
rather than at the very beginning of a record. A colon is used to separate the
record ID from the record ID start position. The start position of a record ID
defaults to 1 (the beginning) if this information is not supplied.

Restriction: A maximum of 60 output files can be defined within the definition
file. A maximum of 30 record IDs can be associated with each output file.

The following shows the definition file layout:
[OutputFile1],[RecordID]:[RecordIDStartPosition] ,..up to 30 rec IDs
[OutputFile2],[RecordID]:[RecordIDStartPosition] ,..up to 30 rec IDs
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Example Scenario

Definition File (purchaseorder.def)
C:\Dropoff\Accounting.txt,BEG,DTM, PO1,PID,ITA,CTT
C:\ Dropoff\CustomerInfo.txt, N1,N3,N4

Input File (purchaseorder.txt)
BEG*01*02*10000654321**000704~
DTM*002*000730~
N1*ST*DENIM JEAN CO~
N3*501 BLUEJEAN WAY *505 LOOSEFIT DRIVE ~
N4*LEVI*AZ*86005~
PO1*0123456789*10*EA*15**BP*555666411~
PID*A****FLARE BOTTOM JEANS~
ITA*A***CC***1000~
CTT*1~

Command Line
Tomulti.exe purchaseorder.txt purchaseorder.def

Resulting Output File for C:\Dropoff\Accounting.txt

BEG*01*02*10000654321**000704~
DTM*002*000730~
PO1*0123456789*10*EA*15**BP*555666411~
PID*A****FLARE BOTTOM JEANS~
ITA*A***CC***1000~
CTT*1~

Resulting Output File for C:\ Dropoff\CustomerInfo.txt

N1*ST*DENIM JEAN CO~
N3*501 BLUEJEAN WAY *505 LOOSEFIT DRIVE ~
N4*LEVI*AZ*86005~

TXTRACE.EXE Utility
The TXTRACE.EXE utility is a dialog-based application that sets and clears a
registry key used by the translator to trigger the creation of a trace file.

About TXTRACE.EXE

This trace file contains entries depicting the input file, output file, and translation
object files that are used by the Sterling Gentran:Server Translator. The trace file
also contains entries that show each attempt of the translator to match an input
block of data (such as record, segment, XML tag, and pcdata) to a map object. The
trace file is typically used by Sterling Gentran:Server support to determine whether
the Translator is correctly matching data from the input file to the map objects
defined in the source map and translation object.

TXTRACE.EXE is included on the installation DVD in the \i386\utils folder.
Copy the TXTRACE.EXE program to your \GENSRVNT\bin folder to make this
utility available for use.

Interaction with GNTXEng.EXE

GNTXEng.EXE is a Sterling Gentran:Server COM component that is responsible for
the translation of inbound data. The GNTXEng.EXE program uses the same
registry key that TX32.EXE (the Sterling Gentran:Server translator) uses to
determine if a trace file should be created.
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When TXTRACE.EXE is used to set the registry key defining the trace path and
filename, the GNTXEng.EXE program modifies that filename by inserting .GNTX
after the filename and before the file extension. GNTXEng.EXE then writes the
trace information to that file.

If you define a trace file path and name as c:\GENSRVNT\mytrace.txt, TX32.EXE
creates the file and writes to it. Then, GNTXEng.EXE creates a file named
c:\GENSRVNT\mytrace.gntx.txt and writes information to this trace file in XML
(eXtensible Markup Language) format.

GNTXEng.EXE does not use the *.IPC files that TX32.EXE uses, so the information
that used to be written to the *.IPC file is now passed through the interface when
GNTXEng.EXE is invoked by COMMPOST.EXE. Since this information is not
accessible to the end user (and support), it is now written to the trace file (when
tracing is activated).

XPROCESS Utility
The XPROCESS utility is an external data processor used when sending or
receiving data. You typically use the XPROCESS utility to prepare data for
transmission to a Trading Partner or to prepare data that you received from a
Trading Partner. You invoke the XPROCESS utility in the command line of a
Delivery Rule.

About the XPROCESS Utility

The syntax of the XPROCESS utility is:
XPROCESS [option] [Parameter1] [Parameter2] [Parameter3]

As an example:

The VAN that your Trading Partner uses expects each line of data to be terminated
with a Carriage Return and Line Feed. Your data is terminated by tilde (~)
characters. You use the XPROCESS utility to convert the tildes into Carriage
Return/Line Feed characters.

Note: If you are a new Sterling Gentran:Server customer, we suggest you use the
Xprocess DLL Agent to perform similar functions.

XPROCESS Parameters

Note: When using a <filename> parameter, you must specify a full path and
filename unless this utility is being invoked by means of the EXE Delivery Agent.
In that case, only the $Filename token is necessary to represent the filename.

Table 116. Parameter options and descriptions

Option Description

-0 Converts any specified hexadecimal character [hexValue1] to another hexadecimal character [hexValue2].

xprocess -0 <hexValue1> <hexValue2> <filename>

-1 Appends the file you specify [filename] to the beginning of the data. This option is often used as a
preprocessor when sending data to the AT&T GMS network.

xprocess -1 <inputfile1> <inputfile2> <outputfile>
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Table 116. Parameter options and descriptions (continued)

Option Description

-2 Replaces the tilde, Carriage Return, and Line Feed characters with a single Carriage Return. This option
is often used as a preprocessor when sending data to the GEIS network.

xprocess -2 <filename>

-3 Replaces all Carriage Returns with tildes and removes all Line Feeds. This option is often used as a
preprocessor when receiving data from the GEIS network.

xprocess -3 <filename>

-4 Removes all Carriage Returns and Line Feeds.

xprocess -4 <filename>

-5 Removes all Carriage Returns and Line Feeds and adds one hexadecimal character (0x1A) at the end of
the file. This option is often used as a preprocessor for the TDSI network.

xprocess -5 <filename>

-6 Removes all hexadecimal 0x1A characters. This option is often used as a prepostprocessor for the TDSI
network.

xprocess -6 <filename>

-7 Adds GM header and trailer records and removes all Carriage Returns and Line Feeds. This option is
often used as a preprocessor for GM. It creates a THS and THD segment for the header and a TTR for
the trailer.

xprocess -7 <youruserid> <theiruserid>
<fileonGMsystem>

-8 Replaces all tilde, Carriage Returns, and Line Feed characters with a single Carriage Return. This option
is often used as a preprocessor when sending data to the MCI network.

xprocess -8 <filename>

-9 Replaces all Line Feed characters with a tilde. This option is often used as a preprocessor when
receiving data from the MCI network.

xprocess -9 <filename>

-10 Replaces all Carriage Returns with Carriage Return/Line Feeds. This option is often used when
receiving files from Commerce:Network.

xprocess -10 <filename>
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Table 116. Parameter options and descriptions (continued)

Option Description

-11 Replaces a string of hexadecimal characters with a second string of hexadecimal characters.

xprocess –11 <hexString1> <hexString2> <filename>

Note: Each hexadecimal string value contains the prefix 0x, followed by a 2-digit hexadecimal value.
Together, the prefix and the 2-digit hexadecimal value are considered one hexadecimal character.

Example 1

The following is an example of a command line using option -11. When executed, this command
converts each ~CRLF to ~ (tilde)

c:\gensrvnt\bin\xprocess.exe -11 0x7e0x0d0x0a 0x7e inputfile.txt

In this example, the first string contains three hexadecimal characters(0x7e,0x0d, and 0x0a) and the
second string contains one hexadecimal character (0x7e). Inputfile.txt designates the file name of the
input.

Example 2

The following is an example of a command line when executed using the EXE Delivery Agent. When
executed, this command converts each ~CRLF to ~ (tilde)

/o $Input c:\gensrvnt\bin\xprocess.exe -11 0x7e0x0d0x0a 0x7e $Input

In this example, the first string contains three (3) hexadecimal characters(0x7e,0x0d, and 0x0a) and the
second string contains one (1) hexadecimal character (0x7e). The $Input token designates the file name
of the input.

-12 Removes all occurrences of a hexadecimal string from a file.

xprocess –12 <hex string> <filename>

-13 Inserts a hexadecimal string at the prescribed increment (Nbr Bytes) in the input file. This option is
typically used (but not limited to) blocking streamed EDI data.

xprocess -13 <NbrBytes> <HexStringToInsert> <InputFile>

Additional Parameters

The following table describes additional XPROCESS Utility parameters.

Table 117. Additional parameters and descriptions

Parameter Description

hexValue1 A hexadecimal value in the format 0x??. Used with the -0 option (described in the table above)
and is the character you want to replace in the data.

where: ?? is the hexadecimal value.

hexValue2 A hexadecimal value in the format 0x??. Used with the -0 option (described in the table above)
and is the new character you are exchanging for hexValue1.

where: ?? is the hexadecimal value.
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Table 117. Additional parameters and descriptions (continued)

Parameter Description

hexString1 A hexadecimal string in the format 0x??0x??. Used with option -11 (described in the table above).

where: ?? is the hexadecimal value.
Note: Each hexadecimal value contains the prefix 0x, followed by a 2-digit hexadecimal value.
Together, the prefix and the 2-digit hexadecimal value are considered 1 hexadecimal character.

Example

0x7e0x0d0x0a

This example describes a hexadecimal string containing three hexadecimal characters.

hexString2 A hexadecimal string in the format 0x??0x??. Used with option -11 (described in the table above).

where: ?? is the hexadecimal value.
Note: Each hexadecimal value contains the prefix 0x, followed by a 2-digit hexadecimal value.
Together, the prefix and the 2-digit hexadecimal value are considered one hexadecimal character.

Example

0x7e0x0d0x0a

This example describes a hexadecimal string containing three hexadecimal characters.

filename The name of the file on which you want to run XPROCESS. Used only when you run XPROCESS
from the command line. If you are using XPROCESS in a Delivery Rule, you do not need to
include a filename. The filename is passed automatically by Mailbox Server.

NbrBytes Specifies a predefined increment at which you want to insert a hexadecimal string value. Used
with the -13 option (described in the table above).

HexString
ToInsert

Specifies a hexadecimal string value that you want to insert at a pre-defined increment. Used
with the -13 option (described in the table above).

Example 1

In this example, a Trading Partner has sent a file that uses Null characters to
terminate segments. Sterling Gentran:Server expects to see a tilde (~) character as
the segment terminator.

Original Data
ISA*00* *00* *08*9275310000 *12*5088947000334
*970812*1133*U*00304*000000132*0*P*><null>GS*GP*001677954*5088947000334*9
70812*1133*83*T*003040UCS<null>ST*880*000830001<null>

Delivery Rule command line

Use the following command line to replace the Null character (hexadecimal value
0x00) with a tilde character (hexadecimal value 0x7E):
/o $Input XPROCESS.EXE -0 0x00 0x7E $Input

Modified Data
ISA*00* *00* *08*9275310000 *12*5088947000334
*970812*1133*U*00304*000000132*0*P*>~GS*GP*001677954*5088947000334*9
70812*1133*83*T*003040UCS~ST*880*000830001~
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Example 2

In this example, a Trading Partner has sent a file that uses a forward slash (/) to
separate elements. Sterling Gentran:Server expects to see an asterisk (*) character as
the element separator.

Original Data
ISA/00/ /00/ /08/9275310000 /12/5088947000334 /970812/
1133/U/00304/000000132/0/P/>~GS/GP/001677954/5088947000334/9
70812/1133/83/T/003040UCS~ST/880/000830001~

Delivery Rule command line

Use the following command line to replace the forward slash character
(hexadecimal value 0x5C) with an asterisk character (hexadecimal value 0x2A):
/o $Input XPROCESS.EXE -0 0x5C 0x2A $Input

Modified Data
ISA*00* *00* *08*9275310000 *12*5088947000334
*970812*1133*U*00304*000000132*0*P*>~GS*GP*001677954*5088947000334*9
70812*1133*83*T*003040UCS~ST*880*000830001~

Modules
The following table describes some of the Sterling Gentran:Server modules, and
explains their dependencies and how they are used.

Name Description Used by Dependencies

AckServer.EXE A COM component that is partially
responsible for managing deferred
acknowledgement processing. This
component is invoked by rpcsrv.EXE (the
GentranExecutive service). A thread
within rpcsrv.EXE invokes AckServer.EXE
on a scheduled basis (the deferred ack
processing thread).

AckServer.EXE is used to invoke
TxAckGen.DLL and TxAckRec.DLL to
perform the actual acknowledgment
processing.

AckServer.EXE is an out-of-process COM
component and is used to shield the
GentranExecutive Service memory from
any application errors that could occur
during acknowledgement processing.

Rpcsrv.EXE manages the
scheduled invocation of
the acknowledgement
process by using the
AckServer component to
invoke acknowledgement
processing.

TxAckGen.DLL and
TxAckRec.DLL

AckServerps.DLL A proxy/stub DLL associated with
AckServer.EXE.

Any COM clients of
AckServer.EXE.

None
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Name Description Used by Dependencies

GNTXEng.EXE A COM component that is responsible for
the translation of inbound data (it
handles the translation break process).

GNTXEng.EXE exposes two COM
interfaces. The first interface provides
services that perform interchange break
translation. The second interface provides
services that perform simple translation
(there is no interaction with Sterling
Gentran:Server, no tracking, auditing, or
database updates—just translation).
Neither interface is Visual Basic
compatible but both can be accessed via a
C++ program using the #import directive
and the GNTXEng.tlb.

Commpost.EXE TxAckGen.DLL and
TxAckRec.DLL

GNTXEngps.DLL A proxy/stub DLL associated with
GNTXEng.EXE.

COM clients of
GNTXEng.EXE.

None

TxAckGen.DLL A COM component that is responsible for
the acknowledgment generation process.
Specifically, this component handles the
extraction of data from the inbound
document that is used to create the
outbound acknowledgement. The
information used in the creation of the
acknowledgment is derived from the
database entries and the translator report
file associated with the inbound entity
that requires acknowledgment generation.

GNTXEng.EXE uses this
component to handle
acknowledgment
generation for documents
requiring immediate
acknowledgment
processing.

None

TxAckGenps.DLL A proxy/stub DLL associated with
TxAckGen.DLL.

COM clients of
TxAckGen.DLL that use
threading models are
different than it.

None

TxAckRec.DLL A COM component that is responsible for
the acknowledgment reconciliation
process. Specifically, this component
handles the exporting of inbound
acknowledgments. The results of the
export are read back in by TxAckRec.DLL
and are used to perform the updates to
the database to change the
acknowledgment status of outbound
documents that are expecting
acknowledgments.

GNTXEng.EXE and
AckServer.EXE.

None

TxAckRecps.DLL A proxy/stub DLL associated with
TxAckRec.DLL

COM clients of
TxAckRec.DLL that use
different threading
models than it.

None

180 IBM Sterling Gentran:Server for Windows: Administration Guide



Chapter 10. Error Messages

About Error Messages
Sterling Gentran:Server errors and other informational messages are noted in the
following locations:
v Document Translator Report
v Interchange Translator Report
v Audit Log
v Document Tracking
v Interchange Tracking

The informational messages are dependent on the context of the program and are
intended to be self-explanatory.

Sterling Gentran:Server uses the following types of error messages:
v Translator Report Error Messages occur if the error appears on a Document or

Interchange Translator Report.
v System Error Messages occur if the error appears on the Audit Log, Document

Tracking, or Interchange Tracking.

Translator Report Errors
The Document and Interchange Translator Report error messages are displayed on
the Document Translator Report and the Interchange Translator Report under the
Message Number and Message columns.

The Message Number column on the translator report contains a prefix (INF, EDI,
or POS), a dash, and a four digit number that identifies the error. The prefixes are
described in the following table

Table 118. Translator Report Error Prefixes

Prefix Description

INF Used only with information messages, which are not defined in this chapter
because they are intended to be self-explanatory.

EDI Used with all the messages listed below that are not informational. Used if
the error is related to an EDI file.

POS Used with all the messages listed below that are not informational. Used if
the error is related to a positional flat file.

The Message column on the translator report contains the actual error message
text.

Translation Report Error Messages

The translator report error messages are listed below by the last three digits of the
message number and the error message text.
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Table 119. Translation Report Error Messages

Msg ID Message Text Explanation Your Action

100 Mandatory Element
Missing

An element that the translation object
designated as Mandatory was not
created in an Outbound document or
was not received in an Inbound
document.

Use the Segment/Record ID,
Sequence, and Element fields on the
Translator Report to determine which
mandatory element in the document
is missing.

For outbound: If the document was
entered using the Document Editor,
open the document and complete the
missing field. If you imported the
document into your system, delete
the document and then import that
document after the import file has
been corrected.

For inbound: Contact your trading
partner and determine what action
you should take.

110 Incorrect Element Format An element was entered or received
with an incorrect format. Some
examples of incorrect format are: a
numeric field that contains
non-numeric characters, and a field
that exceeds the maximum length or
is less than the minimum length (as
defined in the standard), and invalid
dates.

Use the Segment/Record ID,
Sequence, and Element fields on the
Translator Report to determine which
element in the document is invalid.

For outbound: Correct the data
source.

For inbound: Contact your trading
partner and determine what action
you should take.

120 Too Many Components
in Composite

A composite element in a document
you received has more component
elements (sub-elements) than allowed
by the standard.

Use the Segment/Record ID,
Sequence, and Element fields on the
Translator Report to determine which
element in the document is invalid.

For outbound: If the document was
entered using the Document Editor,
open the document and correct the
invalid field. If you imported the
document into your system, delete
the document, correct the data, and
then import that document again.

For inbound: Contact your trading
partner and determine what action
you should take.
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Table 119. Translation Report Error Messages (continued)

Msg ID Message Text Explanation Your Action

130 Invalid Conditional
Relationship

A conditional relationship in the
document is not valid.

Use the translator report to determine
where in the document the error
occurred.

For outbound: If the document was
entered using the Document Editor,
open the document and correct the
conditional relationship. If you
imported the document into your
system, delete the document and
import the document again.

For inbound: Contact your trading
partner and determine what action
you should take.

140 Implicit Rule Failure A validation rule set up against this
field failed in the translator. Typically,
this occurs when the Exclusive flag is
set for a standard rule and the field
value does not match the data table.

Check the data value that you
received against the valid data that is
allowed for the field.

200 Mandatory Component
Missing

A component (sub-element) of a
composite element that the translation
object designated as Mandatory was
not created in an Outbound
document or not received in an
Inbound document.

Use the Segment/Record ID,
Sequence, Element, and Composite
fields on the Translator Report to
determine which mandatory
component in the document is
missing.

For outbound: If the document was
entered using the Document Editor,
open the document and complete the
missing field. If you imported the
document into your system, delete
the document and import the
document again.

For inbound: Contact your trading
partner and determine what action
you should take.

210 Incorrect Component
Format

A component (sub-element) of a
composite element that the translation
object designated as Mandatory was
entered (Outbound) or received
(Inbound) with an incorrect format.
Some examples of incorrect format
are: a numeric field that contains
non-numeric characters or a field that
exceeds or is less than the minimum
length (as defined in the standard).

Use the Segment/Record ID,
Sequence, Element, and Composite
fields on the Translator Report to
determine which element in the
document is invalid.

For outbound: If the document was
entered using the Document Editor,
open the document and correct the
invalid field. If you imported the
document into your system, delete
the document, correct the data, and
import the document again.

For inbound: Contact your trading
partner and determine what action
you should take.
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Table 119. Translation Report Error Messages (continued)

Msg ID Message Text Explanation Your Action

220 Component Delimiter A component delimiter was
encountered instead of the expected
element.

Contact either your trading partner or
the translation object creator and
determine what action you should
take.

300 Mandatory Segment A segment that the translation object
designated as Mandatory was not
created in an Outbound document or
was not received in an Inbound
document.
Note: This error can be generated in
a variety of circumstances. The most
common is that the input data
sequence does not correspond to the
data sequence defined in the
translation object used to translate the
data. If this is the case, the
information provided with the
message may indicate a segment in
the data.

Use the Segment/Record ID field on
the Translator Report to determine
which mandatory segment in the
document is missing.

For outbound: If the document was
entered using the Document Editor,
open the document and key data into
the fields that are necessary to
generate the segment. If you
imported the document into your
system, delete the document, add the
data that is necessary to generate the
segment, and import the document
again.

For inbound: Contact your trading
partner and determine what action
you should take.

310 Invalid Loop Start/End
Structure

An invalid Loop Start/Loop End was
found in an Inbound document.

Use the information in the translator
report to determine which LS/LE
pairing is invalid. Contact your
trading partner and determine what
action you should take.

315 Invalid Segment or
Record Structure

A segment (in an EDI file) or a record
(in a positional flat file) in an
inbound file did not match what the
translation object was expecting.

From viewing the information in the
translator report and the Raw EDI
interchange, determine which
segment or record is invalid. Contact
your trading partner to determine
what action you should take.

405 Unknown Partner An Interchange was received but the
system cannot determine which
partner sent it.

From viewing the information in the
translator report and the Raw EDI
interchange, determine which partner
sent you the interchange. If the
partner is not listed on your system,
create the partner and a relationship
and attach the interchange to that
partner. If the partner already exists
on your system, attach the
interchange to that partner and then
determine why the system did not
automatically identify the partner.

410 Header/Trailer Control
Numbers do not match

The control numbers on the header
and trailer do not match, as specified
by the standard.

Check the Raw EDI view to
determine which control numbers are
in the EDI file and contact your
trading partner to determine what
action you should take.
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Table 119. Translation Report Error Messages (continued)

Msg ID Message Text Explanation Your Action

415 Control Total Incorrect The EDI control total in the Segment
Identified field of the translator report
does not equal the value that was
calculated by the Compliance
Checker.

Check the Raw EDI view to
determine what the control total
should be and contact your trading
partner to determine what action you
should take.

420 Unknown Relationship A document was received but the
Partner Profile for that partner does
not include a corresponding Inbound
Relationship.

From the viewing the information in
the translator report and the Raw EDI
interchange, determine which
relationship the document requires
and create the inbound relationship
for the partner.

460 Invalid Test Mode Flag The partner relationship was found
but the test mode flag in the data did
not match the test mode defined in
the inbound partner relationship.

Change the test mode of the inbound
partner relationship to match the test
mode of the data. Ask your trading
partner to change the test mode of
the data they are sending to match
that defined by the inbound
relationship.

System Errors - Archive Engine Messages
This topic describes the error messages that the Archive Engine may write to the
Audit Log.

See Using Archive and Restore in the Sterling Gentran:Server User Guide for more
information on archive and restore procedures.

The following table describes the error messages generated by the Sterling
Gentran:Server Archive Engine.

Table 120. System Errors - Archive Engine Messages

Msg ID Message Text Explanation Your Action

5 Archive invoked with
invalid definition file
[filename]. Archive will
not be performed.

The definition file may be corrupt or
may not have been created using the
Archive Manager.

Recreate the definition file using
Archive Manager and re-run the
archive process.

6 Archive invoked with
invalid command line
argument(s). Archive will
not be performed. Usage:
([usage options])

This error only occurs if the archive
process is initiated from a command
line.

Re-run the archive using the specified
usage options.

8 Error reading definition
file ([filename]). Archive
will not be performed.

The definition file may be corrupt or
may not have been created using the
Archive Manager.

Recreate the definition file using
Archive Manager and re-run the
archive process.

9 Unable to initialize
internal data structures.
Aborting archive.

v View other supporting messages in
the Audit Log to determine why
the archive failed.

v Take the appropriate action based
on the error.
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Table 120. System Errors - Archive Engine Messages (continued)

Msg ID Message Text Explanation Your Action

10 Unable to retrieve
InfoHubServer name
from registry. Aborting
archive.

An internal Windows error occurred. v View other supporting messages in
the Audit Log to determine why
the archive failed.

v Take the appropriate action based
on the error.

11 Unable to connect to
InfoHubServer
([controller name]).
Aborting archive.

The system controller may be down. Verify that the controller is running
and re-run the archive.

12 Archiving of messages
did not complete
successfully. Aborting
archive.

An internal Windows error occurred. v View other supporting messages in
the Audit Log to determine why
the archive failed.

v Take the appropriate action based
on the error.

18 Unable to create archive
file ([filename]). Aborting
archive.

An internal Windows error occurred. v View other supporting messages in
the Audit Log to determine why
the archive failed.

v Take the appropriate action based
on the error.

19 Encountered memory
allocation error ([error]).

An internal Windows error occurred. v View other supporting messages in
the Audit Log to determine why
the archive failed.

v Take the appropriate action based
on the error.

21 Unable to Open ([name
of stream]) stream for
archiving.

Windows experienced an internal
problem opening the file.

v View other supporting messages in
the Audit Log to determine why
the archive failed.

v Take the appropriate action based
on the error.

22 Encountered errors
archiving channels.

The appropriate database table is
empty.

Create the appropriate queue and
re-run the archive process.

23 Encountered errors
archiving message Id
([message identifier]).

The specified message does not exist. Verify that the message exists and
re-run the archive process.

24 Encountered exception
([exception]) while
archiving message Id
([message identifier]).

Base your action on the specified
exception.

25 Encountered exception
([exception] while
archiving channel Id
([queue identifier]).

Base your action on the specified
exception.

27 Unable to Open
([filename]) storage for
archiving.

Windows experienced an internal
problem opening the file.

v View other supporting messages in
the Audit Log to determine why
the archive failed.

v Take the appropriate action based
on the error.
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Table 120. System Errors - Archive Engine Messages (continued)

Msg ID Message Text Explanation Your Action

29 Unable to archive
attachment Id
([attachment identifier])
for message Id ([message
identifier]).

The specified message does not exist. Verify that the message exists and
re-run the archive process.

30 Encountered exception
([exception]) while
archiving attachment Id
([attachment identifier])
of message Id ([message
identifier]).

Base your action on the specified
exception.

31 Encountered the
following exception
attempting to create
stream [stream] for
archiving: [archive file]

v View other supporting messages in
the Audit Log to determine why
the archive failed.

v Take the appropriate action based
on the error.

32 Unable to archive
recipient Id ([recipient
identifier]) for message
Id ([message identifier]).

The specified message does not exist. Verify that the message exists and
re-run the archive process.

33 Encountered exception
([exception]) while
archiving recipient Id
([recipient identifier]) of
message Id ([message
identifier]).

Base your action on the specified
exception.

34 Unable to archive Data
Audits.

v View other supporting messages in
the Audit Log to determine why
the archive failed.

v Take the appropriate action based
on the error.

35 Encountered exception
([exception]) while
archiving Data Audits.

Base your action on the specified
exception.

36 Encountered exception
([exception]) while
archiving definition file.

Base your action on the specified
exception.

39 Invalid message location
([location]) specified in
selection criteria.

The system did not find the message
in the proper queue.

v In Archive Manager, edit the
selection criteria and select the
proper queue.

v Re-run the archive process.

40 Invalid status ([status])
specified in selection
criteria.

The specified status is invalid. v In Archive Manager, edit the
selection criteria and select the
proper status.

v Re-run the archive process.
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Table 120. System Errors - Archive Engine Messages (continued)

Msg ID Message Text Explanation Your Action

41 Invalid days old
([number of days])
specified in selection
criteria.

The specified number of day is
invalid.

v In Archive Manager, edit the
selection criteria and select the
proper number of days.

v Verify that you did not input a
negative number of days in
Archive Manager.

v Re-run the archive process.

42 Invalid parameter
specified in selection
criteria.

One of the selection criteria
parameters you selected in Archive
Manager is invalid.

v Check the Audit Log to obtain
more information from other
supporting messages.

v In Archive Manager, edit the
selection and modify the
inappropriate parameters.

v Re-run the archive process.

49 [function name] unable
to archive data file for
[name of data file].

The system is unable to locate the
attachment data file.

v Verify that the attachment data file
exists using Windows Explorer.

v Re-run the archive process.

52 [function name]
encountered database
exception [exception].

Base your action on the specified
exception.

53 [function name]
encountered exception
[exception].

This is a general exception error. Base your action on the specified
exception.

54 [function name] unable
to archive file [filename].

The system was unable to archive the
specified file.

v Verify that the file exists using
Windows Explorer.

v Re-run the archive process.

57 [function name]
encountered exception
([exception]) while
attempting to archive file
([filename]).

The specified exception occurred
when the system attempted to archive
that particular file.

v Verify that the file exists using
Windows Explorer.

v Re-run the archive process.

63 Encountered exception
([exception]) while
deleting Data Audits.

The specified exception caused the
system to be unable to delete data
audits.

Manually delete the data audits
through your database.

65 Encountered errors
reading selection criteria
([criteria]) from
definition file
([filename]). Aborting
archive.

The specified archive definition file
contains invalid selection criteria.

v Check the Audit Log to obtain
more information from other
supporting messages.

v In Archive Manager, edit the
selection and modify the
inappropriate parameters.

v Re-run the archive process.

66 Encountered errors
archiving definition file
([filename]). Aborting
archive.

v Check the Audit Log to obtain
more information from other
supporting messages.

v Base your action on the specified
errors.

v Re-run the archive process.
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Table 120. System Errors - Archive Engine Messages (continued)

Msg ID Message Text Explanation Your Action

74 Unable to archive data
audits. Aborting archive.

v Check the Audit Log to obtain
more information from other
supporting messages.

v Base your action on the specified
errors.

v Re-run the archive process.

83 Unable to obtain the
Archive System Mutex
from system ([system
name]) on primary
controller ([controller
name]). Another archive
may be currently
processing.

This error indicates that the Archive
Engine was stopped abnormally,
possibly the result of a power outage.

v Stop and restart the Executive
Service. See Starting the System .

v Re-run the archive process.

84 Unable to connect to
system ([system name])
on primary server
([controller name]).

The system is unable to connect to
the primary system controller.

v Verify that the primary system
controller is up and running.

v Using the System Configuration
subsystem, verify that the
Executive Service is started. See
Starting the System .

v Re-run the archive process.

85 Unable to obtain the
name of the primary
server for system
([system name]).

The name of the primary system
controller does not appear in your
registry. This error will only occur if
someone has manually interfered
with the registry settings.

Re-install Sterling Gentran:Server.

86 Sign on to system failed. The system is down. v Verify that the primary system
controller is up and running.

v Using the System Configuration
subsystem, verify that the
Executive Service is started. See
Starting the System .

v Re-run the archive process.

87 Unable to connect to the
system to obtain the
Archive System Mutex.
Aborting.

This error indicates that the system
has attempted to start more than one
Archive Engine at a time, which
typically means that the Archive
Engine was stopped abnormally,
possibly the result of a power outage.

v Stop and restart the Executive
Service. See Starting the System .

v Re-run the archive process.

108 Unable to change
extension of archive file
([filename]).

This error indicates that the system
was unable to change the file
extension of the temporary archive
storage file to .ARV.

This is an internal Windows error; no
user action is necessary.

109 Encountered errors
attempting to archive
channels. Aborting
archive.

This is a general archive error that
occurred while archiving queues.

v Check the Audit Log to obtain
more information from other
supporting messages.

v Base your action on the specified
errors.

v Re-run the archive process.
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Table 120. System Errors - Archive Engine Messages (continued)

Msg ID Message Text Explanation Your Action

111 Archive has been
CANCELLED during
interactive session.

This error indicates that the archive
session was cancelled manually.

Re-run the archive process.

113 Archiving of attachment
data audits did not
complete successfully.
Aborting archive.

This is a general archive error that
occurred while archiving attachments.

v Check the Audit Log to obtain
more information from other
supporting messages.

v Base your action on the specified
errors.

v Re-run the archive process.

System Errors - Archive Manager Messages
This topic describes the error messages that the Archive Manager may write to the
Audit Log.

See Using Archive and Restore in the Sterling Gentran:Server User Guide for more
information on archive and restore procedures.

The following table describes the error messages generated by the Sterling
Gentran:Server Archive Manager.

Table 121. System Errors - Archive Manager Messages

Msg ID Message Text Explanation Your Action

5 Invalid filename, cannot
save as [filename].

The system is unable to save the
archive file with the specified file
name.

v Using Windows Explorer, verify
that the file does not already exist.

v Rerun the archive process.

8 [filename] contains an
invalid definition file
type.

The archive definition file was
corrupted outside the Archive
Manager.

v Using Windows Explorer, delete
the file.

v In Archive Manager, create a new
definition file.

v Rerun the archive process.

11 Unable to open file
named [filename].

The specified file was corrupted
outside the Archive Manager.

v Using Windows Explorer, delete
the file.

v In Archive Manager, create a new
definition file.

v Rerun the archive process.

12 Unable to save file
named [filename].

The system is unable to save the
definition file with the specified file
name.

v Using Windows Explorer, verify
that the file does not already exist.

v In Archive Manager, create a new
definition file.

v Rerun the archive process.

17 The following exception
was encountered:
[exception]

This is a general exception. v Check the Audit Log to obtain
more information from other
supporting messages.

v Base your action on the specified
errors.

v Rerun the archive process.
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Table 121. System Errors - Archive Manager Messages (continued)

Msg ID Message Text Explanation Your Action

20 Unable to connect to
InfoHubServer
([controller name]) for
restoring messages.
InfoHubServer return
code = ([return code]).

While attempting to restore messages,
the system was unable to connect to
the specified controller.

v Verify that the primary system
controller is up and running.

v Using the System Configuration
subsystem, verify that the
Executive Service is started. See
Starting the System .

v Rerun the restore process.

36 Errors were encountered
and message ([message
id]) was only partially
restored from archive
([archive file]). This
message should be
manually deleted and
the restore reattempted.

v Using the InfoHubServer user
interface, delete the message
manually.

v Rerun the restore process.

37 Unable to open archive
file ([filename]) for
restore purposes.

The archive file was corrupted
outside the Archive Manager.

v Using Windows Explorer, verify
that the file exists.

v Rerun the restore process.

47 The following error was
encountered attempting
to launch the Archive
Engine: [error text].

This is a general error. v Check the Audit Log to obtain
more information from other
supporting messages.

v Base your action on the specified
errors.

v Rerun the restore process.

60 The following Database
exception was
encountered while
attempting to obtain
Application Directories:
[exception]

Base your action on the specified
exception.

66 Unable to get
InfoHubServer name
from registry.

The name of the controller does not
appear in your registry. This error
will only occur if someone has
manually interfered with the registry
settings.

Re-install Sterling Gentran:Server.

68 Unable to obtain a listing
of the channels for this
system.

This error indicates that the Infohub
service is down.

v Verify that the primary system
controller is up and running.

v Using Control Panel\Services,
verify that the Infohub service is
started.

81 Unable to obtain Audit
server name from the
registry.

The name of the controller does not
appear in your registry. This error
will only occur if someone has
manually interfered with the registry
settings.

Re-install Sterling Gentran:Server.

83 Unable to obtain Primary
server name from the
registry.

The name of the controller does not
appear in your registry. This error
will only occur if someone has
manually interfered with the registry
settings.

Re-install Sterling Gentran:Server.
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Table 121. System Errors - Archive Manager Messages (continued)

Msg ID Message Text Explanation Your Action

84 The following error was
encountered attempting
to restore [filename]
([message id]) in archive
file [filename]: [error
text].

This is a general restore error. Base your action on the error text.

99 Channel ([channel id])
does not exist. Unable to
restore message
([message id]).

The specified channel no longer exists
on your system so the system cannot
restore the message.

No user action is necessary.

100 Channel Ids are different
for channel ([channel
id]). Message ([message
id]) was not restored.

This error indicates that the specified
channel was deleted from your
system and then recreated (thus the
identifier is different from when the
specified message was archived).

No user action is necessary.

101 The following exception
was encountered while
building a search results
list: [exception]

This is a general search exception. v Check the Audit Log to obtain
more information from other
supporting messages.

v Base your action on the specified
errors.

v Rerun the search process.

System Errors - Audit Notification Server Messages
This topic describes the error messages that the translator may write to the Audit
Log and the Windows Event Log on behalf of the Audit Notification Server.

The following table describes the error messages generated by the Sterling
Gentran:Server Audit Notification Server.

Table 122. System Errors - Audit Notification Server Messages

Msg ID Message Text Explanation Your Action

2 ANServer startup error
[error explanation] in
function [function of the
program in which the
error took place]

The system writes this error only to
the Windows Event Log.

This error indicates that Audit
Notification was unable to start due
to errors initializing business logic,
such as logging into the database,
reading a table, or reading a value
from the registry.

v Depending on the explanation
represented by the error
explanation, take the appropriate
action to determine what caused
the error.

v Use Control Panel/Services to
verify the ID that the service uses
to login.

v Check the Windows Event Log for
more details.

v Call support if restarting doesn't
work.

For example, if the error is a database
error, verify that SQL is started and
verify that the database login for the
service is correct.
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Table 122. System Errors - Audit Notification Server Messages (continued)

Msg ID Message Text Explanation Your Action

3 ANServer shutdown
error [error explanation]
in function [shutdown
function in which the
error took place]

The system writes this error only to
the Windows Event Log.

This error indicates that an error
occurred when Audit Notification
was stopping. On shutdown, Audit
Notification saves values into the
registry. The system may have
encountered an error writing to the
registry.

Call support.

4 Service error: [error
explanation]

The system writes this error only to
the Windows Event Log.

This error indicates that Audit
Notification was unable to start due
to a system error such as "handler not
installed" or "bad service request."

Call support.

9 Error writing message
[message number] to
Audit Log: [error
explanation]

The system writes this error only to
the Windows Event Log.

This error indicates that Audit
Notification encountered an error
writing the designated message to the
Audit Log.

v Depending on the error message,
take appropriate action.

For example, if the system could
not write the message because the
database was down, restart the
services.

v Check the Audit Log and Windows
Event Log to determine if the
system wrote other related errors.

v Call support.

10 Error writing
notification: [notification
name] to Notification
Log: [error explanation]

The system writes this error only to
the Windows Event Log.

This error indicates that Audit
Notification encountered an error
writing an entry to the Notification
Log.

v Depending on the error message,
take appropriate action.

For example, if the system could
not write the notification because
the database was down, restart the
services.

v Check the Audit Log and Windows
Event Log to determine if the
system wrote other related errors.

v Call support.

11 ANServer error [error
explanation] in function
[area of the system in
which the error occurred]

The system writes this error only to
the Windows Log.

This error indicates a general type of
processing error. This error may occur
when a user has modified an audit
message, operator, or notification and
the system cannot update its internal
table due to a database error.

Analyze the error and take corrective
action, if appropriate. You can restart
the service. If the service does not
start successfully, check the Audit Log
and Event Log, and call support.

For example, if the database went
down, restart the service.
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Table 122. System Errors - Audit Notification Server Messages (continued)

Msg ID Message Text Explanation Your Action

12 Error generating
Notification:(HR=[system
error code]) [error
explanation].
Notification: [notification
name] Action:
[notification action such
as e-mail or page]
Operator: [name of
notification recipient]

Audit Notification writes this
message to the Audit Log and the
Windows Event Log when it cannot
generate a user-directed notification
successfully.

Analyze the error and take corrective
action, if appropriate. You can restart
the service. If the service does not
start successfully, check the Audit Log
and Event Log, and call support.

For example, if the database is down,
restart the database and then the
Sterling Gentran:Server services. If the
error continues, check the Audit Log
and Event Log and call support.

13 Error generating
Notification [notification
name] Scheduler Event:
[name of the Notification
Type Scheduler event
that Audit Notification
was attempting to start]

Audit Notification writes this
message to the Audit Log and the
Windows Event Log when it cannot
generate a Notification Type
Scheduler event.

This error indicates that Audit
Notification was unable to generate a
Notification Type Scheduler event.
(The system starts the event by
sending an RPC-based request to the
Executive service.)

Check the Audit Log for messages
generated by the Executive service
that indicate what error occurred
starting the event, and take
appropriate action or call support.

200 [action being
attempted]\r\n\r\
nError returned by
ANServer:[system error
code]\r\n[error
explanation]

The Audit Context object generates
this message. The Audit Context
handles program requests to write to
the Audit Log by forwarding the
requests to Audit Notification. If
Audit Context cannot communicate
successfully with Audit Notification,
it writes this error to the Windows
Event Log on the client machine of
the program requesting the Audit Log
entry.

For example: The action being
attempted may be "Unable to create
EventIDServer object from ANServer".

This error also may occur due to a
network issue.

Verify that the Audit Notification
System is running and has not
encountered any errors (check the
Audit Log and the Windows Event
Log on the Audit Notification server).
If there are errors, restart Audit
Notification and the other Sterling
Gentran:Server services. Then retry
whatever client action was being
attempted when the 200 error
generated.

For network issues, verify that the
client machine can connect to the
server (use Windows Explorer or
Network Neighborhood, or contact
your System Administrator to verify
connectivity).

If the problem still occurs after you
have restarted the services and
verified network connectivity, call
support.
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Table 122. System Errors - Audit Notification Server Messages (continued)

Msg ID Message Text Explanation Your Action

201 Audit Log call failed.
Error returned by
ANServer: [system error
code]\r\n[error
explanation]\r\nAudit
Log data:\r\n[formatted
text of the message that
the program was
attempting to write to
the Audit Log]

The Audit Context object generates
this message. The Audit Context
handles a program request to write to
the Audit Log by forwarding the
request to Audit Notification. If the
Audit Notification System returns an
error indicating that it could not
process the request, then Audit
Context writes this message to the
Windows Event Log on the client
machine of the program requesting
the Audit Log entry.

For example: In a distributed system,
if you open the Mailbox Server client
on a machine that is not the same
server where the Audit Notification
Server and the Mailbox Server are
installed, the Mailbox user interface
attempts to write an Audit Log
message indicating that you started
the client. The user interface program
requests that Audit Context write the
Audit Log entry.

However, Audit Context receives an
error back from Audit Notification
when it requests that the entry be
written. Audit Context then writes
this error message to the Windows
Event Log on the local machine.

Check the Audit Log and the
Windows Event Log (on the Audit
Notification server, not the client
machine) for errors issued by Audit
Notification. Depending on the error,
restart the Audit Notification System.
If the problem still occurs, call
support.

System Errors - Process Control, Communications, and Translator
Error Messages

The Process Control, general communications, and translator error messages are
displayed on the Audit Log, Document Tracking, and Interchange Tracking.

See Using Tracking in the Sterling Gentran:Server User Guide for more information
on the tracking feature. See the topics on using the Audit Notification System for
more information on using the audit log.

The error messages are listed below by the four-digit message number and the
error message text. Some errors include variable parameters. These parameters are
indicated below in brackets, (for example, [filename]).

Table 123. System Errors - Process Control, Communications, and Translator Error Messages

Msg ID Message Text Explanation Your Action

10 MessageStore does not
exist.

The settings in Mailbox Properties (Files
tab) no longer point to a valid message
store location (for example, you may
have deleted the specified message store
location).

Correct or restore the file system
message store location.
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Table 123. System Errors - Process Control, Communications, and Translator Error Messages (continued)

Msg ID Message Text Explanation Your Action

1305 Session Failure -
Unidentified Partner -
[partner ID]

The translation session failed because the
indicated partner relationship does not
exist.

Create the appropriate partner
relationship for that partner. See
How to Create a New Partner
Definition in the User Guide for more
information.

1306 Session Failure - No
Relationship - Standard
[standard] Version
[version] Trans
[transaction set]

The translation session failed because the
system could not find a partner
relationship for the document.

Create the appropriate partner
relationship for that partner and
translate the document again.

1509 Unattend
SessionManager - Error
obtaining connection to
the database.

The database logon credentials that
Commpost tried to supply to the Sterling
Gentran:Server Database are invalid.

Check the logon credentials supplied
to Sterling Gentran:Server.

1535 Unattended Processing -
Import Failed for [import
filename] - No Import file
Spec in System
Configuration

The import file specified for
GDW_Import did not have a
corresponding translation object named
in System Configuration.

Verify that the correct import file
was specified and verify that System
Configuration (Imports tab) has a
corresponding import translation
object named.

1536 Unattended Processing -
Import File [import
filename] Not Found

The user specified the name of a
nonexistent file for the GDW_Import
command.

Verify that the correct import
directory/file name is specified and
that it exists as named. If the file to
import is specified without a
directory, verify that the file exists in
the Imports directory that is named
in System Configuration.
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Table 123. System Errors - Process Control, Communications, and Translator Error Messages (continued)

Msg ID Message Text Explanation Your Action

1537 Unattended Processing -
Create Program [program
name] with parms
[program parameters]
failed with RC=
[program return code] for
Command [command
name]

If the command that is executed is
Exec_Program or End_Script, examine
the following list of return codes and
take the appropriate action:

v 0 System was out of memory,
executable file was corrupt, or
reallocations were invalid

v 2 File was not found

v 3 Path was not found

v 5 Attempt was made to dynamically
link to a task, or there was a sharing
or network-protection error

v 6 Library required separate data
segments for each task

v 8 There was insufficient memory to
start the application

v 10 Windows version was incorrect

v 11 Executable file was invalid -- either
it was not a Windows application or
there was an error in the .EXE image

v 12 Application was designed for a
different operating system

v 13 Application was designed for
MS-DOS 4.0

v 14 Type of executable file was
unknown

v 15 Attempt was made to load a
read-mode application

v 16 Attempt was made to load a
second instance of an executable file
containing multiple data segments
that were not marked read-only

v 19 Attempt was made to load a
compressed executable file -- the file
must be decompressed before it can be
loaded

v 20 Dynamic-link library (DLL) file was
invalid -- one of the DLLs required to
run this application was corrupt

v 21 Application required Microsoft
Windows 32-bit extensions

v 31 No association for the specified file
type or not association for the
specified action within the file type

If a different command is executed,
copy the audit message and contact
support.

1538 Unattended Processing -
No data available for
Command [command
name]; Ptr: [partner]. Doc
Type: [document type]

No data exists to export or print, or no
data that matches the partner and/or
document parameters specified exists to
export or print.

Verify the partner and/or document
parameters specified and compare to
the documents in the In Documents.
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Table 123. System Errors - Process Control, Communications, and Translator Error Messages (continued)

Msg ID Message Text Explanation Your Action

1539 Unattended Processing -
Read lock failure on
[database table] table.
Unable to process
Command [command
name]

The command cannot process because it
cannot obtain a readlock on the specified
database.

Note which other processes are
executing and call support.

1540 Unattended Processing -
Unable to create parm
file [parameter filename]
for Command [command
name]

The application cannot create the
parameter file that is necessary to pass
to the program that processes the
GDW_Print command.

Copy the audit message and contact
support.

1541 Unattended Processing -
Invalid Command
[command name]
bypassed

An invalid command was specified. Use Process Control Setup to edit
the session file being processed and
correct the invalid command
parameter.

1542 Unattended Processing -
Command [command
name] not processed:
From File [filename] does
not exist

You specified a From File for File_Copy
or File_Rename commands that does not
exist.

Correct the From File Command
parameter.

1543 Unattended Processing -
Command [command
name] not processed:
error opening File
[filename]

An error occurred while trying to open
either the From File or the To File on a
File_Copy or File_Rename command.

Copy the audit message and contact
support.

1544 Unattended Processing -
Command [command
name] not processed:
lseek error on To File
[filename]

While processing a File_Copy command
to append a From File to a To File, the
program encountered an error trying to
position the file pointer to the end of the
To File.

Copy the audit message and contact
support.

1545 Unattended Processing -
Command [command
name] not processed: File
[filename] cannot be
renamed to [filename]
(file already exists)

The To File specified in a File_Rename
command already exists. The
File_Rename command only renames a
file to a file name that does not currently
exist.

Either delete the To File or specify a
new To File name.

1546 Unattended Processing -
Command [command
name] not processed:
error deleting file
[filename]

The program could not successfully
delete the file specified as a parameter
for the File_Delete command or could
not successfully delete the From file for
the File_Rename command.

Copy the audit message and contact
support.

1547 Unattended Processing -
Command [command
name] for profile [profile
name] not processed: no
profile exists to receive

For the GDW_Receive command, an
invalid communication profile was
specified.

Specify a valid communication
profile in Parameter 1 or specify
<All>.

1548 Unattended Processing -
Command [command
name] for profile [profile
name] not started: bad
return from SSCOMAPI

While executing a communication
receive process, Process Control
Processing received a bad return code
from its call to SSComAPI.

Copy the audit message and contact
support.
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Table 123. System Errors - Process Control, Communications, and Translator Error Messages (continued)

Msg ID Message Text Explanation Your Action

1549 Unattended Processing -
SSComAPI returned zero
sessions for Command
[command name]

While processing the
GDW_Send_Receive command, Process
Control Processing determined that
either there was an error in
communication processing or there are
no sessions to send/receive.

Check for messages issued from the
communications process between
the "Process Control Processing -
Started Command
GDW_Send_Receive" and "Process
Control Processing - Completed
Command GDW_Send_Receive." If
communication error messages exist,
copy the audit messages and call
support. If there are no
communication messages, the
command was processed
successfully and the message is
informational.

1550 Unattended Processing -
Program Ending: Session
File [filename] not found

Process Control Processing was started
with the name of a session file that does
not exist.

Use Process Control Setup to verify
that the specified session file exists.

1551 Unattended Processing -
Program Ending: No
Session File passed on
program start

Process Control Processing was started
without being passed the name of a
session file.

Use Process Control Setup to
correctly specify a session file and a
calendar (if necessary) to run in
process control mode. See the User
Guide for more information.

1552 Unattended Processing -
Program Ending: Invalid
Signature-Version record:
[session file]

The signature-version record included in
the session file that is being processed is
invalid.

A correct signature-version record
reads "GDW_Session," "Version 1.0".
Use File Manager to edit the session
file and correct the version record.

1553 Process Control -
Command [command]
not processed: bad
Return from call to Audit

The command failed to process and
returned a bad call.

Check the return code and correct
the command. If the problem
persists, contact Customer Support.

1556 Process Control -
Command [command]
encountered errors
during processing

The command failed to process and
returned a bad call.

Check the return code and correct
the command. If the problem
persists, contact Customer Support.

1557 Process Control - Error
reading [database name]
database for Key = [key]

The system experienced a problem
reading the database and was unable to
continue.

Check the database connection and
user rights and retry.

1578 Process Control - Unable
to obtain successful
database security

The system experienced a problem
reading the database and was unable to
continue.

Check the database connection and
user rights and retry.

1579 Process Control - Invalid
Gentran security

A remote client was not able to connect
to the controller using the login defined
at installation time.

Verify which user security for the
controller was specified during
product installation and enter this
on the client login screen.

1582 Process Control - I/O
error during file
operation

The system had problems reading or
writing data to the disk.

Check your operating system and
disk storage for problems and space,
and retry the scheduler operation.

1583 Process Control - Error
creating mutex: mutex
already exists

The system could not perform a locking
function on a process.

Ensure there are no orphaned
processes running and retry.

1585 Process Control - Failed
waiting for mutex

The system could not perform a locking
function on a process.

Ensure there are no orphaned
processes running and retry.
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Table 123. System Errors - Process Control, Communications, and Translator Error Messages (continued)

Msg ID Message Text Explanation Your Action

1588 Process Control - System
[system name] is not
running

A client had problems connecting to a
controller machine.

Check the controller system and
ensure it is accessible.

1589 Process Control -
Command [command]
not processed: From File
[filename] is read-only

The system could not write to a file that
had read-only permissions.

Change the permissions or direct to
a different file.

1590 Process Control - Error in
[filename]: Session =
[session name],
Command = [command]

The system failed to process the
command.

Check the return code and ensure
the syntax of the command is
correct.

1592 Process Control - Unable
to obtain the Archive
directory for archives of
type [archive type].

The system could not perform an archive
because an invalid directory was
specified.

Ensure the path of the directory is
correct and retry.

1593 Process Control -
[filename] is not a valid
archive definition type.

This file is not recognized as a definition
file generated by the archive program.

Check the spelling of the file name
and path to the file. If both are
valid, regenerate the file with the
Archive Manager. Contact support if
not resolved. See the User Guide for
more information.

1594 Process Control - %1 This is a generic display message. Contact support for resolution.

1606 CommPost found error
[network error] in
interchange [interchange
number] while
reconciling 020 report

The indicated error in the specified
interchange occurred while the system
was reconciling the 020 network report.

Refer to your network
documentation to determine what
caused the error and what action
you should take.

1607 CommPost found error
[network error] in
unknown interchange
while reconciling 020
report

The indicated error occurred while the
system was reconciling the 020 network
report.

Refer to your network
documentation to determine what
caused the error and what action
you should take.

1608 CommPost found
warning [network error]
in interchange
[interchange number]
while reconciling 020
report

The indicated warning in the specified
interchange occurred while the system
was reconciling the 020 network report.

Refer to your network
documentation to determine what
caused the error and what action
you should take.

1609 CommPost found
warning [network error]
in unknown interchange
while reconciling 020
report

The indicated warning occurred while
the system was reconciling the 020
network report.qq

Refer to your network
documentation to determine what
caused the error and what action
you should take.

1622 Commpost - Error
obtaining connection to
the database.

The database logon credentials that
Commpost tried to supply to the Sterling
Gentran:Server Database are invalid.

Check the logon credentials supplied
to Sterling Gentran:Server.

1703 Translator: Relationship
not found for partner:
[partner ID], direction:
[inbound/outbound],
agency: [standard
agency], version:
[version]

The translation session failed because the
system could not find a partner
relationship for the document.

Create the appropriate partner
relationship for that partner and
translate the document again. See
the User Guide for more information.
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Table 123. System Errors - Process Control, Communications, and Translator Error Messages (continued)

Msg ID Message Text Explanation Your Action

1704 Translator: Translation
Object [filename] Not
Found

The system could not find the translation
object file required to perform the
necessary translation.

Register the specified translation
object file again. See the User Guide
for more information.

1707 Translator: Invalid
Translation Object File
[filename]

Either the indicated translation object file
does not exist or this translation object
entry is missing from the translation
object database.

Obtain a valid translation object
from IBM and register the
translation object with the system.
See the User Guide for more
information.

1708 Translator: Setup Failed The translation object file is corrupt or
invalid.

Obtain a valid translation object
from IBM and register the
translation object with the system.
See the User Guide for more
information.

1754 Translation error during
document export. Export
file [filename], external
data key [key], partner
[partner ID], document
name [document name]

A translator error occurred during
document export.

Check the external data summary
viewer, scroll to the specified file,
and view the translator report for
the document that failed to export
properly.

3001 [Interchange/group/
document]
acknowledgement status
changed to Overdue for
partner [partner]

5010 Acknowledgement status
changed to Rejected for
partner [partner],
[document] [interchange]

An outbound document was rejected
due to an Inbound Acknowledgement.

6501 CommMgr: Errors
received from Mailbox
during communications
session

An error was encountered during
communications processing.

This is a general error message
indicating that a failure of some
type was encountered during the
comm process. Examine the other
audit messages to determine if the
Communications Manager generated
a specific message for this error. See
the user action recommended for the
specific audit message to determine
your action.

6503 CommMgr: Error
connecting to gateway.
Mailbox retcode = [code]

An error was received from the gateway
connect call.

Follow the actions recommended in
the Communications User Guide for
the Mailbox return code.

6506 CommMgr: Startup failed
to open ODBC
connection

Comm Manager was unable to open a
single ODBC connection to the Sterling
Gentran:Server database when the
Executive Service was started on the
primary system controller.

v Verify that the current number of
connections to SQL Server does
not use the maximum number of
configured SQL Server User
Connections. You may need to
increase the number of User
Connections. See your SQL Server
documentation for more
information.

v If the above action fails to solve
the error, contact Customer
Support.
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Table 123. System Errors - Process Control, Communications, and Translator Error Messages (continued)

Msg ID Message Text Explanation Your Action

6507 CommMgr: No ODBC
connections available.
Service aborted

Comm Manager was unable to open any
ODBC connection to the Sterling
Gentran:Server database when the
Executive Service was started on the
primary system controller.

v Verify that the ODBC system data
source points to a valid SQL
Server and database and that SQL
Server is currently running.

v Check the Event Log on the
machine where SQL is installed to
view any messages related to SQL
Server errors. Verify that the SQL
Server is running.

v Verify that the current number of
connections to SQL Server does
not use the maximum number of
configured SQL Server User
Connections. You may need to
increase the number of User
Connections. See your SQL Server
documentation for more
information.

v If the above actions fail to solve
the error, contact Customer
Support.

6508 CommMgr: Startup error
obtaining system
information

Comm Manager encountered an error
during the RPC call to obtain the
Mailbox server and the name of the
notification mailbox.

Contact Customer Support.

6509 CommMgr: error [error].
Mailbox retcode = [return
code]

Comm Manager received an error return
code from a call to the Mailbox RPC
interface.

Follow the actions recommended in
the Communications User Guide for
the Mailbox return code.

6510 CommMgr: Error
obtaining database
connection in [thread]

Comm Manager manages the database
through various processing threads. A
function needed access to the database,
but was unable to obtain a database
connection from the pool of database
connections.

v Stop and restart the Executive
Service on the primary system
controller. See the Stopping the
System for more information.

v If this fails to resolve the error,
contact Customer Support.

6515 CommMgr: Error
extracting data from
attachment for Message
Id [message Id]

An error occurred when Mailbox
attempted to extract data from an
attachment for the specified Message ID.

v Verify that the specified message
ID exists in the Application InBox.

v Contact Customer Support.

6518 CommMgr: Error
initiating inbound
process for message
[message Id]

An error occurred when starting either
the GDW_Process_MBFile or
GDW_Import session. The system may
have started the process on the primary
system controller (if a communications
process was initiated interactively from
Sterling Gentran:Server) or on the
controller on which the process control
session that initiated communications
was running.

v Restart the Executive Service on
the primary system controller.
This reprocesses any unread
messages.

v If this does not solve the problem,
contact Customer Support or try
to manually reprocess that data in
the message.

6519 CommMgr: Error -
Invalid Mailbox:
[mailbox] for Partner:
[partner]

The specified partner for the interchange
does not have a valid mailbox.

Verify that the specified partner is
associated with a valid mailbox. See
How to Edit or Delete a Partner
Definition in the User Guide for more
information.
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Table 123. System Errors - Process Control, Communications, and Translator Error Messages (continued)

Msg ID Message Text Explanation Your Action

6520 CommMgr: Error [error]
creating thread in
[thread]

An error occurred when creating a
thread.

Contact Customer Support.

6522 CommMgr: Error [error]
opening file [file name]

Comm Manager was unable to open the
specified file name in the TRANSIN
folder.

v Verify that the ID under which
the Executive service is running
has security access to the specified
file.

v If security is set up correctly and
an error still occurs, contact
Customer Support.

6523 CommMgr: Error [error]
writing to file [file name]

Comm Manager was unable to write the
attachment data from the message to the
specified file name in the TRANSIN
folder.

v Verify that the ID under which
the Executive service is running
has security access to the specified
file.

v Verify that appropriate space
exists to write the file.

v If security is set up correctly and
adequate space exists, and an
error still occurs, contact
Customer Support.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku

Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
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incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

J46A/G4

555 Bailey Avenue

San Jose, CA 95141-1003

U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.
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This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© IBM 2012. Portions of this code are derived from IBM Corp. Sample Programs. ©
Copyright IBM Corp. 2012.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at http://www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.
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Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of the Office
of Government Commerce, and is registered in the U.S. Patent and Trademark
Office.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java™ and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are
trademarks of HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise®, Gentran®,
Gentran:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Realtime®, Gentran:Server®, Gentran:Viewpoint®, Sterling Commerce™,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce®, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks
of others.
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